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services are required, professional assistance should be sought.
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ACCPAC INTERNATIONAL, INC.
MICRO PRODUCT LICENSE AGREEMENT AND LIMITED PRODUCT WARRANTY

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS.  YOUR OPENING OF THE
PROGRAM PACKAGE WILL INDICATE YOUR ACCEPTANCE.  IF YOU DO NOT AGREE WITH
THESE TERMS AND CONDITIONS YOU SHOULD PROMPTLY RETURN THE COMPLETE
PACKAGE AND YOUR MONEY WILL BE REFUNDED.

ACCPAC INTERNATIONAL, INC. (“ACCPAC INTERNATIONAL”) provides this Program and licenses
its use to you.  You are responsible for selecting the Program to achieve your intended results and for the
installation, use and results obtained from the Program.

THE PROGRAM, INCLUDING ITS CODE, DOCUMENTATION, APPEARANCE, STRUCTURE AND
ORGANIZATIONS, IS A PROPRIETARY PRODUCT OF ACCPAC INTERNATIONAL AND IS
PROTECTED BY COPYRIGHT AND OTHER LAWS.  TITLE TO THE PROGRAM, OR ANY COPY,
MODIFICATION OR MERGED PORTION OF THE PROGRAM, SHALL AT ALL TIMES REMAIN
WITH ACCPAC INTERNATIONAL.

1. License—The following restricted rights are granted:
a. This Program is licensed to you solely for your use on a single computer or on a single computer

network system for your own individual use.  Even though copies of the Program may be provided on
disks of different sizes, you may not use both sizes simultaneously on different computers.  The
program may be transferred to and used on another computer, so long as the Program is de-installed
on the original computer, and shall under no circumstances be used on  more than one computer at a
time.
If designated for use on a network system, the Program may only be used in conjunction with the
LanPak for the Program.

b. You may either:  (i) make one copy of the Program solely for backup or archival purposes in support
of your permitted use of the Program, or (ii) transfer the Program to a single hard disk provided you
keep the original solely for backup or archival purposes.

c. You may transfer the Program together with this license to another person, but only if the other person
agrees to accept the terms and conditions of this Agreement.  If you transfer the Program and the
License, you must at the same time transfer all copies of the Program and its documentation to the
same person or destroy those not transferred.  Any such transfer terminates your license, but you
agree that you shall continue to keep all ACCPAC INTERNATIONAL materials confidential.

2. Restrictions—Without the prior written consent of ACCPAC INTERNATIONAL, you may not:
a. TRANSFER OR RENT THE PROGRAM OR USE, COPY OR MODIFY THE PROGRAM, IN

WHOLE OR IN PART, EXCEPT AS EXPRESSLY PERMITTED IN THIS LICENSE.
b. DECOMPILE, REVERSE ASSEMBLE OR OTHERWISE REVERSE ENGINEER THE PROGRAM,

EXCEPT TO THE EXTENT THE FOREGOING RESTRICTION IS EXPRESSLY PROHIBITED
UNDER APPLICABLE LAW.

c. REPRODUCE, DISTRIBUTE OR REVISE THE PROGRAM DOCUMENTATION.
d. USE ANY PROGRAM THAT IS DESIGNATED IN ITS DOCUMENTATION AS A “RUNTIME”

PROGRAM FOR APPLICATION DEVELOPMENT PURPOSES.
e. USE THE PROGRAM TO PROVIDE FACILITY MANAGEMENT, SERVICE BUREAU OR OTHER

ACCESS AND USE OF THE PROGRAM TO THIRD PARTIES.

IF YOU FAIL TO COMPLY WITH ANY OF THE TERMS OF THIS LICENSE, YOUR LICENSE WILL
BE AUTOMATICALLY TERMINATED.  SUCH TERMINATION SHALL BE IN ADDITION TO AND
NOT IN LIEU OF ANY CRIMINAL, CIVIL OR OTHER REMEDIES AVAILABLE TO ACCPAC
INTERNATIONAL.

3. Limited Warranty
ACCPAC INTERNATIONAL warrants that the Program will substantially perform the functions or
generally conform to the Program’s specifications published by ACCPAC INTERNATIONAL and included
in this package under normal use for a period of 90 days from the date of delivery to you.

ACCPAC INTERNATIONAL warrants that the disks on which the Program is furnished will be free from
defects in materials and workmanship under normal use for a period of 90 days from date of delivery to you.

ACCPAC INTERNATIONAL does not warrant that the functions contained in the Program will meet your
requirements or that the operation of the Program will be entirely error free or appear precisely as
described in the Program documentation.
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TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, AND EXCEPT AS
SPECIFICALLY STATED IN THIS LICENSE, THE PROGRAM IS PROVIDED AND LICENSED “AS
IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

ACCPAC INTERNATIONAL SHALL NOT BE BOUND BY OR LIABLE FOR ANY OTHER
REPRESENTATIONS OR WARRANTIES, WHETHER WRITTEN OR ORAL, WITH RESPECT TO THE
PROGRAM MADE BY ANY THIRD PARTY, INCLUDING AN AUTHORIZED RESELLER OR ITS
AGENTS, EMPLOYEES OR REPRESENTATIVES, NOR SHALL YOU BE DEEMED A THIRD PARTY
BENEFICIARY OF ANY OBLIGATIONS OF ACCPAC INTERNATIONAL TO AN AUTHORIZED
RESELLER.

4. Limitations of Remedies and Liability
To the maximum extent permitted by applicable law, the remedies described below are accepted by you as
your only remedies.

ACCPAC INTERNATIONAL’s entire liability and your exclusive remedies shall be:

a. If the Program does not substantially perform the functions or generally conform to the Program’s
specifications published by ACCPAC INTERNATIONAL, you may, within 90 days after delivery,
write to ACCPAC INTERNATIONAL to report a significant defect.  ACCPAC INTERNATIONAL’s
only responsibility will be to use its best efforts, consistent with industry standards, to cure the defect.
If ACCPAC INTERNATIONAL is unable to correct the defect within 90 days after receiving your
report, you may terminate your license and this Agreement by returning all copies of the Program
with proof of purchase and your money will be refunded.

b. If the Program media is defective, within 90 days of delivery, you may return it with a copy of your
proof of purchase, and ACCPAC INTERNATIONAL will replace it.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL ACCPAC
INTERNATIONAL BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING LOST PROFITS, LOST
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE
USE OR INABILITY TO USE THE PROGRAM, EVEN IF ACCPAC INTERNATIONAL OR AN
AUTHORIZED RESELLER HAD BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

5. General
This Program is provided with “Restricted Rights.”  Use, duplication or disclosure by the U.S. Government
is subject to the restrictions set forth in 48 CFR 52.227-10 (c) (1) and (2) or DFARS 252.227-7013(c) (1)
(ii) or applicable successor provisions.  The manufacturer is ACCPAC INTERNATIONAL, INC.

You are required to observe the relevant U.S. Export Administration Regulations and may not re-export the
Program in violation of these or other applicable export laws or regulations.

If any provision of this license is held to be unenforceable, the enforceability of the remaining provisions
shall in no way be affected or impaired thereby.  This Agreement shall be governed by the laws of the State
of California.

Any questions concerning this License should be referred in writing to ACCPAC INTERNATIONAL, INC.
6700 Koll Center Parkway, Pleasanton, CA  94566.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AND, BY OPENING THE
PROGRAM PACKET, INDICATE YOUR ACCEPTANCE OF ITS TERMS AND CONDITIONS.  YOU
ALSO AGREE THAT, UNLESS SPECIFICALLY COVERED BY ANOTHER WRITTEN LICENSE
AGREEMENT WITH ACCPAC INTERNATIONAL, THIS LICENSE IS THE COMPLETE AGREEMENT
BETWEEN US AND THAT IT SUPERSEDES ANY INFORMATION YOU RECEIVED RELATING TO
THE SUBJECT MATTER OF THIS AGREEMENT.

All product names referenced herein are trademarks of their respective companies.
© 1999 ACCPAC INTERNATIONAL, INC.,  6700 Koll Center Pkwy, Pleasanton, CA 94566
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Chapter 1
If You’re New to
Simply Accounting

Where to Start
If you: and want to: Go to:

Have just bought
the program

install the program on your
computer

Chapter 3, “Installing and
Starting Simply Accounting”

Have never used
Simply Accounting

practice using the program
with data from a sample
company

Chapter 4, “Tutorial: Learning
Simply Accounting”

Have never used
Simply Accounting
and are starting a
new business

set up the program to work
with your new company

■ Chapter 5, “Choosing
Options and Setting Up
Accounts”

■ The New Business Guide
(described in this chapter)

Have never used
Simply Accounting
and want to use it
in an existing
business

set up the program to work
with your company, and
enter your existing records

■ Chapter 5 to choose options
and set up accounts

■ Chapter 6 to enter existing
records and history

Haven’t used
computers very
much

find out how to navigate
through Simply Accounting
screens

Your Windows manual to find
out how to move around in the
program, enter data, and use
menus and toolbars

Have already set
up Simply
Accounting

use the program for day-to-
day tasks

The User Guide, especially
Chapters 4 to 12
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Learning the Basics
The Simply Accounting manuals assume that:

■ You have read the owner’s manual for the computer you
are using, and are familiar with your machine and with
using a mouse.

■ You are familiar with Windows terms such as icon, click,
double-click, drag, select, choose, menu, window, insertion
point, folder, dialog box, and Clipboard, and with basic
concepts such as directory (folder) structures and file
naming.

■ You have read the Accounting Manual that comes with this
program, and are familiar with accounting terms and
concepts such as debits and credits.

If you prefer, Simply Accounting can display non-
accounting terminology instead. See “Display Options” in
Chapter 5 to find out how to turn it on or off.

Getting Help

New Business Guide

The New Business Guide provides checklists for creating a new
company. They list the steps you need to complete (such as
searching the company name and obtaining licenses), and
provide the names of government agencies, contact numbers,
and Web links. To use the guide, choose New Business Guide
from the Business Assistant menu in the Home window.

Wizards

Simply Accounting includes several “wizards,” sets of steps
that guide you through complex tasks. See the Quick Reference
booklet for a list of wizards and a description of what they do.
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On-Screen Displays

Most of the screens in Simply Accounting include a “status
bar,” a line of text at the bottom of the screen. The line displays
information about a field or menu item when you drag the
mouse pointer over it.

Finding the Home Window

In case you need to use a window or command that is available
only from the Home window, most screens include a command
or toolbar button called Bring Home Window To Front. This lets
you find your way “home” from almost anywhere in the
program.

Online Help

You can display additional information or instructions for most
tasks in Simply Accounting. Either press the F1 key, or use the
Help menu to select a topic.

Simply Accounting Manuals

■ The Getting Started manual covers information you need to
set up Simply Accounting in preparation for day-to-day use.
You can also use it after you have set up the program, if you
need to change any options or settings, reinstall sample
data, or use the tutorial to train new staff.

■ The User Guide contains information on day-to-day use of
the program, and also covers advanced topics such as
importing and exporting data and customizing forms.

■ The Workbook provides additional practice in using Simply
Accounting. It guides you through setting up a company
and making typical entries.

■ The Accounting Manual helps you become familiar with
accounting terms and concepts such as debits and credits.
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Please see the card enclosed in your Simply Accounting
package to find out how to order a copy.

■ Once you are familiar with Simply Accounting, the Quick
Reference booklet will be a handy guide to refresh your
memory about tasks such as correcting entries. It also
contains a list of common tasks that tells you where to find
more information.
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Chapter 2
What’s New in This Version

If you are replacing an older version of Simply Accounting for
Windows with version 7.0, you should read this chapter before
you install the new program. It contains important information
about updating your data to work with the new program, and
about new features and changes in the program.

If you are replacing Simply Accounting for DOS (formerly
known as Bedford Integrated Accounting) with Simply
Accounting for Windows, be sure to read “Converting from
Simply Accounting for DOS,” later in this chapter.

Once you are familiar with the new features, and with the
effects of updating on your data, install the program, following
the steps in Chapter 3.

Your data is safe Note that updating (replacing the older version of the program
with a new one) does not harm your data; all your accounting
records are still intact after you install the new version. However,
updating does make some minor changes in your data; you
should read this chapter completely before you update, to be sure
you understand the process before you begin.

Installation Tips
Follow the steps in Chapter 3 to install the new version of
Simply Accounting. We recommend that you read the whole
installing section before you begin, to be sure you understand
the steps to take and decisions you must make.

In addition, note the following:
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Back up your data ■ Be sure you have a backup of your Simply Accounting data
files before you start.

■ If you have customized any of the CA-RET or Crystal
forms, be sure you have a backup of the revised forms.

Save time and avoid
errors

■ Save time and avoid errors by selecting only the components
you need.

– You probably need to select only the Simply Accounting
program files.

– You do not need to select Company Templates unless
you plan to do the exercises in the Workbook.

– You need to select Conversion Utility only if you are
updating from Simply Accounting for DOS.

■ When you are finished installing the program, update your
data to work with the new program. If you are updating
from Simply Accounting for Windows, go to the next
section, “Updating from a Previous Version of Simply
Accounting for Windows.” If you are updating from Simply
Accounting for DOS, go to “Converting from Simply
Accounting for DOS,” later in this chapter.

Updating from a Previous Version of Simply
Accounting for Windows

The updating process expands the size of your records to make
room for additional information kept by some of the program’s
new features. Before you can use the new program, you must
update your data so that it will work with the new version.
Updating is simple and takes only a few minutes.

After you update your data, do not use your Simply Accounting
data with older versions of the program.  Be sure to delete any
older versions of Simply Accounting from your hard disk, to
avoid inadvertently using the wrong version. Using an older
version of the program could damage your data.
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To update your data to work with the new version of Simply
Accounting:

Back up your data 1. If you have not already done so, make a backup of your
Simply Accounting data files. This ensures that you have an
intact copy of your data in case anything goes wrong during
the updating process.

Install the new
version

2. If you have not already done so, follow the steps in Chapter 3
to install the new version of Simply Accounting.

Start Simply
Accounting

3. Start Simply Accounting. When you see a message warning
you that your files are about to be updated to a new file
format, be sure you have a backup of your data files, then
choose Yes to continue.

When the program has finished updating your data, the
Session Date dialog box appears.

4. Enter the session date.

Check data integrity 5.  Use the Check Data Integrity command on the Maintenance
menu to check the integrity of your data, to find out whether
your accounts are in balance.

If the program finds integrity errors, read “Correcting
Integrity Errors” in Chapter 1, “Protecting Your Data,” in
the User Guide.

6. Make a backup copy of your updated data files.

7. Store the Simply Accounting program disks in a safe place.

8. If you have not already done so, read the rest of this chapter
to find out about the new features and changes in the
program.

Converting from Simply Accounting for DOS
If you are replacing Simply Accounting for DOS with Simply
Accounting for Windows, you must convert your data to be
able to use it with the new program.
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The conversion process expands the size of your records to
make room for additional information kept by some of the
program’s new features. Before you can use the new program,
you must update your data so that it will work with the new
version. Updating is simple and takes only a few minutes.

You use the conversion program included with Simply
Accounting for Windows to convert your data from Simply
Accounting for DOS.

Your data is safe The program does not alter your Simply Accounting for DOS
data files during conversion. The program creates a new set of
data files in Simply Accounting for Windows format, leaving
the old Simply Accounting for DOS files intact.

Note that program files are the computer files that contain
instructions that tell the computer how to run the Simply
Accounting program. Data files are the computer files that
contain information about your company and its accounting
records, including such information as the options you have
chosen for your company, lists of customers and vendors, and
records of journal entries.

Before You Convert

Before you convert your data, be sure the totals of your General
Ledger accounts are the same as the totals of the corresponding
subsidiary ledgers. For example, make sure that the total of all
balances owed to your vendors is the same as the balance of the
Accounts Payable account. Do not convert your data until all the
accounts balance.

The conversion process copies your current data files into a
different set of data files. We recommend that you store these
new files in a folder (directory) called \Winsim\Data. This
folder is created automatically when you install Simply
Accounting for Windows. If you want to store your data files in
a different folder, create the folder before you begin conversion.
If you are unsure how to do this, refer to your Windows
manual.
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To convert your data to work with Simply Accounting 7.0
for Windows:

Back up your data 1.  Make a backup copy of your Simply Accounting for DOS
data. Do not skip this step. If something goes wrong and
your data is damaged during conversion, you can use the
backup to restore it.

2. Start Windows.

3. If you have not already done so, install version 7.0 of the
Simply Accounting for Windows program on your hard
disk, following the instructions in Chapter 3 of this manual.

 When the program asks what type of setup you prefer, do
not select Compact. Select Typical, or select Custom and
then select Conversion Utility on the Select Components
screen.

4. Choose Start from the taskbar, then Programs, Simply
Accounting, Convert.

 The Simply Accounting conversion screen appears.

Type a path to your
data files

5.  Enter the folder (directory) and name of your Simply
Accounting for DOS data files.

The drive and directory where your current Simply
Accounting for DOS data files are located would normally
be C:\SIMPLY\DATA or C:\BEDFORD\DATA, unless
you store your data files in a different directory. For
example, you might select C:\SIMPLY\DATA\SN4.REC.

Remove the asterisk
from SN*.REC

Notice that you must remove the asterisk from the file name
that is originally displayed on the screen. The file name
should be SN4.REC, not SN*.REC.

6. Click Open.

 A new screen appears. The program asks you to enter a
path and file name for your new Simply Accounting for
Windows data files.

7. Select a path to your data. We recommend that you use
\Winsim\Data.

8. To accept this path and start the conversion process, click
Save, or press the Enter key. Or, if you do not want to
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continue, click Cancel, or press the Tab key to highlight the
Cancel button, then press Enter.

Conversion takes
several minutes

9.  The conversion process can take several minutes, and must
not be interrupted. When conversion is complete, a screen
appears, listing the number of Simply Accounting for DOS
records converted to Simply Accounting for Windows
format.

10. When you have finished reading this information, choose
OK.

11. Check the converted data to be sure all the accounts
balance, in case anything went wrong during the conversion
process.

12. Check the integrity of the converted data and make a
backup copy, following the instructions under “Checking
Data Integrity” and “Backing Up Data” in Chapter 1 in the
User Guide.

13. Read “If You Are Converting from Simply Accounting for
DOS,” later in this chapter, for information on the
differences between Simply Accounting for Windows and
Simply Accounting for DOS.

Learning Simply
Accounting

We recommend that you do the tutorial lessons in Chapter 4 to
learn how Simply Accounting for Windows handles some of the
basic accounting tasks.

You should also read the Simply Accounting for Windows
manuals to become familiar with the new terminology and
features you will be using.

Learning Windows If you have not used the Windows program before, we
recommend that you become familiar with the features and
terminology of that program as well.

New Features in Simply Accounting
The Simply Accounting program has been revised to add the
extra features most requested by users, and to enhance existing
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ones. The main changes to the program are described in this
section.

Easier Setup

Business Guide Helps You Set Up a New Company Quickly

The New Business Guide is a list of tasks that must be
completed when setting up a new business, such as obtaining
licences and registering the business name. It describes each
task, in simple language, and tells you where to find more
information (such as government phone numbers and Web site
addresses).

Easier Setup of Chart of Accounts

The Accounts icon window has been redesigned, allowing you
to drag and drop accounts and move them easily to different
parts of the list. You can also use the Tab and Shift+Tab keys to
change the indentation of an account, “promoting or demoting”
it to a group or subgroup account type as you wish. As before,
the program will warn you if any accounts are not in logical
order before you close the window.

Removal of “Set Ready”

Simply Accounting now lets you start entering transactions
more quickly when you’re setting up a new company. You can
still enter opening balances and historical transactions as before,
but the transaction entry windows are not locked, so you can
enter transactions at any time. This lets you get your company
“up and running” more quickly, while still giving you the
option of entering a complete set of historical transactions when
you have time. The program still maintains the tight control that
ensures that your books are balanced.
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You can enter history up until the end of the company’s first
fiscal year. After you enter a date in the new fiscal year, you can
no longer enter historical data.

Add Power to Simply Accounting by Linking to Other Programs

Download Bank Statements from the Internet

If your bank or financial institution allows you to download
bank statements in OFX (Open Financial Exchange) format, you
can import the statements into Simply Accounting, then use
Simply Accounting to reconcile the statements to your
accounting records automatically. This speeds up reconciliation
and reduces data entry errors.

For more information, see Chapter 18, “Importing Data,” in the
User Guide.

Use More Microsoft Office Forms with Simply Accounting

Several new Microsoft Office documents have been added to
Simply Accounting.

■ Budget Worksheet.

■ Balance Sheet (two columns).

■ Income Statement (two columns).

■ Employee Hours Worksheet 2 (for a two-week period).

For more information on these reports, refer to Chapter 20 in
the User Guide.
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New E-mail Features

Import E-mailed Invoices, Orders, and Quotes

MAPI-compatible
e-mail required

If you and your vendors or customers use Simply Accounting
and have MAPI-compatible e-mail programs (such as Lotus
Domino or Microsoft Mail), they can e-mail you their
sales invoices, sales quotes, and purchase orders. You can then
import these forms directly into your Simply Accounting
program, updating your accounts and other records
automatically.

This can help you save considerable time and avoid errors
because you do not have to re-enter transactions that your
vendor or customer has already prepared.

When a vendor e-mails a sales invoice or quote, Simply
Accounting imports it as your purchase invoice or quote. When
a customer e-mails a purchase order, Simply Accounting treats
it as your sales order.

To find out more about importing e-mailed invoices, orders,
and quotes, see Chapter 18, “Importing Data,” in the User Guide.

Automatically Send Confirmation to Vendors by E-mail

When you receive an invoice or quote from a vendor, Simply
Accounting can automatically e-mail a response to the vendor,
to confirm that you have received the invoice or quote.

In the vendor’s record, on the Options tab, check the E-mail
Confirmation Of Purchase Invoices And Quotes box. When you
process an invoice or quote from this vendor, Simply
Accounting will ask you whether you want to send
confirmation. If you say Yes, it displays the vendor’s e-mail
address and a message, which you can change if you wish.
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Send E-mail to Vendors and Customers from Simply Accounting

The Vendors and Customers windows now include an E-mail
button that lets you send an e-mail to the vendor or customer
from within Simply Accounting, without having to open your
e-mail program. (The vendor or customer must have a
MAPI-compatible e-mail program such as Lotus Domino or
Microsoft Mail.)

If the record already includes the e-mail address, you don’t
even have to type the address. Just click the E-mail button, or
choose E-mail from the Online menu, then type your message
and click Send.

More Flexibility

Process Entries throughout an Entire Fiscal Year

You can now process transactions with dates anywhere in the
current fiscal year, including dates in the future. (In earlier
versions of Simply Accounting, you could not enter a date later
than the session date except on paycheques.) The session date
(usually today’s date) still exists, but you are not restricted to
entering transactions on or before that date.

When you first install the new version of Simply Accounting,
this feature is turned off, so that, as in previous versions, you
cannot enter a transaction with a date later than the session date.

If you would like to allow transactions to be processed on dates
in the future, you can turn on this feature. In the Home
Window, on the Setup menu, choose Settings. On the System
tab, check the Allow Transactions In The Future box. You can
also choose to have the program warn you if the date is too far
in the future, by entering a number in the field Warn If
Transactions Are [     ] Days In The Future.

For more details about dates in Simply Accounting, refer to
Chapter 5.
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Use Two Bank Accounts for Purchases and Sales

You can now set up a second linked bank account for
purchases, and one for sales. When you enter a purchase or
sales transaction, you can select the account you wish to use for
that transaction. This is useful if, for example, you want to set
up a petty cash or clearing account.

On the Setup menu, choose Linked Accounts, then Vendors and
Purchases (or Customers and Sales). In the Alternate Bank field,
select the second bank account.

When you enter a purchase invoice and select Cheque as the
payment method, a new Paid From field appears, allowing you
to select the account you want to use to pay that invoice.

Similarly, when you enter a sales invoice and select Cheque as
the payment method, a new Deposit To field lets you select the
account you want to receive the payment.

Store a Ship-To Address for Customers

The Customers window now includes a Ship-To Address tab,
where you can store an address and contact name different
from the customer’s mailing address. When you select the
customer in the Sales, Orders, and Quotes window, the ship-to
address appears, in addition to the billing address. You can
change the ship-to address, or accept the one displayed.

When you first install the new version of Simply Accounting,
the program fills in the existing customer address as the ship-to
address. You can change it if you wish.

Show Subtotals on Sales Invoices

You can now print subtotals on sales invoices. On the Setup
menu, choose Reports and Forms, then the Invoice tab. Check
the Show Subtotal In Invoice box. When you print sales
invoices, the subtotal (before freight and taxes) appears
following the list of items sold.
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More Income and Deduction Fields in Payroll

■ You can now enter a second overtime rate in employee
records, in the Overtime Per Hour 2 field.

■ You can now set up three additional income fields, for a
total of five. (Earlier versions of Simply Accounting
included two income fields, usually called Salary and
Commission.) To enter names for the new fields, on the
Setup menu, choose Names. You can enter the additional
income amounts on each paycheque, or in the new Payroll
Cheque Run window (described later in this chapter).

■ You can now set up five additional deduction fields, for a
total of ten. To enter names for the new deductions, on the
Setup menu, choose Names. You can enter the new
deductions in the Employees window.

■ Every income field can now be associated with a separate
linked account. This allows you to keep track of wages
separately, providing more detailed records of your payroll
expenses. For example, you could keep track of
administrative, sales, and labour costs separately.

When you first install the new version of Simply
Accounting, all the income accounts are linked to the same
account you used in the earlier version. To enter different
accounts, on the Setup menu, choose Linked Accounts, then
Payroll. Under Wage Expenses, select the accounts you
want to use for the different income types.

Preset Amount or Percentage for Payroll Deductions

You can now set each payroll deduction as either an amount or
a percentage. On the Setup menu, choose Settings, then the
Payroll tab. Under Deductions, select either Amount or
Percentage Of Gross for each deduction you use.

The deductions appear on the Deductions tab in the employee
record. The numbers you enter in each deduction field will be
either a dollar amount or a percentage, according to the settings
you entered on the Payroll tab in the Settings dialog box.



New Features in Simply Accounting

Getting Started    2–13

SWC7GS02.DOC, printed on 03/08/99, at 10:19 AM. Last saved on 03/04/99 12:02 PM.

ACCPAC INTERNATIONAL, INC. Confidential

Make Credit-Card Payments to Vendors

In addition to accepting credit-card payments from customers,
you can now make credit-card payments to vendors.

On the Setup menu, choose Credit Cards. On the new Credit
Cards Used tab, enter information about the credit cards you
plan to use to make payments. For each card, select an account
to keep track of the amounts you owe the credit-card company,
and an account to record any credit-card fees or interest.

The next time you enter a purchase transaction, the credit cards
you have set up will appear in the new Paid By field, along with
Cash and Cheque. If you select a credit card, the transaction will
be processed to the Credit Card Payable account.

When you receive your bill from the credit-card company, the
new Credit Card Bill choice in the Payments window lets you
issue a cheque and enter any fees.

Reconcile More Accounts

You can now use the Account Reconciliation feature with any
asset, liability, or equity account. (In earlier versions of Simply
Accounting, you could reconcile only asset accounts.) You can
set up as many as 1,000 accounts for reconciliation.

For more information, refer to Chapter 7, “Setting Up an
Account for Reconciliation,” in this manual, and to Chapter 14,
“Reconciling Accounts,” in the User Guide.

Set Up Budgets for Projects

You can now set up a budget for revenues and expenses for
each project. A new Project Budget report shows actual and
budget amounts, with dollar or percentage differences, for the
current or previous year.

To be able to set up a budget for a project, on the Setup menu,
choose Settings, then the Project tab. Check the Budget Project
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box and choose a budget period frequency. Then, in the Project
window, on the Budget tab, check Budget This Project and enter
the revenue and expense amounts you want to budget for each
period.

Allocate Amounts to Projects from Any Account

In earlier versions of Simply Accounting, you could allocate
revenues and expenses to projects. You can now allocate from
any account, allowing more flexibility in keeping track of project
assets and liabilities. To be able to allocate from an asset,
liability, or equity account, open the account record in the
Accounts window, then check the Allow Project Allocations
box.

Optional Prenumbering of Forms

In earlier versions of Simply Accounting, all forms (invoices,
cheques, and so on) had a default (preset) number. Now, you
can leave the number blank if you wish, by leaving the Next
Number On field blank in the Forms tab in the Setting dialog
box. The form will appear on the screen with the Number field
blank, letting you enter any number you wish.

Save Time

New Automatic Payroll Cheque Run

A new icon in the Home window, Payroll Cheque Run, lets you
process multiple paycheques quickly and easily, without having
to enter each one separately. Pay all employees at once, pay
only the employees who are due to be paid in the current pay
period, or pay only selected employees. The program calculates
taxes automatically.

For more information about payroll cheque runs, see Chapter 7,
“Paying Employees,” in the User Guide.
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Enter Regular and Overtime Hours in the Employee Record

You can record the number of regular and overtime hours each
employee normally works in a pay period, on the Income tab in
the employee record. The number of hours appears
automatically on each paycheque for that employee, but you can
change it if you wish. (In earlier versions of Simply Accounting,
you had to enter hours each time you entered a paycheque.)

Enter Benefits in the Employee Record

You can record a standard benefit amount for each employee,
on the Income tab in the employee record. The amount appears
automatically on each paycheque for that employee, but you can
change it if you wish. (In earlier versions of Simply Accounting,
you had to enter benefits each time you entered a paycheque.)

Update Your Budget More Easily

You can now enter a budget amount for an entire year, and
have Simply Accounting divide it into equal portions and enter
the correct amounts for each budget period. (In earlier versions
of Simply Accounting, you had to enter a budget amount for
each period, even if all the amounts were the same.)

In the account record, on the Budget tab, enter an amount in the
Total Budgeted Amount field, then click the Allocate button.
Simply Accounting divides the total by the number of periods
(for example, months or quarters), and enters an equal amount
for each period.

Automatically Delete Transaction Details at Year End

A new command, Automatically Clear Data, on the
Maintenance menu, lets you set up Simply Accounting to clear
details over a certain age at the end of your fiscal year,
automatically. This helps prevent your data files from being
cluttered with old information and keeps them from getting too
large to run efficiently.
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You can select which data you want to clear, and indicate the
age of the details you want to retain. (For example, you may
want to clear all invoices over 12 months old, or all account
reconciliation data over 6 months old.)

Protect Your Data

Automatic Working Copy Helps Protect Data on a Network

If you store your Simply Accounting data on a network server,
you can now have the program automatically copy the data
from the network to your local drive (hard disk) when you start
Simply Accounting. Even if your network fails while you are
working on Simply Accounting, your data is safe on your hard
disk. When you exit Simply Accounting, the program
automatically copies the data back to the network, ready for
you to use next time.

To use this feature, choose Working Copy on the File menu in
the Home window, then enter the location (drive and folder
name) to which you want Simply Accounting to copy the data.

If your Simply Accounting system is set up to use passwords, a
user must start Simply Accounting with the system password to
be able to change the location to which the data is copied.

Restore a Backup without Opening Simply Accounting

You can now restore a backup copy of your data without
starting the program. This can be useful if your data has been
damaged and you are unable to open Simply Accounting.

To restore a backup, start Simply Accounting. At the Select
Company window, select the new option Restore From Backup,
then follow the instructions on the screen.
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Automatically Check Validity of Social Insurance Numbers

When you enter a Social Insurance Number in an employee
record, the program automatically checks that it is a valid
number, and warns you if it is not. This ensures that you have
valid numbers on file when you print reports and forms to
submit to the government.

Simply Accounting does not check the validity of Social
Insurance Numbers that you entered before you installed the
new version. However, if you make a change to an existing
record, it will check the number, and warn you when you try to
close the record if it is not valid.

Set Employee Status to Inactive

In the employee record, you can set the status of the employee
to Inactive. You cannot issue paycheques or print T4 or Relevé 1
slips for inactive employees. This can be useful if you have high
turnover and do not want your payroll reports to include
employees who no longer work for you.

New “Ease-of-Use” Features

Some aspects of the Simply Accounting interface — the way it
looks and the way you work with it — have been redesigned, as
described in this section.

Keep the Same Vendor or Customer on Multiple Invoices

Use the Same
Vendor [or
Customer]
Next Time

If you are entering several invoices, orders, or quotes for the
same vendor or customer, you can retain the vendor or
customer name for the next invoice, saving time and avoiding
data entry errors. Just click Use the Same Vendor [or Customer]
Next Time
on the toolbar, or select it from the Purchases (or Sales) menu.
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Checklists Help You through Complex Tasks

When you’re trying to complete a complex task, it can be
difficult to remember what you’ve done and what you have left
to do, especially if you’re interrupted before you finish. Simply
Accounting provides several checklists that help you through
day-end, month-end, and year-end procedures. The checklists
show you the date you last completed each task, and let you
check off each component on the screen as you complete it.

You can also create your own customized checklists, for
whatever tasks you wish.

To use or create a checklist, in the Home window, on the
Business Assistant menu, choose Checklists. Either double-click
an existing checklist, or click Create to set up a new one.

For more information, refer to Chapter 13 in the User Guide.

Easier to Enter Transaction Types and Payment Types

The Transaction Type and Paid By fields have been redesigned
to make it easier to understand and enter the payment type on
invoices.

In the Sales window, the Sale On Account and Sale With
Payment transaction types have been replaced by “Invoice,”
and the Paid By field now includes Pay Later as an option. The
Paid By field still includes Cash, Cheque, and any credit cards
you have set up.

Similarly, In the Purchases window, the Purchase On Account
and Purchase With Payment transaction types have been
replaced by “Invoice,” and the Paid By field now includes Pay
Later as an option, in addition to Cash and Cheque. You can
also make payments to vendors by credit card (described earlier
in this chapter under “Make Credit Card Payments to
Vendors”).
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Find Records in a List More Easily

When selecting from a drop-down list, you can now type the
first few letters of the name you are searching for, to display
that name. (In previous versions of Simply Accounting, in most
lists you could type the first letter only, to go to the first of the
items beginning with that letter.)

Start a New Year More Easily

The new Start New Year command on the Maintenance menu
lets you start a new fiscal or calendar year more easily.
(Previously, you had to enter the new date using the Advance
Session Date command.) To start a new fiscal or calendar year,
choose Start New Year from the Maintenance menu in the
Home window. If your fiscal year is not a calendar year, select
which type of year you want to change, then choose OK.

Switch to the Home Window Quickly

A new command has been added called Bring Home Window
To Front. It lets you quickly switch to the Home window if you
need to use a command or icon available only in the Home
window. The command appears:

■ On the toolbar in all windows.

■ On the View menu in all icon windows (Vendors,
Employees, and so on).

■ On the Edit menu in all records windows (Vendors,
Employees, and so on).

■ On the File menu in all transaction entry windows.
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New and Enhanced Reports

Account Reconciliation

The Account Reconciliation Detail report now includes totals for
the debit and credit columns.

Today’s Date on Reports

You can now include a printed-on date on reports. The date
appears at the bottom of the report, and is unrelated to the As
At date you select when preparing to print the report. The
program uses your computer’s system date, usually today’s
date.

To include the print date on reports, on the Setup menu, choose
Reports and Forms. Check the Print The System Date On
Reports box.

New and Renamed Reports

■ The following reports and forms have been added to Simply
Accounting.

– Project Budget report

– Project Allocation report

■ The Project report has been renamed the Project Income
report.

For more information on these reports, refer to Chapter 16 in
the User Guide.

Export Reports in Excel 97 Format

If you export a report to Excel 97, the file is now exported in
Excel 97 format.
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Other New Features and Changes

Inventory Turnover Information Always Available

The Track Inventory Turnover feature has been removed. The
program now stores inventory turnover information
automatically if you have checked the Store Invoice Lookup
Details box, on the System tab in the Settings dialog box.

See the Transaction Entry Number While Making Entries

You can now see the transaction entry number the program will
assign to the entry you are making, before you process the
entry. (In previous versions of Simply Accounting, the
transaction entry was not assigned until you processed the
entry.) This can be useful if you want to make a note of the
entry number without having to look it up in a report after
processing.

In any transaction entry window, choose Display [entry type]
Transaction Detail to see the details of the entry and the
transaction number.

Field Renamed

The Salary Hours field in the employee record has been
replaced by an Hours Per Period field. The field still stores the
usual number of working hours for salaried employees,
required for the Record of Employment.

New Menus

Two new menus have been added to the Home window.

■ The new Business Assistant menu contains commands that
help you run your business more smoothly.

– To-Do Lists (formerly on the Maintenance menu).
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– Checklists (described earlier in this chapter).

– Business Advice (formerly on the Help menu).

– New Business Guide (described earlier in this chapter).

■ The new History menu contains the Finish Entering History
command, which replaces the old concept of Set Ready. (See
“Removal of ‘Set Ready’” earlier in this chapter). The menu
is visible only if you have not yet used the Finish Entering
History command (or the Set Ready command in an earlier
version of Simply Accounting).

New Colours

You can now change the background colours in the Home
window, and on the display screens for invoices, orders, quotes,
receipts, and cheques. In the Home window, on the View menu,
choose Appearance, then select the colours you want to use for
the different windows and forms.

New Icons

The Purchases, Orders, and Quotes icon and the Item Assembly
icon have been redesigned. They still appear in the same
location in the Home window.

The Payment Cheques icon has been renamed Payments.

The To-Do Lists button in the toolbar in the Home window has
also been redesigned.
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If You Are Converting from Simply Accounting for
DOS

You Must Change Your Password

When you convert from the DOS version of Simply Accounting
to the Windows version, your password for the DOS version is
deleted. Anyone who uses your data in Simply Accounting for
Windows has access to all parts of the program.

If you wish to use passwords in the Windows version, you must
set them up using the Set Security command on the Setup
menu. For instructions, see Chapter 1, “Protecting Your Data,”
in the User Guide.

Changes in Your Data

Note that in Simply Accounting for DOS, inventory costs had
three decimal places and were not rounded. In Simply
Accounting for Windows, inventory item costs can have up to
four decimal places and are rounded to the nearest hundredth
of a cent. This may result in a slight difference in inventory costs
when you convert your data to Simply Accounting for
Windows.

Otherwise, the conversion program does not change your data,
only the format in which it is stored. Your Simply Accounting
for DOS data files also remain unchanged after conversion.

Larger Fields

The Simply Accounting for Windows program can accept and
display amounts up to $999,999,999.99 ($1 billion minus one
cent). The limit for monetary amounts in Simply Accounting for
DOS was $20 million.

An employee’s regular or overtime hourly rate can have up to
four decimal places.
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The selling price per unit of an inventory item can have up to
four decimal places.

Inventory items (descriptions) can have up to 35 characters (the
limit was 26 in Simply Accounting for DOS).

In Simply Accounting for Windows, inventory item costs can
have up to four decimal places and are rounded to the nearest
hundredth of a cent. In Simply Accounting for DOS, costs had
three decimal places and were not rounded. This may cause a
difference in inventory costs when you convert your data to
Simply Accounting for Windows.

Source and item codes can be up to 13 characters long. This
applies to invoice numbers, cheque numbers, journal entry
source codes, and inventory item codes.

New Default Values

In Simply Accounting for DOS, the default aging periods were
0 to 29 days, 30 to 59 days, and 60 to 90 days. In Simply
Accounting for Windows, the default aging periods are 0 to 30,
31 to 60, and 61 to 90 days. If you use the default aging periods,
this may cause differences in your Vendor Aged and Customer
Aged reports. (The default aging periods are the periods the
program uses automatically, unless you change them, using the
Settings command on the Setup menu.)

Where To Now?
You are now familiar with the new features in Simply
Accounting for Windows. You should now skim or read the
new manuals included in the Simply Accounting package, to
find detailed instructions to help you use the new or changed
features.
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To install Simply Accounting for Windows (that is, to copy it to
your computer’s hard disk so you can use it), follow the
instructions in Chapter 3 of this manual.

If you wish, do the lessons in Chapter 4, or the Workbook
exercises, to practice using the program. Refer to the User Guide
for information on using the program for day-to-day
accounting.
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Chapter 3
Installing and Starting Simply
Accounting

This chapter describes how to install Simply Accounting
version 7.0. Installation copies the program files and various
components to your computer’s hard disk and adds Simply
Accounting to the list of programs on the Programs menu.

■ If you are updating from an earlier version of Simply
Accounting for Windows, or converting from Simply
Accounting for DOS, be sure to read Chapter 2, “What’s
New in This Version.”

■ If you are installing Simply Accounting for the first time, be
sure to read Chapter 1, “If You’re New to Simply
Accounting.”

Installing Simply Accounting
Follow this installation checklist to set up Simply Accounting to
update your existing files, or create new files.

We recommend that you read all of this section before you
begin installation, to be sure you understand the steps to take
and decisions you must make.

New to Windows? If you are relatively new to Windows, we recommend that
you read your Windows manual before starting the Simply
Accounting program.
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Installation Checklist

❏ Check your
software and
hardware

The recommended minimum software and hardware your
computer system needs to run both Windows and Simply
Accounting successfully are:

■ Simply Accounting for Microsoft Windows. The program
comes on 3½" high-density disks or one CD-ROM.

■ Microsoft Windows 95.

■ A personal computer with an 80486/33 processor.

■ A hard disk with 25 Mb (35Mb recommended) of free
space, and one floppy-disk drive or a CD-ROM drive.

■ 16 Mb of memory (RAM).

■ A VGA or similar high-resolution monitor that is supported
by Windows.

■ A printer that is supported by Windows, if you want to
print reports, statements, cheques, purchase orders, and
invoices.

■ A mouse that is supported by Windows.

■ Office 95, if you want to use the Microsoft Office
integration options.

■ An Internet connection, e-mail service and a word
processing program, if you want to use the e-mail options.

❏ Find the Simply
Accounting serial
number

The installation program asks you for the Simply Accounting
serial number, so you need to locate this number on the outside
of the Simply Accounting box or on the registration card that
came in the box.

❏ Decide which
components to
install

You need to decide which of the Simply Accounting program
components you need. During installation, you can choose to
install some or all of the components. They are described in
“Simply Accounting Components,” later in this chapter.

❏ Back up your
CA-RET and
Crystal forms

If you are converting from an earlier version of Simply
Accounting, and have customized any of the CA-RET or Crystal
forms, be sure you have a backup copy of the revised forms (see
Chapter 2 for clarification).
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❏ Back up your
Simply Accountin
g diskettes

If you are installing from diskettes, make backup copies of your
program disks, before installing Simply Accounting, in case
they ever become lost or damaged.

To make backup copies of program disks:

1. Choose My Computer. Select the icon for the disk you want
to copy from, usually 3½ Floppy (A:).

2. From the File menu, choose Copy Disk. Follow the
instructions on your screen.

❏ Install Simply
Accounting

To install Simply Accounting:

1. Start Windows and make sure no other programs are
running.

2. Insert the Simply Accounting CD-ROM in your computer’s
CD-ROM drive. If you are installing from diskettes, insert
Disk 1 in the floppy-disk drive.

3. If you are installing from a CD-ROM, the installation
program may start automatically. If so, go to step 4.

If the installation does not start automatically, or if you are
installing from Disk 1, choose the Start button from the
taskbar, then choose Run.

If you are installing from a CD-ROM, type d:\launch, press
Enter, then select “Install Simply Accounting.” If you are
using diskettes, type d:\setup and press Enter.

For d, substitute the letter of the drive in which you inserted
the Simply Accounting disk. (Diskette drives are often A or
B. CD-ROM drives are often D or E.)

4. Follow the step-by-step instructions as they appear on the
screen.

When you see the Setup Type window, you will be asked to
choose a Typical, Compact, or Custom setup. We
recommend that you select a Typical setup because it
installs the most common components needed by Simply
Accounting.
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If you chose Custom setup and want to uncheck a program
component, click the check mark beside it, or highlight the
line and press the Spacebar. (To decide which components
to install, see the next section, “Simply Accounting
Components.”)

❏ Restart your
computer

5. If you see a message informing you to restart your system,
restart your computer so the program can work properly.

6. Put the Simply Accounting disks away for safekeeping.

Simply Accounting Components
The program components are placed in a folder called either
\Program Files\Winsim or \Progra~1\Winsim, on the current
drive of your hard disk, or, if you prefer, in a different drive
and folder you specify during installation. Some program
components are placed in subfolders of the folder you specify
for the program files.

Component Description

Simply Accounting
Program

Installs the Simply Accounting program files in the \Winsim
folder.

Sample Data Installs the records of a fictional company to let you practice
using the program, or do the lessons in Chapter 4. Sample data
will be placed in a subfolder called \Samdata.

Company Templates Installs predefined charts of accounts that you can use when
creating your own company. You should also select this choice
if you want to do the exercises in the Workbook. The company
templates contain charts of accounts suitable for various types
of businesses. Company templates will be placed in a
subfolder called \Template.

Tip: If you are installing Simply Accounting for the first
time, be sure to install the company templates. The
program will help you select the company template best
suited for your company’s needs, as described in the
section “Creating a Company” in Chapter 5, “Choosing
Options and Setting Up Accounts.”
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Component Description

Crystal Reports
Print Engine

Lets you print customizable forms and reports. Program files
will be placed in the \Windows folder.

Forms and Reports Installs sample invoice, statement, purchase order, sales order,
receipt, and cheque forms you can customize for your own
company. You should also select Forms And Reports if you
want to display and print the customizable management
reports provided by Simply Accounting. The forms and
reports will be installed in a subfolder called \Forms.

If you are already using CA-RET forms, and have changed the
forms for your own use, be sure the file names are different
from the names of the CA-RET forms that come with Simply
Accounting. The program will overwrite existing files that
have the same name as the new files. To see a list of CA-RET
file names, refer to “Custom Form File Names and Fields” and
“Management Report File Names and Fields,” in Chapter 21 in
the User Guide.

Microsoft Office
documents

Installs subfolders for Office 95 or Office 97 documents,
depending on the version installed on your computer. These
documents can use Simply Accounting data to create
customized form letters, spreadsheets, and other useful
documents. They are stored in the \Office subfolder.

Manuals
(CD-ROM
installation only)

Installs Simply Accounting manuals in .PDF format to the
\Manuals subfolder. Select Custom on the Setup Type screen,
then select Manuals in the Select Components screen. You will
be prompted to install Acrobat Reader, if it is not already
installed on your computer.

New Business
Guide

Provides you with checklists for creating a new company,
including the names of provincial and federal government
business agencies, contact numbers, and handy Web links.
This component is included when you select Typical install.
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Component Description

Conversion Utility Lets you convert data files created using Simply Accounting
for DOS (formerly called ACCPAC Bedford Integrated
Accounting) to work with Simply Accounting for Windows.
The utility files will be placed in the \Winsim folder.

When you are ready to convert your data, refer to the section
“Converting from Simply Accounting for DOS,” in Chapter 2
of this manual.

 If you are not changing to Simply Accounting for Windows
from Simply Accounting for DOS, you do not need to install
the Conversion program

Demos
(CD-ROM
installation only)

Installs audio-visual presentations that describe some of the
main features of the program; you can run the demos if you
have a sound card. To install the demos, select Custom on the
Setup Type screen when you are installing Simply Accounting,
and then select Demos in the Select Components screen.

Starting Simply Accounting
The most common way to start a program in Windows is to use
the Start button.

To start Simply Accounting using the Start button:

1. Choose the Start button on the taskbar.

2. Choose Programs.

3. Choose Simply Accounting (or the name of another
submenu where you installed Simply Accounting).

4. Choose Simply Accounting on the final menu.
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 The Select Company window appears:

5. If you are using Simply Accounting for the first time, choose
the Open The Sample Company To Help You Learn Simply
Accounting option or the Create A New Company option.

 If you are upgrading from a previous version of Simply
Accounting for Windows, you will see an additional option
on the Select Company window that allows you to open the
last company you worked on. Choose this option, or the
Select An Existing Company option.

6. Enter a session date.

 

 The session date is the date the program uses as the
processing date for all entries made during the current
session.
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 The date shown in the dialog box is the session date on
which the program was last used. To find out more about
the session date and other dates, see the “Dates” section in
Chapter 5.

7. Choose OK to accept the displayed date.

The Home window The program’s main window, the Home window, appears:

 

Simply Accounting lets you
display either accounting or
non-accounting terms (for
example, in accounting terms,
“Vendors & Purchases”
displays as “Payables”). To
switch terminology, choose
Setup, Settings, and then the
Display tab. The Simply
Accounting manuals use non-
accounting terminology.

When you start Simply Accounting with your own company’s
data, the file name you assigned to the data appears in the
title bar at the top of the window (in this case, UNIVERSL).

8. Go to the section “Where To Now?” later in this chapter.

Reinstalling Sample Data
Why reinstall? To do the lessons in Chapter 4, the data you use must match the

data used in those instructions.

If anyone has been experimenting with the sample data, follow
these steps to ensure that you start with a complete, unaltered
set of data.
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To reinstall sample data:

1. Start Windows and make sure no other programs are
running.

2. Insert the Simply Accounting CD-ROM in your computer’s
CD-ROM drive. If you are installing from diskettes, insert
Disk 1 in the floppy-disk drive.

3. If you are installing from a CD-ROM, the installation
program may start automatically. If so, go to step 5.

If the installation program does not start automatically, or if
you are installing from Disk 1, choose the Start button from
the Taskbar, then choose Run from the menu that appears.

4. If you are installing from a CD-ROM, type d:\launch, press
Enter, then select “Install Simply Accounting.” If you are
using diskettes, type d:/setup and press Enter.

For d, substitute the letter of the drive in which you inserted
the Simply Accounting disk. (Diskette drives are often A or
B. CD-ROM drives are often D or E.)

5. Follow the step-by-step instructions as they appear on the
screen.

At the Setup Type screen, choose Custom.

What to select When the setup program asks you to select the components
you want to install, select (check) Sample Data to be able to
do the lessons in Chapter 4. Uncheck all other components in
the list. (To uncheck, click the check mark, or highlight the
line and press the Spacebar.)

Sample data will be placed in the \Program Files\Winsim\
Samdata or \Progra~1\Winsim\Samdata subfolder, on the
current drive of your hard disk.

6. When the files are installed, put the Simply Accounting
disks away for safekeeping. You are now ready to start the
lessons in Chapter 4, or to do the exercises in the Workbook.
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Uninstalling Simply Accounting
If, for any reason, you need to remove the Simply Accounting
program and data files from your hard disk, you can do so, as
follows.

In the Start menu, choose Settings, then Control Panel. Choose
Add/Remove Programs, then select the Install/Uninstall tab.
Select (highlight) Simply Accounting v7.0, then choose the
Add/Remove button.

Where To Now?
Installing for the first
time?

To practice using the program to do common tasks, go to
Chapter 4, “Tutorial: Learning Simply Accounting.” You can
also do the exercises in the Workbook. The Workbook provides
step-by-step lessons you can use to practice setting up and
using Simply Accounting, without affecting your company’s
“real” data. Follow the exercises to create a complete set of
practice data.

If you are ready to set up the program to work with your own
data, refer to Chapter 5, “Choosing Options and Setting Up
Accounts,” and Chapter 6, “Entering Account History.”

Upgrading from
Simply Accounting
for Windows?

If you were using a previous version of Simply Accounting for
Windows, you must update your data to work with the new
version. Go to the section “Updating from a Previous Version of
Simply Accounting for Windows,” in Chapter 2, “What’s New
in This Version.”

Upgrading from
Simply Accounting
for DOS?

If you were using Simply Accounting for DOS (formerly called
ACCPAC Bedford Integrated Accounting), you must convert
your data to work with Simply Accounting for Windows. Go to
the section “Converting from Simply Accounting for DOS,” in
Chapter 2.

If your system is already set up and your own company’s data
is ready to use, refer to Chapter 2, “Maintaining Records,” and
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Chapters 4 to 13, in the User Guide, for information on using the
program to enter day-to-day transactions.

You can also use the on-screen Help and Advice buttons and
menus to find out more about Simply Accounting.
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Chapter 4
Tutorial: Learning Simply
Accounting

This chapter contains lessons that show you some of the basic
features of the Simply Accounting program. The lessons let you
familiarize yourself with Simply Accounting before setting up
the program with your own data. You can also use this chapter
after you have set up Simply Accounting, to practice using parts
of the program that may be unfamiliar, or to train new staff.

You can do the lessons at any time, in any order. They show
you how to:

■ Display reports.

■ Enter a vendor invoice.

■ Look up a sales invoice.

■ Store and recall recurring entries.

■ Change an employee record.

■ Create an employee record.

■ Remove a customer record.

Your data is safe You use the sample data included with the program to do these
lessons. The sample data gives you a chance to practice using
the program without affecting the data for your own company.

Universal
Construction

The sample data contains the records for a fictional company
called Universal Construction, located in Vancouver, B.C. The
firm is currently working on several projects, including a
subdivision, several shopping centres, and a basement
renovation.

Universal’s records keep track of its vendors (suppliers),
customers, employees, inventory of construction materials and
services, and projects.
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For additional
practice

For additional practice, use the Simply Accounting Workbook.
The Workbook includes lessons that take you step by step
through the process of setting up a company’s books and
using the program for day-to-day operations.

Before You Start
If you are not familiar with the Home window in Simply
Accounting, refer to the Quick Reference booklet.

Terminology Simply Accounting has an option to display accounting or
non-accounting terminology. This manual and the User Guide
use non-accounting terminology that the average person can
understand more easily. Refer to the Quick Reference booklet for
a list of non-accounting terms and their accounting equivalents.

“Choose” and
“select”

Note that in Microsoft Windows terminology, the word
“choose” means to use a mouse or the keyboard keys to begin
an action in Windows. The word “select” means only to
highlight an item. This does not begin an action.

When you are using a mouse in Simply Accounting, you
“choose” an icon in the Home window by pointing to it and
double-clicking the mouse button. This opens a new window.
You “select” an icon in the Home window by pointing to it and
clicking the mouse button once. This highlights the icon without
opening a new window. A darker colour appears around an
icon’s title when it is highlighted.

If you are right-handed, the word “click” as used in Simply
Accounting manuals refers to the left mouse button unless the
right mouse button is specifically mentioned. If you are
left-handed, “click” refers to the right mouse button unless the
left mouse button is specified.

Install sample data Before you start the lessons in this chapter, install the sample
data, following the instructions in Chapter 3, “Installing and
Starting Simply Accounting.”
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If you or someone else has installed the sample data, and
subsequently made changes to it, you must reinstall it, so that
your data matches the data used in these lessons. Follow the
instructions under “Reinstalling Sample Data,” in Chapter 3.

If you have already started Simply Accounting with the
UNIVERSL data file, skip to “Lesson 1: Display Reports.”
Otherwise, start the program now by following the instructions
in the next section, “Starting the Program with Sample Data .”

Starting the Program with Sample Data
If you have not installed the Simply Accounting program or the
sample data that comes with the program onto your hard disk,
refer to Chapter 3 in this manual for installation instructions.

To start Simply Accounting:

1. Choose the Start button on the taskbar.

2. Choose Programs.

3. Choose Simply Accounting (or the name of another
submenu where you installed Simply Accounting).

4. Choose Simply Accounting on the final menu.

5. Select Open The Sample Company To Help You Learn
Simply Accounting, then choose OK.
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6. Choose Accrual-Basis.

7. Choose the OK button to accept the displayed date. To
choose OK, click it with the mouse, or press the Enter key.

The Home window Once you accept the date, the Simply Accounting program’s
Home window appears:
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This is the program’s main
window, known as the
Home window.

For information on any icon
in the Home window:
■ Point to the item with

the mouse pointer and
read the description on
the status bar, or

■ Click the icon once to
select it and press F1
for Help.

The status bar provides
information about fields,
icons, and menu choices.

Lesson 1: Display Reports
Lesson objectives ■ Display reports from the Reports menu.

■ Use “drilldown” to view details related to a displayed
report.

■ Use the scroll bar and keyboard keys to move up and down
in a report.

Chapter 16, “Reports and Graphs,” in the User Guide, describes
each Simply Accounting report. After you display a report, you
can print it or export the information to other programs.

You will display two reports in this lesson: the Vendor List and
the Payment Transactions report.

Display the Vendor List

The first report you will display is the Vendor List, a list of all
the vendor (supplier) records in Universal Construction’s
Vendors and Purchases module.
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To display the Vendor List:

1. In the Home window, on the Reports menu, select Lists,
then choose Vendors.

The Vendor List is displayed.

 

You double-click a vendor to
“drill down” to the Vendor Aged
Detail report when the mouse
pointer changes to a magnifying
glass with a plus sign in it. For
more information about
drilldown, see Chapter 16,
“Reports and Graphs,” in the
User Guide.

The status bar tells you what
information will appear when
you double-click to drill down.

Resizing the window You can increase the size of the report window. Click once
in the top left corner of the window, or press the Alt key
then the Spacebar. Choose Maximize from the menu that
appears. You can also use the mouse pointer to drag a
corner of the window.
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2. Look at the first vendor on the list, Abercrombie Hardware
Inc. Notice that the entry includes the name, phone number,
contact person (Nick Dewitt), address, federal tax
identification number, and e-mail address. There is also
space for a fax number and a Web site address.

The program can print some of this information on cheques
(the name, address, and contact). It is also useful in case you
need to write to, telephone, or send e-mail to the vendor,
and you can use it to print mailing labels.

Move to the bottom of the list. You can see that Universal
has 27 vendors on file. (To see all the vendors, use the scroll
bar or arrow keys to move up and down the list.)

3. When you finish reviewing the Vendor List, close the report
window and return to the Home window. (Click once in the
top left corner of the window, or press the Alt key, then the
Spacebar. Choose Close from the menu that appears.)

Display the Payment Transactions Report

Simply Accounting can display and print a report for each of its
transaction-entry windows. You will now practice displaying
the Payment Transactions report, to see how a transaction-entry
report differs from a record list, like the Vendor List you
displayed earlier. You can use a transaction-entry report to
check that you have entered transactions correctly, and as a
permanent printed record of your entries.

You will display a list of entries made in the Payments window
for a two-month period, from January 15, 2000, to March 15,
2000.

To display the Payment Transactions report:

1. In the Home window, on the Reports menu, select
Transaction Details, then choose Payments.
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The Payment Transactions Options dialog box is displayed.

 

The program can select
information by processing
date or by transaction
number.

■ Leave Current Year selected to include this year’s
entries on the report.

■ If you select By Date, the program asks you to choose a
range of dates for the report. The report will include all
entries for the dates you specify.

■ If you select By Transaction Number, the program asks
you to choose a range of transaction numbers.

■ Leave the By Date option selected. You must now enter
start and finish dates, to display the report for the
period from January 15, 2000, to March 15, 2000.

2. Click the arrow at the right of the Start field to display the
list of default (preset) start dates. Or, with the Start field
highlighted, press F4, or Alt and the Down Arrow key, to
display the list.
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 (A field is an area on the screen in which you enter
information. It is usually a box beside or below the
description of the information to be entered.)

The date 1-15-00
(January 15, 2000) is
not listed, so you must
enter the date
manually.

3. Make sure the Start field is selected, then type 1-15-2000 and
press Tab. Note that the month, day, and year may appear
in a different order on your system, depending on the date
format set in the Control Panel in Windows.

 The finish date displayed is 3-15-2000. This is the date you
need, so do not change it.

4. Choose OK.

 

You can double-click the
report to “drill down” to
related information, when
the mouse pointer changes
to a magnifying glass with a
plus sign in it. For more
information about drilldown,
see Chapter 16, “Reports
and Graphs,” in the User
Guide.

The status bar tells you what
information will appear when
you double-click.

Resizing the window You can increase the size of the report window. Click once
in the top left corner of the window, or press the Alt key,
then the Spacebar. Choose Maximize from the menu that
appears.

5. Click in the scroll bar or press the arrow keys to move up
and down in the report.
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The report shows all entries made in Universal’s Payments
window from January 15, 2000, to March 15, 2000.

Notice the first entry. This was a payment made to Office
Equipment Rentals.

The transaction entry shows that:

■ The payment was made on January 19, 2000.

■ The transaction number is J238. The program assigned
this number automatically when the entry was made.

■ The source code is 282. This is the number of the cheque
used to pay the vendor.

■ Office Equipment Rentals is listed as the recipient of the
cheque. The program fills in the vendor name, as
entered on the cheque.

■ The Accounts Payable account (2200) was debited in
this transaction, and the Regal Bank: Current
account (1080) was credited.

■ The debit and credit amounts are 15,000.00.

■ Scroll to the bottom of the list. (Click in the scroll bar at
the right of the window, or press the Page Down key.)
Notice that the report includes total debits and total
credits for the transaction entries in the report.

6. When you have finished looking at the Payment
Transactions report, close the report window. (Click once in
the top left corner of the window, or press the Alt key, then
the Spacebar. Choose Close from the menu that appears.)

Lesson 2: Enter a Purchase Invoice
Lesson objectives ■ Move from field to field in a transaction-entry window.

■ Use list boxes to select information when entering a
transaction.

■ Display a transaction entry to check it before processing.

■ Process (save) a transaction entry.
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Universal Construction has received an invoice from Harry’s
Lumber for the purchase of 10 squares of asphalt roofing tiles at
$45.00 per square. The invoice number is C123, and it is dated
March 11, 2000. You will record this invoice for future payment.

To enter the details of a purchase invoice:

1. From the Home window, open the Purchases, Orders, and
Quotes window.

 To open the Purchases, Orders, and Quotes window,
double-click the Purchases, Orders, and Quotes icon, or use
the arrow keys to highlight it, then press Enter.

Notice that the Purchases, Orders, and Quotes window
looks like an invoice, to make it easier to enter invoice
information.

 Other transaction-entry windows also look like the
documents they are used with. For example, the
Paycheques and Payments windows show a cheque. The
Receipts window shows a receipt.

Customizing windows You can customize all transaction-entry windows to suit
your data entry needs:

The Invoice Received box is
checked to indicate that you
are entering the invoice details
after receiving the vendor’s
invoice, rather than before.
The name of the Invoice field,
at the top right of the window,
changes to Reference when
the Invoice Received box is
not checked, so you can enter
invoice details with a
temporary reference number
for invoices you have not yet
received.

The payment terms displayed
in the Terms fields are from the
vendor record for Harry’s
Lumber.

The program calculates and displays the GST,
sales tax, and invoice totals.
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■ You can maximize the window to fill the whole screen,
which allows you to see more entries at the same time.

■ You can drag any corner of the window (unless it is
maximized) to increase or decrease the number of lines
displayed or change the width of columns.

■ You can change the width of columns by dragging the
right edge of the column heading.

■ You can move columns by dragging the column
headings to the right or left.

 Simply Accounting automatically saves changes to the
window.

 To return the window to its original size and column
positions, choose the Restore Window command from the
Edit menu.

 To move to a field in the window, click the field with the
mouse, or press the Tab key until you reach it. To move
backwards through the fields, hold down the Shift key, then
press Tab.

 (A field is an area on the screen in which you enter
information. It is usually a box beside or below the
description of the information to be entered.)

2.    Move to the Transaction field and display the list of
transaction types. (Click the arrow at the right of the
Transaction field, or, with the field highlighted, press F4,
or Alt and the Down Arrow key.) Any field with an arrow
to the right can display a list of choices from which you
can select.

 Select Invoice from the transaction list. (Click the name with
the mouse, or use the arrow keys to move the highlight to
Invoice, then press F4, or Alt and the Down Arrow key.)

 You will pay this invoice later, so select the option to Pay
Later from the Paid By field, unless it is already selected.

Enter a vendor name 3. Move to the Purchased From field, and select Harry’s
Lumber from the vendor list.
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 The program inserts the name and address of Harry’s
Lumber in the Purchased From field.

4. Press the Tab key twice to move past the Order/Quote No.
field; the insertion point moves to the Invoice field.

Note: You would select a purchase order number in the
Order/Quote No. field if you had already recorded a
purchase order for the invoice you were entering.

5. Enter the invoice number, C123, in the Invoice field. You
cannot process an invoice without a number.

6. Move to the Date field.

 This field automatically displays the session date, the date
you entered when you started Simply Accounting. You can
change the date if you wish.

 If you are using a mouse, highlight the date by holding
down the mouse button, then dragging the mouse pointer
over the date. If you pressed Tab to move to the field, the
date is already highlighted.

 With the date highlighted, type the invoice date, 03-11-2000,
over the session date.

 You can also use the Backspace or Delete key to erase the
session date, then type the invoice date.

Enter invoice details 7. Move to the Item field. Double-click or press Enter to
display a list of inventory items and services.
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 Use the scroll bar or the arrow keys to move through the list
to R1001, Roofing: Asphalt Tile. Double-click or press Enter
to put R1001 in the Item column.

 The program fills in the item, unit, description, price, sales
tax rate, and account number for this item, and the insertion
point moves to the Received (Rec’d) field.

8. Type 10 in the Received field.

9. Press Tab until you reach the Price field.

 The invoice from Harry’s Lumber shows that the asphalt
tile costs $45.00 per square. Type 45 over the price
displayed, then press Tab. Notice that the program inserts
the decimal point and zeroes, displaying 45.00, and the
Amount field contains 450.00, which equals the (unit) price
multiplied by the quantity.

 The insertion point is now in the GST Code (G) field.

10. Double-click the GST code field or press Enter to display a
list of GST codes. Notice that code 3 means GST is not
included in the item price.

You can enter a different GST code or GST amount by
typing over the ones displayed; select code 3 for this lesson.

The program calculates the GST amount by multiplying
7.00 percent times the contents of the Amount field, and
displays the result in the GST Amount (G.Amt.) field.

11. Press Tab until you reach the Provincial Sales Tax Rate (P)
field, which contains 7.00 percent.

 The program calculates the sales tax amount by multiplying
7.00 percent times the contents of the Amount field, and
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displays the result in the Provincial Sales Tax Amount
(P. Amt.) field.

 You can enter a different sales tax rate or sales tax amount,
but do not change it for this lesson.

12. Press Tab until the insertion point moves past the Account
and Allocation (Allo) fields, and onto the next line.

 The account number is displayed automatically. This is the
inventory asset account associated with the item you are
purchasing.

 The Allocation (Allo) field is left blank. For details on how
to allocate to projects, see Chapter 9, “Allocating Amounts
to Projects,” in the User Guide.

 The Purchases, Orders, and Quotes window now looks like
this:

 

The program calculates and
displays the GST, sales tax,
and invoice totals.

The payment terms
displayed in the Terms fields
are from the vendor record
for Harry’s Lumber.

Before you process (save) this invoice, you will check the
entry that the program will create from the information.

Check your entries 13. To check the entry, on the Report menu, choose Display
Purchase Transaction Detail. The program displays the
accounts it will debit and credit when you choose the
Process button. When you are finished looking at the
transaction entry, close the window. (Click once in the top
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left corner of the window, or press the Alt key, then the
Spacebar, then choose Close from the menu that appears.)

Process (Alt+P) 14. Click the Process button in the upper right corner of the
window, or press Alt+P (hold down the Alt key, then
press P).

 Processing will:

■ Assign J329 as the transaction number. This transaction
number will be printed with the entry in the Purchase
Transactions report, and you can use the number to
look up the entry after you have processed it.

■ Add the 10 squares of asphalt roofing tiles to the
quantity on hand for item R1001 in the Inventory
module, by debiting account 1580 (Roofing Materials)
and account 2490 (GST Paid On Purchases), and
crediting account 2200 (Accounts Payable).

■ Update the weighted average unit cost and the
valuation of the quantity on hand for the item
purchased.

15. Close the Purchases, Orders, and Quotes window and
return to the Home window. (Click once in the top left
corner of the window, or press the Alt key, then the
Spacebar, then choose Close from the menu that appears.)

 You have now recorded the purchase of the roofing tile.
When the invoice is due for payment, the Universal
Construction accounting clerk will enter and process the
payment, and print the cheque. For information about
processing payments and cheques, refer to “Accounting for
Payments” in Chapter 5 in the User Guide.

 For more information about entering vendor invoices, see
“Accounting for Purchases” in Chapter 5 in the User Guide,
after you finish this lesson.

Lesson 3: Look Up Invoices
Lesson objective This lesson teaches you how to look up a sales invoice.
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Select Invoice
Lookup in the
Settings dialog box

Note that invoice lookup is an option which might not be
selected for your own company’s accounting data. Before you
can store and look up the details of invoices, you must select the
Store Invoice Lookup Details option, on the System tab in the
Settings dialog box.

A clerk in the West Coast Development purchasing department
has just phoned about an invoice Universal Construction sent to
their offices, but which they have misplaced.

Although the clerk has not seen the invoice, he wants to know
the final amount in order to prepare the cheque.

To look up invoice details:

1. From the Home window, open the Sales, Orders, and
Quotes window.

 To open the Sales, Orders, and Quotes window,
double-click the Sales, Orders, and Quotes icon, or use the
arrow keys to highlight it, then press Enter.

 
As with the Purchases, Orders, and Quotes window, the
Sales, Orders, and Quotes window looks like an invoice.

Look up
invoice

2. Click the Look Up Invoice button on the toolbar, or press
Ctrl+L to display the Invoice Lookup dialog box.
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3.    In the Customer Name field, click the down arrow to the
right of the box to display a list of customers.

 

4.    Click the scroll bar, or press the Page Down key until you
can select West Coast Development from the list.

 If you know the invoice number, you can enter it directly
without selecting the customer name.

5.    Choose the Browse button to display the West Coast
Development invoices.

 

6.    Select invoice 17637 from the list. Click the selection with
the mouse, or use the arrow keys to highlight it, then choose
Select.

 Note that this invoice has already been processed, so you
cannot change any of the displayed information.

Allocate 7.    Highlight the invoice detail line and click the Allocate
button, or double-click the Allocate (Allo) field on the detail
line.
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 Although you cannot change this information, you can
check that the invoice was allocated properly.

8. Click OK to close the Project Allocation window.

9. If your printer is set up, choose the Print button to reprint
the invoice.

10. When you are finished, close the Sales, Orders, and Quotes
window and return to the Home window. (Click once in the
top left corner of the window, or press the Alt key, then the
Spacebar, then choose Close from the menu that appears.)

For more information about looking up invoices, see
Chapter 10, “Looking Up Invoices, Orders, and Quotes,” in the
User Guide, after you finish this lesson.

Lesson 4: Store and Recall Recurring Transactions
Lesson objectives ■ Store a transaction as a recurring entry.

■ Recall a stored transaction and process it.

Simply Accounting lets you store copies of transactions and
recall them for future use. You can store and recall entries for
any of the following transaction-entry windows:



Lesson 4: Store and Recall Recurring Transactions

4–20    Simply Accounting

SwC7gs04.doc, printed on 03/08/99, at 10:26 AM. Last saved on 02/25/99 11:20 AM.

ACCPAC INTERNATIONAL, INC. Confidential

■ Miscellaneous Transactions.

■ Purchases, Orders, and Quotes.

■ Sales, Orders, and Quotes.

■ Paycheques.

■ Item Assembly.

■ Adjustments.

Universal Construction has just signed a 12-month lease for new
office equipment. You will create an entry in the Miscellaneous
Transactions window to record the first month’s payment, and
you will store this entry so you can use it on the 15th of each
month.

Store a Recurring Transaction

To store a recurring transaction:

1. From the Home window, open the Miscellaneous
Transactions window.

 To open the Miscellaneous Transactions window,
double-click the Miscellaneous Transactions icon, or use the
arrow keys to highlight it, then press Enter.
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2. Press the Tab key to move to the Date field, then press the
Delete key to erase the displayed date.

3. Press the Tab key again to move to the Comment field.

 Although you cannot process a Miscellaneous Transactions
entry without a source code and a date, you can store an
entry with blank fields, then fill them in later when you
recall the entry.

4. Type Office Equipment Lease Payment.

5. Press Tab to move to the Account field.

6. Enter 5150 as the account number for the leasing expense,
and press the Tab key to move to the Debits field.

7. Enter 250 as the debit amount, and press Tab.

8. Enter 1080 as the account number for the chequing account,
and press the Tab key to move to the Credits field.

9. Press Tab to accept the credit amount displayed.

Store 10. Click the Store button or press Ctrl+T to save the recurring
transaction.

 

11. Click OK or press Enter to accept the recurring transaction
name and the frequency (monthly).

12. When you are finished, close the Miscellaneous
Transactions window and return to the Home window.
(Click once in the top left corner of the window, or press the
Alt key then the Spacebar, then choose Close from the menu
that appears.) If the program asks whether you want to
discard the transaction, choose Yes.

Next you will see how to recall and use a transaction you have
stored.
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Recall a Recurring Transaction

To recall a recurring transaction:

1. Open the Miscellaneous Transactions window.

Recall 2. Click the Recall button (or press Ctrl+R) to display a list of
all stored transactions.

 

 The transaction you added under “Store a Recurring
Transaction,” earlier in this lesson, has no Date Last
Processed, so the program assumes that the transaction is
due today.

3. Double-click the Office Equipment Lease Payment entry, or
click the Select button.

■ Enter the cheque number Chq #155 in the Source field.

 The date is filled in automatically (because you left the date
blank in the stored transaction).

Process (Alt+P) 4. Click the Process button or press Alt+P to process the
transaction.

5. Click the Recall button or press Ctrl+R to look at the
recurring transaction you just processed.
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 As you can see, the Office Equipment Lease Payment is due
next on April 15.

6. When you are finished, click the Cancel button (or press
Esc) to leave the Recall Recurring Transaction dialog box.

7. Close the Miscellaneous Transactions window and return to
the Home window. (Click once in the top left corner of the
window, or press the Alt key, then the Spacebar, then
choose Close from the menu that appears.)

For more information about creating recurring transactions, see
Chapter 12, “Using Recurring Transactions to Save Time,” in
the User Guide, after you finish this lesson.

Lesson 5: Change an Employee Record
Lesson objectives ■ Find a specific employee record.

■ Enter new information in an employee record field.

■ Save the changes you make to an employee record.

Changes to all records — accounts, vendors, customers,
employees, inventory items and services, and projects — are
made in the same way. For more information on changing
records, see Chapter 2, “Maintaining Records,” in the User
Guide, after you finish this lesson.

Universal Construction’s personnel manager tells you that
employee Gary Pearson has moved and changed his telephone
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number. The personnel manager asks you to enter the new
address and telephone number in Pearson’s employee record.

The old address and telephone number are:

Pearson, Gary P.
2601 Benson Drive
Vancouver
British Columbia
V4K 8S3
555-8951

The new address and telephone number are:

 Pearson, Gary P.
 2712 Sunset Drive
 Vancouver
 British Columbia
 V5T 1P2
 555-1009

To enter changes in the employee record:

1. In the Home window, on the Edit menu, select Find, then
choose Employee. A dialog box with a list of the company’s
employees appears.

2. Choose Pearson’s name from the list. Double-click his name,
or use the arrow keys to highlight it, then press Enter. (You
can move quickly through a long list by typing the first
letter of the name you want. To find Pearson, type P.)

 The Employee Records window opens with Pearson’s
record displayed.
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3. Move to the Street field, by clicking it with the mouse, or
pressing the Tab key until you reach it.

 If you pressed the Tab key to move to the Street field, it is
highlighted. Or, you can hold down the mouse button and
drag the mouse pointer through the field to highlight it.

 With the field highlighted, type 2712 Sunset Drive over the
previous address.

4. Move to the Postal Code field.

 If you are using a mouse, highlight the Postal code by
holding down the mouse button and dragging the mouse
pointer over the Postal code. If you pressed Tab to move to
the field, the code is already highlighted. You can also use
the Backspace or Delete key to erase the previous code, then
type the new Postal code.

 Type the new Postal code, v5t 1p2, over the previous Postal
code.

 If you enter a nine-digit zip code or a Canadian postal code,
the program formats the code when you move to another
field.

 Move to the Phone field, then type the new telephone
number, 604 555 1009, over the previous telephone number.
Press Tab to move to the next field.
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 The Phone field accepts numbers only. The program
automatically formats area codes and phone numbers with
parentheses and a hyphen when you move to another field.

 You have now made all required changes to Pearson’s
employment record.

 The window should look like this:

 

 To save information or changes you entered, you can:

■ Move to another employee record.

■ Create a new employee record.

■ Close the Employee Records window.

 If you decide not to save changes you made, you can:

■ Choose Undo Changes from the Edit menu.

■ Choose Cancel, if that choice is available.

 You cannot undo changes after you move to another record
or process a transaction. If you discover an error in a “real”
processed entry, refer to the sections in Chapter 2,
“Maintaining Records,” and Chapter 11, “Correcting
Entries,” in the User Guide, that discuss changing records,
and adjusting and reversing transactions.
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5. To record the changes to Pearson’s employee record, close
the window. (Click once in the top left corner of the
window, or press the Alt key, then the Spacebar, then
choose Close from the menu that appears.)

To verify the changes you made to Gary Pearson’s record, open
the Employee Records window as described in steps 1 and 2.

Lesson 6: Enter a New Employee Record
Lesson objectives ■ Open the Employee Records window to enter a new

employee record.

■ Enter employee information in different kinds of fields.

■ Use the Create command to add a new employee record.

Using icon windows When you choose an icon in the Home window to enter a new
record for accounts, vendors, customers, employees, inventory
items and services, or projects, the program displays the icon
window. The icon window displays an icon for each record. For
example, an account is shown with a picture of an account
book.

You use the icon window to find and use records quickly and
easily. For example, you can rearrange the icons so that your
most frequently used records appear at the top of the window,
regardless of alphabetical or numerical order, so that you do not
need to scroll through a list to find them. To remove a record,
you can use the mouse or arrow keys to select (highlight) a
record, then choose the Remove button from the toolbar.

Turning off the icon
window

If you prefer not to use an icon window, you can turn off this
feature. However, the instructions in these lessons assume that
the window will appear.

Because an employee record contains the largest variety of
information, you will practice creating an employee record in
the Payroll module.
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Universal’s personnel manager tells you a new employee,
Michael Grice, has just started working at Universal. The
manager wants you to add a new employee record for Grice,
and gives you a copy of his job application form and other
personnel records.

To enter a new employee record:

1. In the Home window, choose the Employees icon.
(Double-click the Employees button, or use the arrow keys
to highlight it, then press Enter.)

2. Choose the Create button on the toolbar, or choose Create
from the Edit menu.

 

 You will enter information for the new employee on the tabs
in this window, beside the field names.

 Look for the field that is highlighted in light-on-dark print
or that contains the flashing insertion point, to find out
where you are in the window. This is where you will enter
data next.

If you make a
mistake

 If you notice a mistake in a previously completed field,
you can click it with the mouse to return to the field, then
correct your error. You can also move backwards through
the fields by holding down the Shift key and pressing the
Tab key until you reach the field.
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 You can see that the Employee field is now highlighted,
prompting you to enter the name of the new employee.

Add personal
information

3. Type Grice, Michael in the Employee field.

 If you make a typing mistake, remove incorrect characters
by pressing the Backspace or Delete key, then type the
correct information.

4. Move the insertion point to the Street field on the Personal
tab. (Click the Street field with the mouse, or press the Tab
key.)

 Type 4324 Argo Place, then move to the City field.

Default entries The City field displays the default entry, Vancouver.

 The Province field displays the default entry, British
Columbia.

 Default entries are displayed automatically by the program
to help make data entry easier and faster. If there is a
default for a field, it is displayed when you open the
window or select the tab.

 Defaults are based on previously entered information. For
example, the city and province entered in the Company
Information dialog box appear as defaults in the City and
Province fields of new employee, vendor, and customer
records.

 The procedure for changing program defaults is explained
in Chapter 5, “Choosing Options and Setting Up Accounts.”

5. Accept the default city and province by moving to the
Postal Code field.

6. Type v5b 1e6 in the Postal Code field.

 If the program recognizes your entry in this field as either a
Canadian postal code or an American extended zip code, it
formats the code when you move to another field. Other
codes remain as typed.

7. Move to the Phone field.

 Type 604 555 1580.
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 The Phone field accepts numbers only. The program
automatically formats the phone number with parentheses
and a hyphen when you move to another field.

8. Move to the Social Insurance Number (SIN) field.

 Type 451 605 679

 The SIN field accepts numbers only. The program
automatically inserts the spaces in the social insurance
number (if you left them out) when you move to another
field.

9. Move to the Birth Date field.

 Michael Grice was born on March 18, 1949. Enter this date
in the Birth Date field by typing 3 18 1949, with a space
between the month, day, and year.

 You can also enter this date as 3-18-49, or 03/18/49.

 When you move the insertion point to another field, the
program automatically formats the date.

10. Move to the Hire Date field.

 Michael Grice was hired on March 15, 2000. Enter this date
in the Hire Date field by typing 03 15 00, with a space
between the day, month, and year.

11. Choose the Taxes tab by clicking it, or by pressing Tab until
the Personal tab is selected and then pressing the Right
Arrow key.

 

12. Move to the Tax Table field.

 Click the arrow at the right of the Tax Table field, or press
Alt and the Down Arrow key, to display a list of provinces.
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 Use the mouse or the arrow keys to move through the list of
provinces. Select British Columbia. (Click to select a
province, or highlight it, then press Alt and the Down
Arrow key.)

13. Move to the Federal Claim field. This field accepts only
dollar amounts.

 Type 6456. This is the net claim amount shown on Michael
Grice’s TD1 form. (Enter the dollar amount, not the net
claim code number.)

 You can type 6456 or 6456. or 6456.00 to enter $6456.00.

 The program skips over the Quebec Claim field, because
Quebec is not selected in the Tax Table field. All other
provinces base their provincial taxes on the federal claim.

14. Move to the WCB Rate field. Enter a percentage of 2.5.

 This is the Workers’ Compensation Board assessment
percentage for Michael Grice. The percentage depends on
the employee’s occupation.

 Next, notice that two fields affect employment insurance:
the Deduct EI box and the Rate field.

15. Move to the Deduct EI box. Click, or use the Spacebar, to
check the Deduct EI box, if it is not already checked.

 This indicates that employment insurance premiums will be
deducted from Michael Grice’s paycheque.

 Click or press the Tab key to move to the Rate field next to
the Deduct EI box.

 The Rate field displays the default entry, currently 1.4,
which comes from the Setup, Settings, Payroll tab.

 This is the employer’s EI premium rate. (That is, the
employer’s EI premium is calculated by multiplying the
employee’s EI premium by 1.4.)

 Accept the displayed EI rate.

16. Choose the Income tab by clicking it, or by pressing Tab
until the Income tab is selected and then pressing the Right
Arrow key.
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17. Press Tab until the Regular Per Hour field is selected. This
field accepts only dollar amounts.

 Type 12.

 To enter $12.00, you can type: 12 or 12. or 12.00.

 You can enter up to four digits to the right of the decimal
point in this field. For example, you can enter 12.6725.

 Tab over to the Hours Per Period field and enter the total
hours normally worked per pay period, 80.

18. Move to the Overtime Per Hour 1 field. Type 18.

 The Overtime Per Hour 1 field accepts only dollar amounts,
with up to four decimal places.

 Leave the Salary Per Period and Benefits Per Period fields
blank, since Michael Grice is paid by the hour.

Add pay information 19. Move to the Pay Periods Per Year field.

You must enter a number in the Pay Periods Per Year field.
If you leave it blank, the program displays an error message
when you try to close the Employee Records window or
move to another record.

The Pay Periods Per Year field accepts only the numbers
shown in the list box for this field.

 To display the list box, click the arrow to the right of the
field, or press F4, or the Alt and Down Arrow keys.

 Select 24, because Michael Grice will be paid twice a month.
Click once with the mouse to select the number. Or, use the
arrow keys to highlight the number, then press Alt and the
Down Arrow key to select it.
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20. Move to the Retain Vacation box.

 Click, or use the Spacebar, to check the Retain Vacation box,
if it is not already checked. This indicates that the company
retains Grice’s vacation pay to be paid out later, rather than
paying it on each paycheque.

 Move to the percentage field next to the Retain Vacation
box.

 Enter 4.0, to show that Grice receives vacation pay equal to
four percent of his earnings.

 (The program calculates vacation pay when paycheques are
produced, adding the amount to Vacation Pay Owed for the
employee in the Payroll module. If you enter a percentage
of zero, no vacation pay is calculated.)

21. Choose the Deductions tab by clicking it, or by pressing Tab
until the Income tab is selected and then pressing the Right
Arrow key.

 

Employee
deductions

This is where you enter the various personal deductions
for an employee.

 Since there are no further deductions for Michael Grice, go
to the next step. (For more information about deduction
fields, refer to “Adding Employees,” in Chapter 2,
“Maintaining Records,” in the User Guide.)

22. Choose the YTD Income tab by clicking it, or by pressing
Tab until the Deductions tab is selected and then pressing
the Right Arrow key.
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EI insurable earnings If an employee already has EI insurable earnings this year,
you enter those earnings in the EI Insurable Earnings field.

Since there are no EI insurable earnings for Michael Grice
this year, go to the next step.

23. Choose the Memo tab by clicking it.

24. Press Tab until the insertion point is in the Memo field. This
field accepts a memo up to 255 characters, including spaces.

 Type Michael Grice’s birthday is in 3 days.

Tip:  The To-Do List displays only the memo’s first
40 characters until you select the memo to view it all, so
you might find it useful to summarize longer memos in
the first 40 characters.

25. Move to the To-Do Date field and type 3 18 2000.

 This is the date the memo will first appear in the To-Do
Lists window (Grice’s birthday is on March 18).

26. Move to the Display This Memo In The To-Do List box.
Click, or use the Spacebar, to check the box if it is not
already checked.
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27. Choose the Create button at the bottom of the window.
Click it with the mouse, or Tab to it and press Enter. The
new employee record is added to the Payroll module.

28. Close the Employee Records window. (Click once in the top
left corner of the window, or press the Alt key then the
Spacebar, then choose Close from the menu that appears.)

Lesson 7: Remove a Vendor Record
Lesson objective In this lesson, you will learn to remove a vendor record from

the Vendors and Purchases module.

Removing records from other Simply Accounting modules —
General; Customers and Sales; Payroll; Employees; Inventory
and Services; and Project — requires similar steps to those for
removing a record from the Vendors and Purchases module.

Before you delete a vendor record, clear paid invoices for the
vendor, make sure the record has a zero balance, and process
outstanding purchase orders and purchase quotes.

The sales manager tells you to remove the vendor record for
Lexington Masonry Inc. from the Vendors and Purchases
module. The company has closed down, so you will no longer
be doing business with them.

To delete a vendor record:

1. In the Home window, on the Edit menu, select Find, then
choose Vendor. A dialog box with a list of the company’s
customers appears.

2. Select Lexington Masonry Inc. from the list. Double-click
the vendor’s name, or use the arrow keys to highlight it,
then press Enter. (You can move quickly through a long list
by typing the first letter of the name you want. To find
Lexington Masonry Inc., type L.)

 The Vendor records window opens with Lexington
Masonry Inc. record displayed.
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3. Choose the Activity tab by clicking it, or by pressing Tab
until the Address tab is selected and then pressing the Right
Arrow key until the Activity tab is selected.

 As you can see on the Activity tab, Lexington Masonry Inc.
has a balance owing of zero.

4. Choose the Remove button on the toolbar, or choose
Remove on the Edit menu. When the program asks whether
you are sure that you want to remove the record, choose
Yes. If it asks whether you wish to clear lookup data for this
customer, choose No.

5. Close the Vendor records window. (Click once in the top
left corner of the window, or press the Alt key then the
Spacebar, then choose Close from the menu that appears.)

When You Are Finished
To end your work session, in the Home window, on the File
menu, choose Exit. The Simply Accounting program closes.
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Where To Now?
If you want additional practice, refer to the Simply Accounting
Workbook. The Workbook shows you step by step how to create a
set of data files and use the program for day-to-day operations.
When you complete the lessons, you are ready to start using
your own company’s data with the program.

Refer to Chapters 5 and 6 in this manual to find out how to set
up the program to work with your own data, and for
information on setting up a chart of accounts for your company
and preparing for day-to-day operation.

If your own company’s data is already set up, refer to the User
Guide, for information on entering day-to-day transactions.
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Chapter 5
Choosing Options and Setting Up
Accounts

This chapter explains how to choose options and set up
accounts to suit your company. It shows you how to:

■ Create a company to store your accounting records.

■ Record information such as interest rates, cheque
numbering, and screen-display options.

■ Set up a chart of accounts.

■ Set up, change, and remove linked accounts, the accounts
that let Simply Accounting automatically update
information in related modules when you process a
transaction.

It also explains the dates that are important to the program.

If you have not yet installed Simply Accounting, refer to
Chapter 3, “Installing and Starting Simply Accounting,” to find
out what to do before setting up company files and entering
options.

If you are unfamiliar with accounting methods, read the
Accounting Manual to learn the basic accounting concepts you
should know before using Simply Accounting.

Dates
This section discusses date formats, defines the dates that are
important in Simply Accounting, and explains restrictions on
dates you can enter. Be sure you are familiar with these dates
before you create your company.
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Date Formats

Date fields in Simply Accounting accept dates in most standard
formats. For example, you can enter October 14, 2005 as
Oct 14 ’05, or 05 10 14, or 10-14-05, or 101405, or 14 10 05, or
10/14/05.

Simply Accounting uses the short-date format you select in
Microsoft Windows.

To change the date format:

1. On the Windows Start menu, choose Settings, Control
Panel, then Regional Settings. On the Date tab, select or type
the options you want in the Short Date fields.

For more information on date formats, consult your Windows
manual or Windows online help.

Date Definitions

The following dates are important in Simply Accounting. You
should know what they mean before you use the program.

Fiscal Start Date.  The first day of your accounting year.

Fiscal End Date.  The last day of your accounting year.

Earliest Transaction Date.  The earliest date on which you can
process transactions for the fiscal year. You cannot process a
transaction with a date that is earlier than the earliest
transaction date, unless you have set up Simply Accounting to
accept transactions in previous years. (Choose Settings from the
Setup menu, then choose Allow Transactions In Previous Year.)
For more information, see “Transaction Date,” later in this
chapter.

The earliest transaction date can be the Fiscal Start date, the
Fiscal End date, or any date in between.
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When you begin using Simply Accounting for the first time (if
you are not converting from an earlier version or from Simply
Accounting for DOS), the earliest transaction date is the date
you choose for the conversion from your former accounting
system to Simply Accounting.

You enter an earliest transaction date when you first set up the
program. This is the date for which you have a complete,
balanced set of company records. You can change the earliest
transaction date until you are finished entering historical
transactions. For instructions on how to finish entering history,
refer to Chapter 6, “Entering Account History.”

Last year’s
records

If you keep two years of records, the program stores two
earliest transaction dates, one in the previous fiscal year and
one in the current fiscal year.

Changes to the
earliest transaction
date

After you finish entering history, you can see the earliest
transaction date in the Company Information dialog box on
the Setup menu, but you cannot change it. However, the
program automatically changes the earliest transaction date:

■ When you start a new fiscal year. The program changes the
earliest transaction date to the first date of the new fiscal
year.

 If you keep last year’s records, the program stores the latest
earliest transaction date from the previous fiscal year, and
creates a new earliest transaction date for the new fiscal
year.

■ When you use the Clear Transaction Details command on
the Maintenance menu to clear all transactions before a
specified date within a fiscal year. The program changes the
earliest transaction date to the date you enter in the Clear
Transaction Details dialog box.

Latest Transaction Date.  The latest date on which you can
process transactions for the fiscal year. You cannot process a
transaction with a date that is later than the latest transaction
date, unless you have set up Simply Accounting to accept
transactions in the future. (Choose Settings from the Setup
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menu, then choose Allow Transactions In The Future.) For more
information, see “Transaction Date,” later in this chapter

Session Date.  The date associated with the current work
session. The program displays the session date automatically in
all transactions, and will use it as the transaction date, unless
you change the date when you make the entry.

Change Session Date Each time you start Simply Accounting, you are prompted to
enter the session date. After starting, you can use the Change
Session Date command on the Maintenance menu to change the
session date to an earlier or later date if you wish, without
having to exit and restart the program.

The current session date is displayed in the Company
Information dialog box, for your information, but you cannot
change it there.

The session date is also:

■ The preset date for aged vendor and customer reports.

■ The date as of which information is summarized for some
reports, such as inventory stock levels, the Employee
Summary report.

■ The preset date the program prints on customer statements.
(Individual transactions are listed on statements with the
dates on which they were entered.)

Transaction Date.  The date associated with each processed
transaction. The transaction date is usually the same as the
session date; the program displays the session date
automatically in all transactions. However, you can enter an
earlier or later date if you wish.
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Processing
transactions to last
year or a future date

If you are processing a transaction to the previous fiscal year,
the date can be any date between last year’s earliest transaction
date and last year’s Fiscal End date. If you are processing a
transaction to a future date, the date can be any date up to the
current year’s Fiscal End date. You must check the Allow
Transactions In Previous Year or Allow Transactions In The
Future box on the System tab in the Settings dialog box before
you can process transactions for last year or a future date.

Paycheque
processing dates

You can also postdate and backdate payroll cheques. If the date
you enter on the cheque is in the current fiscal and current
calendar year, the program uses the transaction date.

If the date you enter is in the previous calendar year, the
program uses December 31 as the processing date. For example,
if your session date is in January and you want to enter a
paycheque for the last pay period in December, the program
uses December 31 as the processing date.

Dates for Account Reconciliation

The program handles dates for account reconciliation
differently, depending on whether you are setting up your
company accounts for the first time or doing a regular (usually
monthly) reconciliation.

When you set up an account for reconciliation, the program
processes an adjusting transaction for any unreconciled amount
as of the session date. However, when you use the Account
Reconciliation window to reconcile your bank or credit-card
statements each month, the program records adjustments for
unreconciled amounts as of the statement end date (which you
enter from your statement).

The program processes income and expense amounts that you
enter from your bank or credit-card statement as of the date you
enter in the Date field for the transaction, unless the date is
before the earliest transaction date or you are processing a
transaction to the previous year.
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If the date is before the earliest transaction date but in the
current fiscal year, the program records the transaction as of the
earliest transaction date.

Processing to last
year

If the date is between last year’s earliest transaction date and
last year’s Fiscal End date, the processing date is the date you
enter.

If the date is before last year’s start date, or it is between last
year’s start date and last year’s earliest transaction date, the
processing date is last year’s earliest transaction date.

To use the program for account reconciliation, work through
Chapter 7, “Setting Up an Account for Reconciliation.” Then,
whenever you receive a bank or credit-card statement, follow
the instructions in Chapter 14, “Reconciling Accounts,” in the
User Guide.

Preset Dates

In some cases, you can click the arrow at the right of a date
field, or press Alt+Down Arrow or F4, to display a selection of
dates for that field. You can select one of these, or type another.

The list of dates varies, depending on which dialog box you are
working in, and when. It could include the current year’s Fiscal
Start date, the earliest transaction date, the session date, the
current year’s Fiscal End date, and the first day in the next fiscal
year.

Date Restrictions

The program will not accept a date earlier than January 1, 1900,
or later than December 31, 2025.

Transaction dates you enter must equal, or range between, the
Fiscal Start date (or the earliest transaction date, if it is later than
the Fiscal Start date) and the session date.
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The session date must be between the earliest transaction date
and the end of the current fiscal year.

Reports Some reports include only transactions processed as of the
session date, including the Employee Summary and Detail
reports, Vendor Purchases, Customer Sales, and some
inventory reports.

The date range you select for printing most financial and
transaction reports must be between the earliest transaction
date and latest transaction date inclusive. (The exception is the
income statement, for which the starting date of the range can
also be the Fiscal Start date.)

Creating a Company
Before you can use Simply Accounting to keep track of your
accounting records, you must create a set of files to store your
company’s records. This is called “creating a company.” Simply
Accounting includes several “wizards” to help you create a new
company and quickly set up the accounts you will need, as
described in this section. (A wizard is a set of steps that steers
you smoothly through a complicated task).

After you create the files for your company, the instructions in
this chapter and in Chapter 6, “Entering Account History,” will
help you to choose options, set up accounts, and add historical
records.

Company templates To reduce the amount of work you must do to set up your
company’s accounts, Simply Accounting comes with a variety
of company templates. You can adapt one of them to suit your
own business (recommended), or start from scratch if you
prefer.

Company templates include linked accounts — the control
accounts to which transactions are processed automatically
from other windows — plus additional unlinked accounts,
including the group and section headings and totals. (These are
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described later in this chapter, in “Types of Accounts” and
“Linked Accounts.”)

To create a company:

1. If you selected the Typical setup when you installed Simply
Accounting, the company templates are saved on your hard
disk. If you selected a Custom setup and did not select the
company templates, install them now. Refer to “Installing
Simply Accounting,” in Chapter 3, for instructions. During
installation, be sure to include company templates when
you select the parts of the program you want to install.

2. Start Simply Accounting. (For instructions, see Chapter 3.)
When the Select Company window appears, select Create A
New Company.

To create a new company,
select this button.

3. The Setup wizard appears, to help you create a new file and
choose settings and options.

4. Select Copy A Template Containing Typical Accounts, then
click Next.

 If you select Create A New List Of Accounts From Scratch,
you will probably spend more time setting up accounts than
if you choose to copy the Generic Company template.

5. Work through the rest of the Setup wizard to choose the
settings and options you want.

Be sure to read each screen of the Setup wizard carefully so you
understand the choices you make.

 If you are not sure which options and settings best meet
your company’s needs, refer to the next section, “Choosing
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Options for Your Company.” That section also describes
additional settings that are not included in the Setup
wizard.

Tip:  If you change your mind, click the Back button to
review your choices, then change your selections.

6. When you reach the last screen, click Finish to create the
new files.

Always store your company files in the same folder or
directory. If you do not, the program may not work properly.

You are now ready to set up accounts for your company, as
described in “The Chart of Accounts,” later in this chapter.

Choosing Options for Your Company
Before you start to use Simply Accounting for day-to-day
operations, you must:

■ Enter background information about your company.

■ Change the names of certain fields.

■ Enter interest and tax rates, screen display options, invoice
and cheque formats, and other options for each module.

■ Set up printers to work with Simply Accounting.

Enter this information before you select the Finish Entering
History command to finish entering historical details. If you
want to change any historical entries later, you can do so at any
time until the end of your company’s first fiscal year.

To choose options with the Settings wizard:

1. On the Setup menu, select Wizards, then Settings.

2. Follow the instructions that appear on your screen.
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Tip:  If you are changing only one or two settings, you
may find it faster to use the Names, Reports And Forms,
and Settings commands on the Setup menu, rather than
the Setup wizard.

To choose options one at a time:

If you want to choose the options and settings one at a time,
read the rest of this chapter to find out what options are
available and decide how you want to use them.

Information about Your Company

Simply Accounting stores background information about your
company, such as your address, business registration number,
and the start and end dates of your fiscal year. It uses this
information to, for example, print your company name on
reports, and warn you if you are about to start a new fiscal year.

To enter company information:

1. In the Home window, choose Company Information from
the Setup menu.

 

Enter the company name. The
program prints it on reports and, if
you wish, on cheques,
statements, invoices, and
purchase orders. (For details, see
the “Forms” section, later in this
chapter.)

Last Year Dates
appear only if the
file has two years
of data.

For a definition of
these dates, see
“Dates,” earlier in
this chapter.

Enter your company’s
business number. The
program prints it on T4s,
invoices, and purchase orders.

2. Fill in the information. If you are unsure of what to enter,
press F1 for help.
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3. Check that you have entered the information correctly, then
choose OK to accept your entries.

If you are setting up your company for the first time, go to the
next section, “Customizing Names,” to continue preparing
Simply Accounting for use with your company.

Customizing Names

Simply Accounting lets you change the names of two taxes,
fifteen payroll fields, and one module, to provide names that
are more suited to the needs of your company.

To customize a name:

1. Choose Names from the Setup menu.

 
Income fields appear in the Payroll module. Use them to
record taxable income. For example, if your company
pays bonuses but not commissions, rename Income B
field to “Bonus.”

If you rename the Deduction
fields, remember to rename the
corresponding linked accounts.
See “Changing Records” in
Chapter 2 in the User Guide.

If needed, enter the name
of a provincial payroll tax
not collected through the
federal government.

If you want to use HST instead
of GST, rename this tax field,
then enter the tax rates (see
“Sales Taxes,” in the next
section). If you want to use
both, enter the one you will use
most, then enter the tax rates.

Enter the name of the profit centres
you wish to use for your company.
(for example, Branch, Division,
Department, Region, or Job Cost).

2. Enter the new name.

3. Check that you have entered the information correctly, then
choose OK to accept your entries.
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If you are setting up a company for the first time, go to the next
section, “Customizing Rates, Settings, and Formats,” to
continue preparing Simply Accounting for use with your
company.

Customizing Rates, Settings, and Formats

You can customize Simply Accounting by specifying your
choices for options such as interest charges, early-payment
discounts, tax rates, aging periods, and the format and contents
of invoices and reports.

To do this, choose Settings from the Setup menu. Then, for each
topic, select a tab in the dialog box, fill in the fields (as described
in this section), then choose OK to accept your entries. You can
change the information at any time.

Display Options

You can specify the font and type size you want to use when
you display reports on the screen, and whether you want the
program to display standard accounting terminology (such as
payables, ledger, and journal) or non-accounting terminology
that is familiar to the general user.

To set display options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Display tab.
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Choose whether you want to
use accounting or non-
accounting terms.

Choose the font and size you
want to see on the screen
when you display reports.

Check this box if you want
to be able to select a
company whenever you
start Simply Accounting.

System-Wide Options

You can choose to store extra inventory and invoice details,
choose the cash-basis method of accounting, choose the cheque
number as the reference number in the Account Reconciliation
window, allow processing to the previous fiscal year (if you
keep two years of data), and choose how often the program
should remind you to back up your company files.

To set System options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the System tab.   
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See Chapter 9, “Setting Up
Cash-Basis Accounting”, before
you check this box.

If you use account reconciliation,
check this box to use the cheque
number (instead of the invoice
number) as the source code in
the Account Reconciliation
window.

Check this box if you want to be
able to look up invoice details.
See “Looking Up Invoices” in
Chapter 10 of the User Guide.

Select these options if you want to allow transactions in the previous
year or beyond the session date (see “Dates,” earlier in this chapter).

Select how often you want the
program to remind you to back up.

Sales Taxes

You can set the tax rate for GST (goods and services tax) or HST
(harmonized sales tax), or both. You can also choose between
PST (provincial sales tax) or QST (Quebec sales tax), and enter
rates for one of those taxes.

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Sales Taxes tab.
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Enter the GST rate in the Rate 1
field. Or, if you are using a
regional or harmonized sales tax
instead, enter that rate. (To
rename GST, see “Customizing
Names,” earlier in this chapter.)

Check this box if you want
to use QST instead of PST.

Enter PST or QST rates and
information (QST fields
appear if you check the Use
Quebec Sales Tax box,
above).

If you use both GST and harmonized sales tax, enter GST in
the Rate 1 field, and harmonized sales tax in the Rate 2 field.

General Module

You can choose to budget your revenue and expense accounts.

To set General module options:  

1. On the Setup menu, choose Settings.

2. Choose the General tab, and fill in the fields.

Check this box to be able to set
up a budget for your revenue
and expense accounts, and
then select a budget period.

For more information, see
Chapter 3, “Budgeting,” in
the User Guide.

If you select Budget Revenue
And Expense Accounts,
indicate the time period for
which you want to budget,
here.
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Vendors and Purchases

You can choose the three time periods (called aging periods)
you use to classify overdue amounts you owe to vendors.

To set Vendors and Purchases options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Vendors And
Purchases tab.

In each of the three time
periods, enter the number of
days you use to classify
amounts you owe your vendors
(suppliers).

Leave this box unchecked to
include tax in the calculation of
early-payment discounts from
one-time vendors.

Customers and Sales

You can choose the three time periods (called aging periods)
you use to classify overdue customer accounts, set the interest
rate on overdue invoices, choose how long paid invoices will
appear on statements, and set the payment terms you will offer
all or most of your customers.

To set Customers and Sales options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Customers And Sales
tab.
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Type the number of days in
each of the three time
periods you use to classify
overdue customer accounts.

You can include paid
invoices on customer
statements.

Enter the payment terms you
give most customers. (You can
change the setting on individual
customer records.)

Check the Interest Charges box if you want to print interest
charges on overdue customer invoices and statements. Enter
the rate and payment term (for example, 2 percent on invoices
more than 30 days old).

Note that the program does not automatically make accounting
transactions for interest charges. To record a receipt for an
interest payment, you must process a sales invoice for the
interest first, then apply the payment against the original
invoice and the interest invoice. For instructions on entering
invoices and receipts, see “Accounting for Sales” and
“Accounting for Receipts,” in Chapter 6 in the User Guide.

Payroll

To set Payroll options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Payroll tab.
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Enter the rate for your
company’s Ontario
Employer Health Tax or
Newfoundland Health and
Post-Secondary Education
Tax contributions.

Type the factor that applies to
your company’s EI premiums.

You can keep employee details for one
year or two years. To see this
information, display the Employee
Detail report.

Check a box to identify which
income is taxable.

Check a box to deduct a
dollar amount or percentage.

If you have employees in
Quebec who earn tips, check
this box.

Inventory and Services

You can enter your profit evaluation method, choose the order
in which Simply Accounting sorts your inventory list, and
decide whether you want to be able to process and print sales
invoices for goods that you don’t yet have in stock.

To set Inventory and Services options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Inventory And
Services tab.
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Choose the order in which
items appear in the Inventory
And Services List, and in lists
displayed when you enter
transactions.

If you check this box, you
can enter sales invoices for
goods you have not yet
received.

Profit evaluation
method

■ In the Profit Evaluation Method section, select Markup if
you want the profit on inventory items to be calculated
based on the cost price. Or, select Margin if you want the
profit on inventory items to be based on the selling price.

 The program uses the weighted-moving-average method to
calculate cost, then calculates your profit (the difference
between the average cost and the selling price of items).

 The markup or margin is listed on the Inventory Synopsis
and Inventory And Services Sales reports. Here is how the
program calculates markup and margin percentages:

Markup = Selling price – cost
Cost

×  100

Margin = Selling price – cost
Selling price

×  100

■ Select the Allow Inventory Levels To Go Below Zero option
if you may need to record a sale before purchasing your
inventory. (In some cases, this may cause your inventory
levels to drop below zero, creating “negative” inventory.)
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Projects (Cost Allocation and Budgeting)

You can allocate (distribute) some or all of a transaction’s total
revenues or expenses to one or more projects, from the
following windows:

■ Miscellaneous Transactions.

■ Purchases, Orders, and Quotes.

■ Sales, Orders, and Quotes.

■ Paycheques.

■ Adjustments.

For example, you could allocate the cost of lumber to a
particular building project. Or, if an employee works for four
days on project A and one day on project B, you can allocate
80 percent of the payroll expenses to project A and 20 percent to
project B.

For more information about allocating amounts to projects, refer
to Chapter 9, “Allocating Amounts to Projects,” in the User
Guide.

Budgeting

You can also set up a budget to plan the revenues and expenses
for each project. Turn on the option as described in the next
section, then refer to Chapter 3, “Budgeting,” in the User Guide,
for more information.

To set project options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Project tab.
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You can allocate expenses and
revenues to your projects, as
amounts or percentages.

Turn on the budgeting option to
be able to set up budgets for
revenues and expenses.

In the Paycheques window, you
can allocate a salary expense
by amount or percentage; or for
employees paid by the hour, by
hours.

If you normally allocate the full
amount of revenues or
expenses to projects, check this
box to have the program warn
you if you are about to process
an entry with less than the full
amount allocated.

Forms

You can enter settings for the numbering and printing of your
cheques, invoices, and other forms.

To enter settings for forms:

1. In the Settings dialog box, choose the Forms tab.

 

If your payroll and payables
cheques use the same
account, only one cheque
field appears.

Check these boxes to have
the program warn you if you
are about to process a form
before it is printed.

Leave these boxes
unchecked if your preprinted
forms already include your
company name and address.
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Adding Comments to Printed Forms

You can customize printed sales quotes, orders, and invoices by
including comments to suit your own business. For example,
you could mention an upcoming sale, or a new product, on all
your invoices.

To add comments to printed forms:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the Comments tab.

To include remarks on
printed sales, quotes, orders
and invoices, type your
messages in the boxes on
the Comment tab.

E-mail Options

If you have a compatible e-mail program, you can send
purchase orders and invoice confirmations by e-mail to your
vendors, and sales quotes, order confirmations, invoices,
receipts, and statements to your customers.
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E-mail program
requirements

Two popular e-mail programs that you can use are Lotus
Domino and Microsoft Mail. If you want to use the e-mail
feature with a different e-mail program, check the
documentation for that program. If it says the program
supports MAPI, then you will be able to e-mail your vendors
and customers from Simply Accounting. (MAPI is a protocol, or
a set of rules, that e-mail programs can use to allow interaction
with other programs. For your e-mail program to work with
Simply Accounting, it must support MAPI.)

E-mail address Before you can e-mail a vendor or customer, you must know
their e-mail address. You can either include the address in the
vendor or customer record, or add it “on the fly” when you
send the e-mail.

In a vendor or customer account record, you can also set the
option to always print or e-mail purchase orders, and e-mail
confirmation of invoices and quotes to the vendor. (See Chapter
2, “Maintaining Records.”)

Customizing e-mail
forms

When you e-mail a form, you can use one of the forms that
come with Simply Accounting, or you can customize your own.
For information about customizing forms, refer to Chapter 21 of
the User Guide.

When your customer or vendor receives your e-mail, they may
not be able to see the complete form. However, they should be
able to print it from their word processor, as long as they print
the form using a word processor that is able to read “.RTF”
(rich text format) files, and uses headers and footers.

To set e-mail options:

1. On the Setup menu, choose Settings.

2. In the Settings dialog box, choose the E-mail tab.
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Select the forms you want
to e-mail, here.

For each form, type a
comment you wish to include
with the e-mail, here. You
may use up to 1,000
characters, or about 200
words.

Printer Settings

You can set up Simply Accounting to print reports, cheques,
invoices, labels, and other forms, using up to eight different
printers, if you have installed the printers in Windows first.

(Simply Accounting shares printer information with Microsoft
Windows, so you must install and set up at least one printer
with Windows before you can print from Simply Accounting.)

Before you print, use the information in this section to tell
Simply Accounting which printer you wish to use for each type
of report or form. Then try to print. If you have any problems,
read Chapter 8, “Setting Up Printers,” for more information on
using your printer with Simply Accounting.

To set printer options:

1. From the Setup menu, choose Reports And Forms
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Select the size of
form you wish to
use. If you choose
Custom, see
Chapter 21 in the
User Guide to find
out how to
customize forms.

Select Reports And Graphs
for reports, graphs, and
management reports
(displayed with the Advice
button, described in
Chapter 21 in the User
Guide.)

Select one of the
printers you
installed and set
up with Microsoft
Windows.

For information about e-mail,
see the “E-mail Options”
section earlier in this chapter.
To read about customizing e-
mail forms, refer to Chapter 21
of the User Guide.

Use these fields if your reports do not align properly
on the page. Positive amounts in the Top Margin field
lower the report, negative amounts raise it. Positive
amounts in the Left Margin field move the report to the
right, negative amounts move it to the left.

1.  Select the tab for the type of form you want to print, then fill
in the fields. If you are unsure of what to enter, choose the
Help button.

Printing labels If you select Labels, note the following:

■ If you enter a height that does not divide evenly into
the page length, the last row of labels on the page, and
labels on subsequent pages, may not print properly.

■ Labels must be at least one inch wide.

■ On the Reports And Graphs tab, check Print The
System Date On Reports to include the date printed, or
uncheck it if you do not want the print date to appear
on your reports.

■ To show subtotals on invoices, check Show Subtotal In
Invoice on the Reports And Graphs tab.

Check the setup
information

2.  On each tab, you may wish to check the setup information
for the printer you have selected:

a) Choose the Setup button to display the Windows
printer properties box for the printer you selected in
step 2. (This dialog box may look different, depending
on your version of Windows).
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b) Check that the information on this screen is correct.
(This is the printer information you entered when you
installed and set up this printer with Windows.)

 If you need to change any information, fill in the fields
you require, then choose OK to accept your entries and
return to the Reports And Forms dialog box in Simply
Accounting. If you need more information, consult your
Windows manual or Windows online help.

Enter settings for
other types of forms

3.  Repeat steps 2 and 3 for all the other types of forms you
want to print with Simply Accounting.

 If you do not enter settings for payroll cheques, payment
cheques, invoices, labels, purchase orders, statements, and
T4 and Relevé 1 slips, the program assumes you are using
the active printer you selected in Windows.

5. Choose OK to accept your entries.

Print samples 6.  Try printing a sample of each type of printout (a report, an
invoice, and so on). If any of them do not print properly,
you may need to install a different printer driver. Refer to
Chapter 8, “Setting Up Printers,” for instructions.

Reset form numbers 7.  After you print your samples, you may wish to reset the
counter for your cheque and invoice numbers. On the
Setup menu, choose Settings, then select the Forms tab and
enter the desired numbers in the Next Number On fields.

Credit Cards

You can accept credit-card payments from your customers, or
use your credit card for purchases you make from your
vendors. When accepting payments, Simply Accounting
automatically calculates any fee you owe the credit-card
company, and keeps track of it in a separate account. Later, you
can use the Account Reconciliation feature to verify the credit-
card merchant statements against your account records.

To set up credit card information:

Setting up credit
cards

1.  From the Setup menu, select Credit Cards.
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Enter the names of the credit
cards you accept from your
customers.

Enter the account to which the
fee should be charged. You
can create this account “on the
fly” by selecting <Add New
Account> from the account list.

Enter the account where you
want to record the amount the
credit card company will pay
you. You can create this
account “on the fly.”

Enter the percentage the card
company charges on each
transaction.

Enter the names of the credit cards you use for company purchases,
the account should be used to pay for purchases, and the accounts
to which fees should be charged.

Tip: You will find it much easier, later, to reconcile your
Bank and Credit Card accounts if you set up a separate
asset account for each credit card you recognize.

Shippers

Track shipments If you have access to the Internet, you can track shipments on
your shippers’ Web sites. This feature can be particularly useful
if you (or a customer) are worried about a missing or late
shipment.

Invoice lookup Now, you can track shipments whenever you look up an
invoice. (From the Purchases or Sales window, look up the
invoice, and then click the Track Shipments button on the
toolbar to locate your shipment.)

 To enter your shippers’ Web site addresses:

1. From the Setup menu, select Shippers.
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Check the Track
Shipments box.

Enter the names
and tracking (Web)
sites of your
shippers.

Changing and Hiding Parts of the Screen Display
You can change the look of Simply Accounting to suit your
needs and preferences.

Status Bar

The status bar displays helpful information at the bottom of
most screens. When you install Simply Accounting, the status
bar is automatically switched on. If you wish, you can turn it
off.

To turn the status bar on or off:

1. In the Home window, on the View menu, choose Status
Bars to turn the status bar on (9) or off.

Automatic Advice

Simply Accounting can provide business advice automatically
when you run the program. For example, if you are about to
make a sale to a customer whose credit is overextended, the
program will ask whether you are sure you want to sell more to
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this customer. This automatic advice is turned on when you
install the program.

To turn automatic advice on or off:

1. On the View menu, choose Automatic Advice to turn the
option on (9) or off.

To-Do Lists

To-Do Lists are reminders about buying, selling, and other
activities that are essential for your business. You can choose
whether you want the To-Do Lists to appear, and when.

1. On the View menu, choose To-Do Lists.

2. To display the lists when you start Simply Accounting,
choose At Startup. The option is turned on when a 9
appears next to it.

3. To see the lists whenever you change the session date,
choose After Changing Session Date.

Checklists

Checklists help you keep track of ongoing tasks. You can use
Simply Accounting’s built-in checklists, or create your own, and
choose when you want the checklists to appear.

1. On the View menu, choose Checklists.

2. To display the checklists when you start Simply
Accounting, choose At Startup. The option is turned on
when a 9 appears next to it.

3. To see the lists whenever you change the session date,
choose After Changing Session Date.
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Home Window Backgrounds

You can select different coloured and textured backgrounds for
many of the windows in Simply Accounting. These settings are
available only if your computer’s colour palette settings are set
to High Colour or greater.

1. On the View menu, choose Appearance.

2. Choose colours and patterns for screen backgrounds.

3. Choose Apply, then choose OK.

Account Numbers

You can choose whether you want account numbers to appear
in transaction detail displays and reports. For example, you
may want to print reports showing account names only.

To turn account-number display on or off:

1. On the View menu, choose Account Numbers.

2. Choose (9) either or both of:

■ In Transactions

■ In Reports

 If two or more accounts contain the same name, these
commands are dimmed, the account numbering being the
only way to distinguish the accounts.

Hiding Modules

If you do not use all the modules in Simply Accounting, you can
hide them. The program still records information that affects the
hidden module.

1. On the View menu, choose Modules, and uncheck the
modules you do not wish to display.
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Hiding Icon Windows

An icon window displays an array of icons representing
individual records in a module. The visual array helps you to
find records quickly. If you prefer to skip certain icon windows:

1. On the View menu, choose Icon Windows, and uncheck the
icon windows you do not wish to display.

The Chart of Accounts
A chart of accounts is an organized list of all the accounts you
use to keep track of assets, liabilities, revenues, expenses, and
equity in your business.

Before you set up your chart of accounts, you need to
understand the types of accounts Simply Accounting uses to
produce your balance sheets and income statements, and the
account numbering system it uses to ensure that the chart of
accounts is in logical order.

Types of Accounts

The program sets up financial statements as shown in
Figure 3.1. The left side of the illustration lists the terms used
for each section of the statement and for each type of account.
The terms are defined in the table that follows Figure 3.1.

Group and subgroup
accounts

These terms are used only for formatting your financial
statements — your balance sheets and income statements — as
shown on the first page of this balance sheet.

In the example, notice that some accounts are not directly
affected by transactions. Instead, they provide a convenient way
of grouping accounts that are directly affected when you process
a transaction. For example, the sum of all your bank accounts is
given by the subgroup total account, Cash: Net. The total for
any group of asset accounts is contained in a group total
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account, and the total for the entire section of the balance sheet
is collected in the section total account, Total Assets.

UNIVERSAL CONSTRUCTION

Balance Sheet  As At May 15, 1999

Section Heading ASSETS page 1

Group Heading CURRENT ASSETS

Subgroup Account * Regal Bank: Current 48,019.18

Subgroup Account * Oakville Dominion Bank: Payroll 26,996.81

Subgroup Total Cash: Net 75,015.99

Subgroup Account * Accounts Receivable 382,339.90

Subgroup Account * Advances Receivable 0.00

Subgroup Total Receivables: Net 382,339.90

Group Account * Prepaid Expenses 5,955.57

Group Total TOTAL CURRENT ASSETS 463,311.46

Group Heading INVENTORY ASSETS

Group Account * Drywall 4,341.99

Group Account * Lumber 6,918.68

Group Total TOTAL INVENTORY ASSETS 11,260.67

Group Heading CAPITAL ASSETS

Subgroup Account * Buildings 80,000.00

Subgroup Account * Accum. Amort.: Buildings –9,000.00

Subgroup Total Buildings: Net 71,000.00

Group Account * Land 195,000.00

Group Total TOTAL CAPITAL ASSETS 266,000.00

Section Total TOTAL ASSETS 740,572.13

* Accounts whose balances are affected directly when you enter a transaction.

Figure 3.1.  Part of a sample balance sheet, showing account types used
in Simply Accounting.
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The next table explains the types of accounts used to format and
position amounts on your financial statements.

Type of
Account

Function on the Financial
Statement

Relationship to Other Types of
Accounts

Section
Heading

Divides the financial statement into
sections (Assets, Liabilities, Equity,
Revenue, and Expense).

The program assigns the section
name; you cannot change it.
Accounts within a section are
further classified into groups.

Group
Heading

Classifies groups of accounts within
a section.

Introduces two or more group or
subgroup accounts.

Subgroup Stores amounts processed in the
transaction windows. Balances are
shown in the left column of the
financial statement.

Used for accounts whose balances
will be subtotalled, rather than
included directly in the group total.
Subgroup accounts must be
followed by a group total before the
next heading.

Group Stores amounts processed in the
transaction windows. Balances are
shown in the right (total) column of
the financial statement.

Used for amounts included directly
in the group total.

Subgroup
Total

Contains the subtotal of all the
consecutive subgroup accounts
above it. The program displays the
amount in the right column of the
financial statement.

Must follow a subgroup account.
The balance is included in the group
total.

Current
Earnings

Shows the difference between
revenue and expense account totals.
The program calculates the balance
every time you make an entry that
affects a revenue or expense account,
and displays it in the Equity section
of the balance sheet.

You cannot process transactions to
this account.

Group
Total

Gives the sum of all group and
subgroup totals above it, up to the
preceding group heading. The
program displays the amount in the
right column of the financial

You cannot process transactions to
this account.
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Type of
Account

Function on the Financial
Statement

Relationship to Other Types of
Accounts

statement.

Section
Total

Gives the sum of all accounts within
the same section of the financial
statement. (It includes all the group
totals.)

You cannot change the section
name; the program assigns it.

Account Balances

Accounts printed on financial statements can have any value,
positive or negative, up to $999,999,999.99 ($1 billion minus
1 cent).

Accounts can be shown with negative balances, showing that
the balance is the opposite of what you expect for an account in
that section. For example, a Bank account has a negative balance
if it is overdrawn. Accumulated Depreciation has a negative
balance, reflecting the decrease in value of the assets with which
it is grouped.

Assigning Account Numbers

To ensure that accounts are listed under the correct section
heading, and that the program prints the accounts in the right
order on financial statements, Simply Accounting uses the
following account numbering system. You cannot enter an
account number outside this range.

 Asset accounts 1000 to 1999
 Liability accounts 2000 to 2999
 Equity accounts 3000 to 3999
 Revenue accounts 4000 to 4999
 Expense accounts 5000 to 5999

When you assign account numbers, leave gaps between them.
(For example, leave a gap of 10 or 20 numbers.) If you later need
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to add an account in the same section, you can insert it between
two related numbers.

Linked Accounts

Before Simply Accounting can accept day-to-day transactions,
you must link each transaction window to its related control
accounts.

What is
linking?

Linking ensures that the program will update all the related
records automatically whenever you process a transaction.

For example, if you enter a cheque to one of your vendors in the
Payments window, you need to enter only the name of the
vendor and the invoice(s) you wish to pay. The program
automatically enters a transaction that decreases the balance in
a Bank account and decreases the outstanding (unpaid) amount
payable to the vendor.

The program includes a number of linked accounts which the
transaction windows can automatically update when you
process an entry.

Linked accounts in
company templates

If you use a company template to set up your company, many
of the linked accounts you need are already included in the
chart of accounts. (A company template is a ready-to-use chart
of accounts that a typical company would need.)

If you do not use a company template to set up your company,
or if you are adapting a template for your own company, you
must first add accounts to Simply Accounting or modify the
existing accounts in the company template. (You can easily
create, modify, or remove accounts using the Modify Accounts
wizard, on the Setup menu.)

Adding and linking
accounts

Follow the instructions under “Preparing the General Module
for Operation,” in Chapter 6, to add or change accounts. Then
follow the steps under “Setting Up a Linked Account,” later in
this chapter, to link the accounts in the modules you want to
use.
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Start with the General module, and then set up the linked
accounts in the other modules you wish to use. You can change
linked accounts at any time.

Sample Linked Accounts

Here is a list of accounts that might be used by a typical
company. It shows the account name, type, and number, and if
the account is a linked account, the module with which the
account is associated. Unlinked accounts show a dash (—),
instead of a module.

Statement
Section

Account
Number

Account
Name

Account
Type Module

ASSETS 1000 Current Assets Group Heading —

1030 Cash Draws Subgroup —

1050 Petty Cash Subgroup —

1055 Saving Bank Account Subgroup —

1060 Chequing Bank Account Subgroup Vendors and Purchases
1065 Payroll Bank Account Subgroup Payroll
1070 Total Cash Subgroup Total —

1080 Visa Subgroup Customers and Sales
1083 MasterCard Subgroup Customers and Sales
1087 American Express Subgroup Customers and Sales
1089 Other Credit Cards Subgroup Customers and Sales
1090 Total Credit Cards Receivable Subgroup Total —

1100 Investments Group —

1200 Accounts Receivable Subgroup Customers and Sales
1205 Allowance for Doubtful Accounts Subgroup —

1220 Payroll Advances Subgroup Payroll
1230 Total Receivable Subgroup Total —

1300 Prepaid Expense & Deposits Group —

1400 Total Current Assets Group Total —

1500 Inventory Assets Group Heading —

1520 Inventory A Group Inventory and Services
1530 Inventory B Group Inventory and Services
1540 Inventory C Group Inventory and Services
1590 Total Inventory Assets Group Total —

1800 Fixed Assets Group Heading —

1810 Leasehold Improvements Group —

1820 Office Furniture & Equipment Subgroup —

1825 Accum. Deprec’n - Furn. & Subgroup —
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Statement
Section

Account
Number

Account
Name

Account
Type Module

Equip.

1830 Net - Furniture & Equipment Subgroup Total —

1840 Vehicle Subgroup —

1845 Accum. Deprec’n - Vehicle Subgroup —

1850 Net - Vehicle Subgroup Total —

1860 Building Subgroup —

1865 Accum. Deprec’n - Building Subgroup —

1870 Net - Building Subgroup Total —

1880 Land Group —

1890 Total Fixed Assets Group Total —

1900 Other Assets Group Heading —

1910 Computer Software Group —

1920 Goodwill Group —

1930 Incorporation Cost Group —

1950 Total Other Assets Group Total —

LIABILITIES 2000 Current Liabilities Group Heading —

2100 Account Payable Group Vendors and Purchases
2120 Bank Loan - Current Portion Group —

2130 Bank Advances Group —

2160 Corporate Taxes Payable Group —

2170 Vacation payable Group Payroll
2180 EI Payable Subgroup Payroll
2185 CPP Payable Subgroup Payroll
2190 Federal Income Tax Payable Subgroup Payroll
2195 Total Receiver General Subgroup Total —

2200 QPP Payable Subgroup Payroll
2205 Quebec Payable Subgroup Payroll
2210 QHIP Payable Subgroup Payroll
2215 Total - Quebec Min. of Finance Subgroup Total —

2220 EHT Payable Group Payroll
2230 WCB Payable Group Payroll
2335 GST Owing (Refund) Subgroup Total —

2500 Total Current liabilities Group Total —

2600 Long Term liabilities Group Heading —

2620 Bank Loans Group —

2630 Mortgage Payable Group —

EQUITY 3300 Share Capital Group Heading —

3350 Common Shares Group —

3390 Preferred Shares Group —

3400 Total Share Capital Group Total —
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Statement
Section

Account
Number

Account
Name

Account
Type Module

3500 Retained Earnings Group Heading General
3560 Retained Earnings - Prev. Year Group —

3600 Current Earnings Group General
3690 Total Retained Earnings Group Total —

REVENUE 4000 Sale Revenue Group Heading —

4020 Sales Inventory A Group Customers and Sales
4030 Sales Inventory B Group Customers and Sales
4040 Sales Inventory C Group Customers and Sales
4200 Sales Group Customers and Sales
4220 Sales Returns Group Customers and Sales
4240 Sales Discounts Group Customers and Sales
4260 Net Sales Group Total —

4400 Other Revenue Group Heading —

4420 Freight Revenue Group Customers and Sales
4440 Interest Revenue Group Customers and Sales
4460 Miscellaneous Revenue Group Customers and Sales
4500 Total Other Revenue Group Total —

EXPENSES 5000 Cost of Goods Sold Group Heading —

5020 Inventory A Group Inventory and Services
5030 Inventory B Group Inventory and Services
5040 Inventory C Group Inventory and Services
5100 Inventory Variance Group Inventory and Services
5120 Item Assembly Costs Group Inventory and Services
5130 Adjustment Write-off Group Inventory and Services
5140 Transfer Costs Group Inventory and Services
5200 Purchases Subgroup Vendors and Purchases
5220 Purchase Returns Subgroup Vendors and Purchases
5240 Purchase Discounts Subgroup Vendors and Purchases
5290 Net Purchases Subgroup Total —

5300 Freight Expense Group Vendors and Purchases
5350 Total Cost of Goods Sold Group Total —

5400 Payroll Expenses Group Heading —

5410 Wages & Salaries Group Payroll
5420 EI Expense Group Payroll
5430 CPP Expense Group Payroll
5440 WCB Expense Group Payroll
5470 Employee Benefits Group Payroll
5490 Total Payroll Expense Group Total —

5600 General & Admin. Expenses Group Heading —

5610 Accounting & Legal Group —
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Statement
Section

Account
Number

Account
Name

Account
Type Module

5615 Advertising & Promotions Group —

5620 Bad Debts Group —

5630 Cash Short/Over Group —

5640 Courier & postage Group —

5645 Credit Card Charges Group —

5660 Deprecation Expense Group —

5680 Income Taxes Group —

5685 Insurance Group —

5690 Interest & Bank Charges Group —

5700 Office Supplies Group —

5720 Property Taxes Group —

5740 Miscellaneous Group —

5760 Rent Group —

5765 Repair & Maintenance Group —

5780 Telephone Group —

5785 Travel & Entertainment Group —

5790 Utilities Group —

5999 Total General & Admin.
Expenses

Group Total —

Figure 3.2.  Accounts for a typical company. Linked accounts are shown in bold type.

You can change the number or description of any of the
company template’s accounts, and remove any of them except
Current Earnings. To add, rename, or remove accounts, you can
use the Modify Accounts wizard, on the Setup menu. (To learn
more about modifying accounts, refer to Chapter 2,
“Maintaining Records,” in the User Guide.) To link or remove
linked accounts, see the next section, “Setting Up a Linked
Account,” and “Removing a Linked Account,” later in this
chapter.

Setting Up a Linked Account

You can set up linked accounts at any time, one at a time. If you
need many linked accounts, it’s much easier to use the Linked
Accounts wizard.
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To set up several linked accounts:

Linked Accounts
wizard

1.  From the Setup menu, select Wizards, and then Linked
Accounts.

2. Follow the wizard’s instructions until you have set up all
the linked accounts you need.

To set up one linked account:

Add the account 1.  In the Accounts window, add the account you want to use
as a linked account, if it is not there already. (For
instructions, see “Adding Accounts,” in Chapter 2 in the
User Guide.)

Select a module 2.  From the Setup menu, choose Linked Accounts and then a
module, for example, Vendors and Purchases.

For each
box, select
an account
from the
list.

3. Choose OK to accept your entries.

 Now, whenever you process a transaction, the program will
automatically update the linked accounts you specified.

Changing a Linked Account

You can set up different linked accounts to be updated when
you process transactions. For example, you may currently be
recording cash transactions from payroll and sales in two
different Bank accounts. If you want to use the same account for
both, you can change the linked account to the same account.
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To change a linked account:

Add the new
account

1. Add the new account in the Accounts window, if it does
not already exist.

2. From the Setup menu, choose Linked Accounts, and then a
module.

3. Make the changes you need.

4. Choose OK to accept your entries.

 From now on, Simply Accounting will automatically update
the linked accounts you specified.

Removing a Linked Account

If you do not need a linked account, you can unlink it, and then
remove the account.

For example, when you use a company template to create a new
company, the Accounts list includes an account called Freight
Expense. This account is linked to the Freight field in the
Purchases, Orders, and Quotes window. If you never pay for
freight, you can unlink the account. You can then remove the
Freight Expense account from the Accounts list.

To unlink an account:

1. From the Setup menu, choose Linked Accounts, and then a
module

 

Highlight the field, then
press Backspace or
Delete.

2. Clear the field containing the account you want to unlink,
and then choose OK.
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 Once an account is unlinked, you can remove it from the
Accounts list if you wish, by following the instructions
under “Removing Records,” in Chapter 2 of the User Guide.

Where To Now?
If you need more practice setting up accounts and choosing
options, do Exercises 1 through 8 in the Workbook.

If you have followed the instructions in this chapter, you can
now enter historical account information and accept
transactions. See Chapter 6, “Entering Account History,” for
instructions on how to complete these tasks.
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Chapter 6
Entering Account History

This chapter explains how to organize your account records in
preparation for entering account history, and how to set up
linked accounts for each module.

Before you add your accounting records to Simply Accounting,
you should read Chapter 5, “Choosing Options and Setting Up
Accounts,” to find out how to choose options and set up
accounts.

What is Account History?
When you create a new company or use one of the company
templates provided, the modules need to be brought up to date
with your company’s historical financial information. Historical
information includes account balances, vendor and customer
invoice and payment information, employee year-to-date
earnings, deductions, and expenses, and the quantity and value
of inventory on hand.

Simply Accounting modules are set up to accept historical
transactions and current day-to-day transactions concurrently;
you are not required to enter all Historical information before
entering new transactions. Historical information can be added
to any module until you select the Finish Entering History
command (on the History menu), or until the end of your
company’s first fiscal year.

Add history A History symbol beside an icon indicates that a window is set
to accept historical transactions.

When to finish
adding history

After you finish entering historical information, you set up
Simply Accounting to accept only new transaction entries, using
the Finish Entering History command. At the end of the first
fiscal year all history should be entered and balanced prior to
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completing year-end activities. (See Chapter 15, “Period-End
Processing.”)

After you select the Finish Entering History command, you cannot
enter additional historical information.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore on the
File menu.)

Preparing the General Module
Before you start entering account history, you must gather and
organize your existing records, and make decisions about how
you want the General module to work. Read “The Chart of
Accounts,” and “Linked Accounts,” in Chapter 5, then follow
the instructions in this section to organize and record your
account information.

Organize Your Account Records

Before you add Account records:

Design your financial
statements

■ Lay out your balance sheet and income statement in the
format described under “The Chart of Accounts,” in
Chapter 5. Include all the accounts you need. If you have
copies of your year-end financial statements, use them as a
guide. Also, check your company’s existing chart of
accounts for other accounts to be included in your financial
statements.

Classify accounts for
financial statements

■ Classify each account as a group heading, subgroup
account, subgroup total, group account, or group total, as
described under “Types of Accounts,” in Chapter 5. This
tells the program which accounts should be subtotaled
together, and where to place accounts on financial
statements.
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Assign account
numbers

■ Assign each account a four-digit account number. Read
“Assigning Account Numbers,” in Chapter 5 for guidelines
on logical account numbering.

Identify linked
accounts

■ Decide which accounts to use as linked accounts.

Your accounts list must include accounts which the
transactions processed in other modules can automatically
update.

 If you are using one of the company templates that comes
with Simply Accounting, with no changes, the necessary
accounts are linked automatically.

 If you are adapting a company template to suit your own
company, or if you created a new set of data files when you
installed Simply Accounting, you must decide which
accounts to use.

Identify zero-balance
accounts

■ Decide whether to include accounts that have a zero balance
when you print your balance sheet or income statement. For
example, if you are not using the linked accounts related to
EHT (Employer Health Tax) expenses and deductions, you
may not want the accounts printed on balance sheets and
income statements.

 Check your chart of accounts and identify the accounts you
do not want to include if their balances are zero. You will
enter this information when you add your accounts.

Ensure debits and
credits balance

■ Ensure that the total of the debit balances in your account
records equals the total of the credit balances. You cannot
finish entering history until your accounts balance.

Assign GIFI codes ■ Assign a GIFI code to each account if you file your
corporate tax returns (T2s) electronically. Contact your
accountant or Revenue Canada for information about GIFI
codes.

Tip:  We suggest that you ask your accountant to review
your chart of accounts and match them to GIFI codes, to
ensure they are correct.
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Entering Account Records and Historical Information

Once you have organized your account records, you are ready
to add them to Simply Accounting.

If you use a
company template

If you use one of the company templates that comes with
Simply Accounting, many of the accounts you need are already
included in the chart of accounts. You may need to modify or
delete (remove) some of them, or add new accounts.

For example, if you are going to link all the other modules to a
single bank account, you do not need the Saving Bank Account
and Payroll Bank Account; you can delete these accounts.

Follow the instructions under “Removing a Linked Account,” in
Chapter 5, to unlink an account before you delete it.

If you don’t use a
company template

If you do not use a company template, you must add each of
your accounts, one at a time.

To add an account:

1.  In the Home window, choose the Accounts icon.

2. On the Edit menu, choose Create, then fill in the account
number and name, and the Account tab.

Tip:  Position the mouse pointer over a field on the Chart
of Accounts Records window and helpful information
about the field displays on the status bar at the bottom of
the window.

3. Check your entries, then choose Create to add the account
to the General module.

Deleting or changing
accounts

You can also change and remove accounts. For more detailed
instructions, see Chapter 2, “Maintaining Records,” in the
User Guide.
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Entering account
balances

After you add your accounts, enter each account’s balance as of
the earliest transaction date. (The earliest transaction date is the
date you have chosen as the entry date for all your account
balances.) If you do not enter a balance, the program assigns the
account a balance of zero. The account balances you add when
you first set up your system are part of your company’s
“historical information.”

Current Earnings
account balance

Note that the Simply Accounting program calculates the balance
of the Current Earnings account; you cannot enter or change it.
The amount in the Current Earnings account is the difference
between the amounts in the revenue accounts and the amounts
in the expense accounts.

You must enter a balance for each of the modules (except the
General module) as of the earliest transaction date, in their
corresponding linked accounts in the General module: the
Accounts Payable, Accounts Receivable, Advances (receivable),
Vacation (payable), and linked inventory accounts.

You can enter account balances until you select Finish Entering
History on the History menu, or until the end of your
company’s first fiscal year. The General module then displays
account balances that change only when you make transaction
entries.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore from
the File menu.)

When you have finished entering accounts and balances, go to
the next section, “Linked Accounts in the General Module.”

Linked Accounts in the General Module

The General module uses the following linked accounts. These
accounts must be in the Equity section of your chart of accounts;
that is, in the 3000 to 3999 range of account numbers. To set up,
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change, or remove a linked account, see “Linked Accounts,” in
Chapter 5.

Retained Earnings.  Accumulates the company’s retained
earnings from previous years. The program adds the balance of
the Current Earnings account to it automatically when you start
a new accounting year.

Current Earnings.  Records the difference between total
year-to-date revenues and total year-to-date expenses. You
cannot change the account type, remove the account, or change
the account balance.

Before you finish entering history, you can change the Current
Earnings account balance by changing the balance of a revenue
or expense account. You can also change the balance at any time
by processing a new transaction that affects a revenue or
expense account.

Preparing the Vendors and Purchases Module
You use the Vendors and Purchases module to keep track of
your vendors (suppliers) and the amounts you owe and pay
them.

Before you start entering account history in the Vendors and
Purchases module, you must gather and organize your existing
records, make decisions about how you want the Vendors and
Purchases module to work, and set up linked accounts for the
Vendors and Purchases module.

Organize Your Vendors and Purchases Records

Before you add your vendors and purchases records:

Make a list of your
vendors (suppliers)

■ Assemble a complete list of all the vendors you do business
with. The program uses this information to print cheques,
mailing labels, purchase orders, and reports. Include:
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– Vendor name.

– Contact person.

– Address.

– Federal tax ID number.

– Telephone and fax numbers.

– E-mail address and Web site address.

– The payment terms offered by the vendor.

Find purchases
information

■ Find out the total fiscal year-to-date and last year’s
purchases from each vendor, if you want to include this
information in the vendor’s record.

Gather unpaid
invoices

■ Gather all unpaid vendor invoices, and records of any
partial payments made against each of them as of the
earliest transaction date.

Determine unpaid
balances

■ Determine the unpaid balance of each vendor
account.

Be sure debits and
credits balance

■ Ensure that the total of all balances owed to your vendors is
the same as the balance of the Accounts Payable account in
the General module. You cannot finish entering history until
the accounts balance.

Identify linked
accounts

■ Identify the accounts you want to link with the General
module.

 For an explanation of linked accounts, and instructions on
how to set them up, see “Linked Accounts,” in Chapter 5.

Entering Vendor Records and Historical Purchases

Add vendor records After you organize your vendor information, you must create a
record in the Vendors and Purchases module for each vendor.
Follow the instructions under “Adding Vendors (Suppliers),” in
Chapter 2 in the User Guide. Then follow the instructions in this
section to enter each vendor’s account history as of the earliest
transaction date.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
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to your data, you can restore a backup. (Choose Restore from
the File menu.)

Enter purchases and
payments history

After you add your vendors to the Vendors and Purchases
module, you can enter information about the amounts you owe
to each vendor, and any payments you have made against each
invoice as of the earliest transaction date. If you do not enter
this information, the program assumes that there are no unpaid
invoices.

You can enter historical information until you select Finish
Entering History on the History menu, or until the end of your
company’s first fiscal year. After that, the program records
invoice and payment information only when you enter new
transactions in the Purchases, Orders, and Quotes window and
the Payments window.

You can enter all the invoices and payments for a single vendor,
then all the invoices and payments for the next; or, you can
enter all the invoices for all vendors, then all the payments. Use
whichever method is convenient.

To enter a vendor’s payment history, listing all unpaid invoices
and any payments against them, follow the steps in the next two
sections, “Enter Purchase Invoices” and “Enter Payments.”

Enter Purchase Invoices

To enter purchase history:

1.  In the Home window, choose the Vendors icon.

2. Choose the vendor whose history you wish to enter, then
select the History tab, choose Invoices, then fill in the fields.
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Enter the date of the
invoice, or accept the date
displayed.

Enter the invoice number. Enter the full
amount of the
invoice, including
tax and freight,
even if you have
already paid part of
the invoice. (You
will record any
payments later.)

Change the payment terms only
if they differ from the ones you
entered for this vendor in the
Vendors window.

Record the invoice 3. Check that you have entered the information correctly, then
choose Record to add the invoice to this vendor’s history.

4. Fill in the fields and record all of this vendor’s unpaid
invoices, then choose Done to return to the previous screen.

5. Repeat steps 2 through 4 for the other vendors whose
invoices you want to record.

Display and print the
Vendor Aged Detail
report

6. Exit to the Home window, then display and print the
Vendor Aged Detail report. (On the Reports menu, choose
Vendors and Purchases, then Vendor Aged, then select
Detail and Select All, and choose OK. Choose Print from the
File menu.)

If you made a
mistake

7. Check your entries, then keep the printed copy for your
files. If you find an error in an invoice (an incorrect number
or amount), “pay” the invoice, following the steps in the
next section, then re-enter it with the correct information.

Where to now? When you have finished entering invoices, go to the next
section, “Enter Payments,” to enter the payments you have
made against the invoices.

Enter Payments

To record payments against historical purchase invoices:

1. In the Home window, choose the Vendors icon.

2. Choose the vendor whose history you wish to enter, then
select the History tab, then choose Payments.
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Enter the number of your
cheque, or type of credit card.

Enter the date of the
payment, or accept the date
displayed.

Once you’ve entered all
payment details, record it.

Next to each invoice
you paid with this
payment, enter the
amount you paid and
the discount you
received (if any). To
remove an amount,
press Delete or
Backspace.

3. Fill in the fields.

One payment for
multiple invoices

4. If the payment covers more than one invoice, fill in the
Amount Paid field for the other invoice(s).

5. Check that the entries are correct, then choose Record. The
program records your entry, and displays the remaining
invoices with amounts owing, ready for you to enter the
next payment details.

Entering installment
payments

You can record only one payment at a time for a particular
invoice. If you paid an invoice in installments, using more
than one cheque or credit card transaction, and you want to
record the payments separately, repeat steps 3 through 5 to
enter each payment and cheque number.

6. If there are other payments to record for the same vendor,
repeat steps 3 through 5.

7. When you have finished entering payments for this vendor,
choose Done to return to the previous screen.

8. Repeat steps 2 through 7 for the other vendors whose
payments you wish to record.

Print and file the
Vendor Aged Detail
report

9. When you finish entering invoices and payment history, exit
to the Home window and print a list of vendors and their
invoices and payments. (On the Reports menu, choose
Vendors and Purchases, then Vendor Aged, then select
Detail and Select All, then choose OK. On the File menu,
choose Print.)
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If you made a
mistake

10. Check your entries carefully to be sure that you have
entered everything correctly. If you find any errors, check
(select) the Clear Invoices When Paid box on the Options
tab in the vendor’s record. Choose Payments on the History
tab. Pay the invoice in full, then choose Record. Re-enter the
original invoice or payment correctly. Clear (uncheck) the
Clear Invoices When Paid box in the vendor’s record.

11. When you are sure the entries are correct, print the Vendor
Aged Detail report and keep a copy for your records.

Where to now? When you have finished entering the historical records for your
vendors, you are ready to set up linked accounts for the
Vendors and Purchases module. Go to the next section, “Linked
Accounts in the Vendors and Purchases Module.”

Linked Accounts in the Vendors and Purchases Module

Before you enter transactions in the Vendors and Purchases
module, you must set up its linked accounts. For more
information about linked accounts, refer to “Linked Accounts”
in Chapter 5.

You can set up the following linked accounts for the Vendors
and Purchases module.

Principal Bank. Records the payments you make to vendors.

Alternate Bank.  Records the payments you make to vendors
(use only if you need two separate accounts to pay for
purchases).

Accounts Payable.  Records the total amount you owe to your
vendors. The program records all purchases to this account
automatically.

GST Paid on Purchases.  Records the total amount of GST you
have paid on the purchases you have made. If you do not pay
GST on any purchases, you do not need this linked account.
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Freight Expense.  Records freight expense that cannot be
allocated to individual items purchased. If you do not pay
freight on purchases, you do not need this linked account.

Refundable QST Paid.  Records the amount of Quebec Sales
Tax paid on purchases that qualifies for an input tax refund. If
you do not pay QST that qualifies for an input tax refund on
any of your purchases, you do not need this linked account.

The Refundable QST Paid linked account appears after you
select the Use Quebec Sales Tax option. (On the Setup menu,
choose Settings, then select the Sales Taxes tab and select the
Use Quebec Sales Tax option.)

Purchase Discount.  Records any discount you receive on your
purchases from your vendors (suppliers) for early payment. The
program records all purchase discounts to this account
automatically.

Preparing the Customers and Sales Module
You use the Customers and Sales module to keep track of your
customers, and the amounts they owe and pay you.

Before you start entering historical transactions, you must
gather and organize your existing records, make decisions
about how you want the Customers and Sales module to work,
and set up linked accounts for the Customers and Sales module.

Organize Your Customers and Sales Records

Before you add your customers and sales records:

Make a list of your
customers

■ Assemble a complete list of all the customers you do
business with. The program uses this information to print
invoices, customer statements, mailing labels, and reports.
Include:

– Customer name.
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– Contact person.

– Mailing and shipping addresses.

– Telephone and fax numbers.

– E-mail and Web site addresses.

– Payment terms, including early-payment discount.

– Credit limit.

Find sales information ■ Find out the total fiscal year-to-date and last year’s sales for
each customer, if you want to include this information in
the customer’s record.

Gather unpaid
invoices

■ Gather all unpaid customer invoices, and records of any
partial payments made against each of them as of the
earliest transaction date.

Determine unpaid
balances

■ Determine the unpaid balance (if any) of each customer
account.

■ Ensure that the total of all balances owed by your customers
is the same as the balance of the Accounts Receivable
account in the General module. You cannot finish entering
history until the accounts balance.

■ Identify the accounts you want to link with the General
module.

 For an explanation of linked accounts, and instructions on
how to set them up, see “Linked Accounts,” in Chapter 5.

Entering Customer Records and Historical Sales

Add customer records After you organize your customer information, you must create
a record in the Customers and Sales module for each customer.
Follow the instructions under “Adding Customers,” in
Chapter 2 in the User Guide. Then follow the instructions in this
section to enter each customer’s account history as of the
earliest transaction date.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore from
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the File menu.)

Enter sales and
receipts history

After you add your customers to the Customers and Sales
module, you can enter information about the amounts each
customer owes you, and the payments you have received
against each unpaid invoice as of the earliest transaction date. If
you do not enter this information, the program assumes that
there are no unpaid invoices.

You can enter historical sales and receipts history until you
select Finish Entering History on the History menu, or until the
end of your company’s first fiscal year. After that, the program
records invoice and payment information only when you enter
new transactions in the Sales, Orders, and Quotes window and
the Receipts window.

You can enter all the invoices and payments for a single
customer, then all the invoices and payments for the next; or,
you can enter all the invoices for all customers, then all the
payments. Use whichever method is convenient.

To enter a customer’s payment history, follow the steps in the
next two sections, “Enter Sales Invoices” and “Enter Receipts.”

Enter Sales Invoices

To enter sales history for your customers:

1. In the Home window, choose the Customers icon.

2. Choose the customer whose history you wish to enter.
Select the History tab, choose Invoices, then fill in the fields.
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Enter the invoice number.

Enter the date of the
invoice, or accept
the date displayed.

Enter the full
amount of the
invoice, including
tax and freight, even
if the customer has
already paid part of
the invoice. You will
record any
payments later.

Change the payment
terms only if they differ
from the ones you entered
for this customer in the
Customers window.

Record the invoice 3. Check that you have entered the information correctly, then
choose Record to add the invoice to the history of this
customer’s purchases.

4. Fill in and record the information for all of this customer’s
unpaid invoices, then choose Done to return to the previous
screen.

Record invoices for
other customers

5. Repeat steps 2 through 4 for the other customers whose
invoices you want to record.

Print the Customer
Aged Detail report

6. Display and print the Customer Aged Detail report and
check the entries.

 To display the report, on the Reports menu, choose
Customers and Sales, then Customer Aged. Select Detail,
then Select All, then choose OK. Choose Print from the File
menu.

When you have finished entering invoices, go to the next
section, “Enter Receipts,” to enter the payments you have
received against the invoices.

Enter Receipts

To record payments received against historical sales
invoices:

1. In the Home window, choose the Customers icon.

2. Choose the customer whose history you wish to enter, then
select the History tab, then choose Payments.
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Enter the number of
the customer’s cheque
or type of credit card.

Enter the date of the
payment or accept the date
displayed.

Once you’ve entered all
the payment details, record
it.

Next to each invoice
the customer paid with
this payment, enter the
amount paid and the
discount given (if any).
To remove an amount,
highlight it, then press
Delete or Backspace.

One payment for
multiple invoices

3. Fill in the fields.

4. If the payment covers more than one invoice, fill in the
Amount Paid field for the other invoice(s).

5. Check that the entries are correct, then choose Record. The
program records your entry, and displays the remaining
invoices with amounts owing, ready for you to enter the
payments for another cheque.

Entering installment
payments

You can record only one payment at a time for a particular
invoice. If a customer paid an invoice in installments, using
more than one payment, and you want to record the
payments separately, repeat steps 3 through 5 to enter each
payment and cheque number.

6. If there are other payments to record for the same customer,
repeat steps 3 through 5.

7. When you have finished entering payments for this
customer, choose Done to return to the previous screen.

8. Repeat steps 2 through 7 for the other customers whose
invoice payments you wish to record.

Print and file the
Customer Aged
Detail report

9. When you have finished entering invoices and payment
history, exit to the Home window. On the Reports menu,
choose Customers and Sales, then Customer Aged. Select
Detail, then Select All, then OK, to display a list of
customers and their invoices and payments.
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If you made a
mistake

10. Check your entries carefully to be sure that you have
entered everything correctly. If you find any errors, check
(select) the
Clear Invoices When Paid box on the Options tab in the
customer’s record. Choose Payments on the History tab.
Pay the invoice in full, then choose Record. Re-enter the
original invoice or payment correctly. Clear (uncheck) the
Clear Invoices When Paid box in the customer’s record.

11. When you are sure the entries are correct, print the
Customer Aged Detail report and keep a copy for your
records.

Where to now? When you have finished entering the historical records for your
customers, you are ready to set up linked accounts for the
Customers and Sales module. Go to the next section, “Linked
Accounts in the Customers and Sales Module.”

Linked Accounts in the Customers and Sales Module

Before you enter transactions in the Customers and Sales
module, you must set up its linked accounts. For more
information about linked accounts, refer to “Linked Accounts”
in Chapter 5.

You can set up the following linked accounts for the Customers
and Sales module.

Principal Bank.  Records the payments received from
customers.

Alternate Bank.   Records the payments received from
customers, if you need a second account for this purpose.

Accounts Receivable.   Records the total amount your
customers owe you. The program records all sales and receipts
information to this account automatically.
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GST Charged On Sales (Rate 1)/(Rate 2).   Records the total
amount of GST you charged at rates 1 and 2 on goods and
services you sold to customers.

PST Payable.  Records the total amount of provincial sales tax
you collected from customers. If you are not required to collect
PST on any of your sales, or if you collect QST (Quebec sales
tax), you do not need to set up this linked account.

The PST Payable linked account appears when the Use Quebec
Sales Tax option is cleared. (On the Setup menu, choose
Settings, then select the Sales Taxes tab and clear (uncheck) the
Use Quebec Sales Tax option.)

Freight Revenue.  Records revenue from the freight charges
you collect from customers. If you do not charge freight on any
of your sales, you do not need to set up this linked account.

QST Charged On Sales (Rate 1)/(Rate 2).   Records the
amount of Quebec sales tax that you charged at rates 1 and 2 on
goods and services you sold to customers.

These two linked accounts appear when the Use Quebec Sales
Tax option is checked. (On the Setup menu, choose Settings,
then select the Sales Taxes tab and select the Use Quebec Sales
Tax option.)

Sales Discount.  Records any discount on sales you give your
customers for early payment. The program records all sales
discounts to this account automatically.

Preparing the Payroll Module
You use the Payroll module to keep track of your employees
and their earnings and deductions.

Before you start entering account history in the Payroll module,
you must gather and organize your existing records, make
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decisions about how you want the Payroll module to work, and
set up linked accounts for the Payroll module.

If you are not familiar with payroll accounting, or the
requirements of federal and provincial authorities, read
Chapter 18, “Payroll Accounting,” in the Accounting Manual. It
explains payroll accounting, and the principles of preparing
payroll and calculating amounts payable to government
authorities.

You should also obtain copies of all relevant federal and
provincial labour legislation. If necessary, consult an accounting
professional.

Follow the instructions in this section to organize and record
your payroll information.

Organize Your Payroll Records

Before you add payroll records:

Make a list of your
employees

■ Assemble a complete list of your employees and the
personal information for each of them. Include:

– Employee name.
– Address.
– Phone number.
– Social insurance number.
– Birth date.
– Hire date.
– Status (active or inactive).
– Regular wage rate per hour.
– Overtime wage rate(s) per hour.
– Regular salary per pay period.
– Hours per pay period. For salaried employees, this

number is used to calculate an amount for Record of
Employment forms (available from Human Resources
Development Canada) For employees paid hourly, it
saves time entering hours on each paycheque for
employees whose hours change infrequently.
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– Vacation pay retention. (For each employee, find out
whether to retain vacation pay, to be paid out later, or
include it on each paycheque. This depends on
provincial legislation.)

– Rate of vacation pay (percent).
– Province in which the employee is taxed.
– Number of pay periods per year.
– Annual claim, from TD-1 claim form (dollar amount).
– Annual claim, from MR-19-V or TPD-1.C-V claim form

(Quebec employees only).
– Workers’ Compensation Board rate (percent). For

Quebec employees, use the rate charged by the
Commission de la santé et de la sécurité du travail.

– Company’s EI premium factor (normally 1.4 percent).
(For each employee, find out whether to deduct EI.)

– Regular deduction amounts per pay period. (Pension,
union, and medical are examples of common regular
deductions.)

– Amount of additional federal income tax the employee
wishes to have deducted from each paycheque.

■ Find out the total year-to-date earnings, deductions, and
expenses for each employee, as of the earliest transaction
date. Include:

Earnings Earnings:

– Regular wages.
– Overtime wages.
– Salary and commissions, or other income categories.

(See “Customizing Names,” in Chapter 5 for
information on renaming these income categories.)

– Quebec Tips.
– Taxable benefits.
– Quebec taxable benefits (Quebec only).
– Vacation pay paid to the employee.
– Vacation pay owing to the employee.
– Advances paid (that the employee has not yet paid

back).
– EI insurable earnings.

Deductions Deductions:
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– Income tax. (For all provinces except Quebec, combine
federal and provincial tax. For Quebec, include only
federal tax in this category.)

– Quebec income tax (Quebec only).
– Northwest Territories Payroll Tax (NWT only).
– Employment Insurance premiums.
– Canada Pension Plan (CPP) contributions.
– Quebec Pension Plan (QPP) contributions (Quebec

only).
– Other miscellaneous deductions such as registered

pension plan contributions, union dues, or medical-plan
deductions.

 See “Customizing Names,” in Chapter 5, for information on
renaming these deduction categories, and “Customizing
Rates, Settings, and Formats,” in Chapter 5, to specify
whether to calculate these deductions before or after
calculating tax.

Be sure advances
balance

■ Ensure that the total of all advances paid to employees as of
the earliest transaction date is the same as the balance of the
Advances account in the General module. You cannot
complete the Finish Entering History command until the
accounts balance.

Be sure vacation pay
balances

■ Ensure that the total of all vacation pay owing to employees
as of the earliest transaction date is the same as the balance
of the Vacation Payable account in the General module. You
cannot finish entering history until the accounts balance.

Identify linked
accounts

■ Identify the accounts you want to link with the General
module.

 For an explanation of linked accounts, and instructions on
how to set them up, see “Linked Accounts,” in Chapter 5.

Entering Employee Records and Payroll History

Add employee
records

After you have organized your payroll information, you must
create a record for each employee. Follow the instructions under
“Adding Employees,” in Chapter 2 in the User Guide. Then enter
each employee’s earning and deduction history as of the earliest
transaction date, following the instructions in this section.
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Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore from
the File menu.)

Enter pay history After you add employees to the Payroll module, you should
enter calendar year-to-date earnings and deductions for each
employee as of the earliest transaction date. If you do not enter
this information, the program assumes that the balances are
zero, and the employee’s year-end totals will not include any
historical information.

You can enter historical information until you select Finish
Entering History on the History menu, or until the end of your
company’s first fiscal year. After that, the program records
earnings and deductions only when you make entries in the
Paycheques window.

You can see the historical information in each employee’s record
in the Employees window, and can print it in the Employee
Summary and Employee Detail reports.

To enter an employee’s payroll history:

1. In the Home window, choose the Employees icon.

2. Choose the employee whose history you wish to enter.

3. Select the Historical Income tab.
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Either enter the total wages
and overtime, or enter the
total salary for the year to
date.

You may have renamed
these fields. (On the Setup
menu, choose Names.)

Enter the vacation pay you have already paid
out, and the amount you will pay later.

Enter any advances paid (for example, travel
expenses) that the employee has not repaid,
and the employee’s cumulative year-to-date
EI insurable earnings. The program fills in the
net amount paid to the employee for the year
to date.

4. Fill in the historical income fields.

5. Select the Historical Deductions tab.

 

You may have renamed
these fields (by choosing
Names on the Setup menu).
The program can make any
of these deductions before or
after calculating taxes. (On
the Setup menu, choose
Settings, then select the
Payroll tab.)

6. Fill in the deduction amounts for the year to date.

7. Select the Historical Taxes tab.
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Enter the amount of federal and
provincial (except Quebec)
income tax deducted from the
employee’s income in the year
to date.

Be sure to enter the correct EI,
CPP, and QPP amounts. If the
amounts you enter are too low,
you and the employee will both
pay more than the annual limit.

8. Fill in the tax amounts for the year-to-date.

9. Check that you have entered the information correctly, then
choose the Next button to add the information to this
employee’s year-to-date history.

10. Repeat steps 3 through 9 for the other employees whose
history you want to record.

Print and file the
Employee Summary
report

11. When you finish entering employee history, exit to the
Home window. On the Reports menu, choose Payroll, then
Employee. Select Summary, then Select All, then OK, to
display a list of employees and their year-to-date earnings
and deductions.

If you made a
mistake

Check your entries carefully to make sure you entered
everything correctly. If you find any errors, go back to the
employee’s record and correct them, following the steps
above.

12. When you are sure the entries are correct, print the
Employee Summary report and keep a copy for your
records.

Where to now? When you finish entering the historical records for your
employees, you are ready to set up linked accounts for the
Payroll module. Go to the next section, “Linked Accounts in the
Payroll Module.”

Linked Accounts in the Payroll Module

Add linked accounts Before you enter transactions in the Payroll module, you must
set up the module’s linked accounts. For more information
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about linked accounts, refer to “Linked Accounts,” in Chapter 5.
You can set up the following linked accounts for the Payroll
module.

Payroll Bank account.  Records the payroll cheques you issue
to employees.

Advances Receivable.  Records the total amount your
employees owe you for advances you have paid them.

Vacation Payable.  Records the total amount of vacation pay
you owe your employees, if you do not pay out vacation pay on
each paycheque. (This depends on provincial legislation.)

EI Payable.  Records the total amount of Employment
Insurance premiums you owe the government. The program
calculates and totals the EI premiums collected from employees
and those payable by the employer, as required by Revenue
Canada.

CPP Payable.  Records the total amount of Canada Pension
Plan contributions you owe the government. The program
calculates and totals the CPP contributions collected from
employees and those payable by the employer, as required by
Revenue Canada.

Tax Payable.  Records the total amount of federal and
provincial income tax deducted from employees’ incomes. If
your employees work in Quebec, this amount contains only the
federal tax payable.

WCB Payable.  Records the total amount of Workers’
Compensation Board contributions the employer owes the
government. For Quebec employees, this is the account that
records the total amount of CSST contributions the employer
owes the government.

EHT Payable.  Records the total amount of Ontario Employer
Health Tax or Newfoundland Health and Post-Secondary
Education Tax contributions you owe the Ontario or the
Newfoundland government on behalf of your employees.
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Tax (Que) Payable.  Records the total amount of Quebec
income tax deducted for all employees working in Quebec. If
you have changed the name of the Provincial Tax field (by
choosing Names on the Setup menu), this field uses the new
name (for example, NWT Tax).

QPP Payable.  Records the total amount of Quebec Pension
Plan contributions you owe the government. The program
calculates and totals the contributions collected from employees
and those payable by the employer.

QHSF Payable.  Records the total amount of Quebec Health
Services Fund contributions payable by your company, for
employees resident in Quebec.

Pension, Union Dues, Medical, Deduction D to J.   These
record the total amount of company pension plan contributions,
union dues, medical-plan premiums, and other deductions
collected from employees.

You may have changed the names of these fields (by choosing
Names on the Setup menu), or of the Deduction A to J accounts
(by editing them in the Accounts window).

If your employees receive benefits that are subject to GST or
QST, you can set up the linked accounts only after you create
them:

■ GST On Benefits.  Add this account near your other GST
accounts in the 2000 to 2999 range.

■ QST On Benefits.  If you use Quebec Sales Tax in your
business, add this account near your other QST accounts in
the 2000 to 2999 range.

 For instructions, see the “Adding Accounts” section of
Chapter 2, “Maintaining Records,” in the User Guide.

 Also, ensure that you rename the Deduction D field,
Misc A, to GST/Benefits and the Deduction B field, Misc B,
to QST/Benefits (by choosing Names on the Setup menu).
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Wage Expense.  Records the gross income (hourly wages,
salary, commission, vacation pay, income fields C, D and E)
from transactions entered in the Paycheques window. You can
use a single account, or set up several linked accounts if you
want to keep track of different wages separately.

EI Expense.  Records the employer’s portion of the EI Payable
account.

CPP Expense.  Records the employer’s portion of the CPP
Payable account.

WCB Expense.  Records the expense associated with the WCB
Payable account.

EHT Expense.  Records the expense associated with the EHT
Payable account. If you do not have employees who work in
Ontario or Newfoundland, you do not need this linked account.

QPP Expense.  Records the expense associated with the QPP
Payable account. If you do not have employees who work in
Quebec, you do not need to set up this linked account.

QHSF Expense.  Records the expense associated with the QHSF
Payable account. If you do not have employees who work in
Quebec, you do not need to set up this linked account.

Preparing the Inventory and Services Module
You use the Inventory and Services module to keep track of the
goods and services you sell, and their associated asset, revenue,
expense, and variance accounts. You use the following windows
to record changes in the quantity and value of your inventory:

■ Purchases, Orders, and Quotes.

■ Sales, Orders, and Quotes.

■ Item Assembly.

■ Adjustments.
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Before you start entering historical transactions for the
Inventory and Services module, you must gather and organize
your existing records, and make decisions about how you want
the Inventory and Services module to work. If you wish, you
can set up linked accounts.

If you are not familiar with the principles of inventory
accounting, read Chapter 19 in the Accounting Manual.

Follow the instructions in this section to organize and record
your inventory and services information.

Organize Your Inventory Records

Before you add your inventory records:

Make a list of your
inventory and service
items

■ Assemble a complete list of all the inventory items you sell.
These can be either goods (such as lumber or cookies) or
services (such as delivery or repairs). Include:

– Item number and description.
– Whether the item is inventory or a service.
– Unit (each, dozen, kilogram, hour, and so on).
– Selling price per unit.
– Whether to charge PST or QST on sales of services.
– Total quantity of goods on hand as of the earliest

transaction date.
– Total value (cost) of the goods on hand.
– The number of transactions, units sold, cost of goods

sold, and amount sold, for the year to date and last
year.

– Date of the last sale.
– Minimum stock level (the level at which you re-order

goods).

Identify linked
accounts

■ Identify the accounts you want to use to link with the
General module.

 For an explanation of linked accounts, and instructions on
how to set them up, see “Linked Accounts,” in Chapter 5.

Link related accounts
to each item

■ For each inventory item, decide which accounts to use to
record asset, revenue, expense, and variance amounts.
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 Revenue and variance accounts are optional. Expense
accounts are used to track the cost of goods sold.

 The program updates one or more of these four accounts
whenever you buy or sell inventory items. (When you buy
an inventory item, the program increases the asset account
balance. When you sell an inventory item, the program
reduces the asset account balance, and records the selling
price to the item’s revenue account and the cost price to the
item’s expense account. If you allow negative inventory
levels, occasional price variances are recorded in the
variance or expense account.)

 You can have one asset, one revenue, one expense, and one
variance account for all inventory items, or you can group
items and associate each group with a different asset,
revenue, expense, and variance account. For example, if
your company is a grocery store, you could put all baked
goods in one group, all fruits and vegetables in another, and
all canned goods in another.

Service items For each service item, decide which accounts (if any) to use
to record revenue and expense amounts. These accounts
are both optional.

 When you sell a service, the program records the selling
price to the service item’s revenue account, and when you
purchase a service item, the program records the cost price
to the item’s expense account, if you supplied these
accounts for the item.

 You can have one revenue and one expense account for all
service items, or you can group items and associate each
group with a different revenue and expense account. For
example, if your company provides lawn and garden
services, you could put all the lawn-care services in one
group, and all the gardening services in another.

Decide whether to
allow negative
inventory levels

■ Decide whether you need inventory levels to be able to fall
below zero — useful if you need to record a sale before
purchasing your inventory.

 If you use the Allow Inventory Levels To Go Below Zero
option (explained in the “Inventory and Services” section of
Chapter 5), the first time an item’s inventory level drops
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below zero, the program will ask you to specify a variance
account — to record possible differences between average
and actual cost.

Be sure accounts
balance

■ Ensure that the value (cost) of all inventory items associated
with an asset account is the same as the balance of that
inventory asset account in the Accounts window. You
cannot finish entering history until the accounts balance.

Entering Item Records and History

Add item records After you organize your inventory and services information,
you must create a record in the Inventory and Services module
for each item and service you sell. Follow the instructions under
“Adding Inventory Items and Services,” in Chapter 2 in the
User Guide.

You should also enter historical information, the quantity and
value of each inventory item’s stock on hand as of the earliest
transaction date, number of transactions and units sold, and
amount sold for last year and the year to date. If you do not
enter this information, the program assumes the quantities and
values are zero.

You can enter historical Inventory and Services quantity and
value information until you select Finish Entering History, or
until the end of your company’s first fiscal year. After that, the
program records quantity and value (cost) information only
when you enter transactions in the following windows:

■ Purchases, Orders, and Quotes.

■ Sales, Orders, and Quotes.

■ Item Assembly.

■ Adjustments.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore from
the File menu.)
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To enter inventory and services history:  

1. In the Home window, choose the Inventory and Services
icon.

2. Choose the first item whose history you wish to enter.

3. Select the Activity tab.

  

Enter the year-to-date figures
for the item. The Cost Of Goods
Sold (C.O.G.S.) field appears
only for inventory items (not for
service items).

Enter last year’s figures for the item, if
applicable. The Cost Of Goods Sold
(C.O.G.S.) field appears only for
inventory items (not for service items).

3. Fill in the fields.

4. Select the History tab to fill in the fields for Opening
Quantity and Opening Value.

5. Check that you have entered the information correctly, then
choose the Next button to add the information to this item’s
history.

 The program adds the information, and displays the next
item record.

6. Repeat steps 4 and 5 for the other items.

Display and print
several inventory
reports

7. Display and print the Inventory and Services List, and the
Inventory and Services Detail, Inventory Quantity, and
Inventory Synopsis reports, as described below, then check
the entries. Keep the reports for your files.

 Inventory and Services List.  In the Home window, on the
Reports menu, choose Lists, then choose Inventory and
Services. Check that you have entered the item numbers,
descriptions, and account numbers correctly.
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 Inventory Quantity.  In the Home window, on the Reports
menu, choose Inventory and Services, then Inventory.
Choose Inventory By Item, Item Quantity, then choose
Select All. Choose OK, then check that you entered the
quantities and minimum levels correctly.

 Inventory and Services Detail.  In the Home window, on
the Reports menu, choose Inventory and Services, then
Activity. Choose the Select All button, then under Select
From select All Items. Check the boxes for the details you
wish to include in the report, then choose OK. Check that
you have entered the number of transactions, units sold,
amount sold, cost of goods sold, and last sale date correctly.

 Inventory Synopsis.  In the Home window, on the Reports
menu, choose Inventory and Services, then Inventory.
Choose Inventory By Item, Item Synopsis, then choose
Select All. Choose OK, then check that you have entered the
units, price, cost, and total value correctly.

When you have finished entering historical records for your
inventory items, you are ready to set up linked accounts for the
Inventory and Services module. Go to the next section,
“Inventory and Services Module Linked Accounts.”

Linked Accounts in the Inventory and Services Module

Before you enter transactions in the Inventory and Services
module, you should set up the linked inventory accounts. For
more information about linked accounts, refer to “Linked
Accounts,” in Chapter 5. Here are the linked accounts you can
set up:

Item Assembly Costs.  Records the costs of assembling
component inventory items into manufactured inventory items.
If you never assemble inventory items, you do not need to set
up this linked account.

Adjustment Write-off.  Records changes in the value of your
inventory due to shrinkage, theft, and so on. The program uses
this account as the default account in the Adjustments window;
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all adjustments update this account, unless you specify a
different account when you make an adjustment. Typically, this
account is an expense account such as Shrinkage, Obsolescence,
or Damage. If you do not set up this linked account, adjustment
transactions update the item’s expense account.

If you never write off inventory costs (for example, if you never
have shrinkage or damage of inventory items), you do not need
to set up this linked account.

Preparing the Project Module
You use the Project module to list the projects you are working
on, their start dates, and balance forward amounts. You can also
use it to budget revenues and expenses for projects. You
allocate revenues and expenses to projects by entering
transactions in the following windows:

■ Miscellaneous Transactions.

■ Purchases, Orders, and Quotes.

■ Sales, Orders, and Quotes.

■ Paycheques.

■ Adjustments.

Note:  The Project module does not have its own
transaction-entry window.

If you are not familiar with project accounting, read Chapter 20,
“Cost Accounting,” in the Accounting Manual, to see how you
might allocate revenues and expenses in your business.

Since the Project module does not have any associated
transaction-entry windows, it is not affected by the Finish
Entering History command. You can change the name of the
Project module to the name of the profit centres you wish to use
for your company (on the Setup menu, choose Names). For
example, you might use Branch, Division, Department, Region,
or Job Cost.
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Organize Your Project Records

Make a list of
your projects

Assemble the names of all projects to which you want to
allocate revenues or expenses. If a project is large, you may
want to set up separate names for each of its major parts.

Find current
balances

The opening balance of a project is zero until you allocate
revenues or expenses to it by entering transactions. If you
already have projects underway when you set up Simply
Accounting, find out the current revenue or expense balance for
each, so you can add their historical balances to the record.

Entering Project Records and Project History

Add project records After you organize your project records, you must create a
record for each project in the Project window. Follow the
instructions under “Adding Projects,” in Chapter 2 in the
User Guide. Then follow the instructions in this section to enter
historical balances for each project.

At the end of a fiscal year, the program carries over the balance
in any project-related accounts, so you can continue accounting
for a project’s revenues and expenses in the new year. It does
not carry over individual transaction entries, but you can print a
project report for the previous year that includes project details.

To enter project history:

1. In the Home window, choose the Project icon.

2. Choose the project you want. Fill in the balance-forward
amounts.
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Finish Entering History
After you have entered your records and their historical
information, and have set up the linked accounts for the
modules you plan to use, you must select Finish Entering
History from the History menu. If you have not completed the
Finish Entering History command before the end of your
company’s first fiscal year end, Simply Accounting will not let
you close the current year.

Until you finish entering history, you can continue to change the
account balances or other information you entered, and there
are no restrictions on deleting any of the module records.

Backup Remember to back up your data frequently. (Choose Backup on
the File menu or toolbar.) In case of a power failure or damage
to your data, you can restore a backup. (Choose Restore from
the File menu.)

Finish entering historical transactions:

1. In the Home window, on the History menu, choose Finish
Entering History.

The Budget tab appears
when the Budget Project
option is selected. (Select
Settings from the Setup
menu, choose Project, then
check Budget Project and
enter Budget Period
Frequency.)
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Note: If the accounts are not balanced, you will not be able
to complete the Finish Entering History command. Simply
Accounting will indicate which totals are not balanced.

 

2. Choose Proceed. The History symbols disappear, to show
that you can no longer enter historical information.

Where To Now?
Keep the Getting Started manual handy in case you need to refer
to it again, to change program options, set up printers (see
Chapter 8, “Setting Up Printers”), or reconcile your accounts
using Simply Accounting (see Chapter 7, “Setting Up an
Account for Reconciliation.”)

Use the Workbook If you need more practice in working with Simply Accounting,
refer to the Workbook.

Use the User Guide To familiarize yourself with day-to-day use of the program,
refer to the User Guide. You will probably want to refer
frequently to Chapter 2, “Maintaining Records,” and Chapters 4
through 13.
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Use the Quick
Reference

Once you are familiar with the program, use the Quick Reference
booklet as a reminder of how to do common tasks.
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Chapter 7
Setting Up an Account for
Reconciliation

This chapter describes how to set up an account for
reconciliation. You can set up as many as 1,000 accounts to use
for reconciling (matching) your Simply Accounting records to
your bank or credit-card statements.

Use online banking to
help you reconcile

If your financial institution has a Web site, you can use online
banking to eliminate much of the manual work of reconciling. If
you wish to be able to use this feature, you must first set up the
account to use online banking. To find out how to set up an
account for online banking, read the section “Setting Up an
Account for Online Banking,” later in this chapter.

Before you begin If you plan to accept credit cards from customers or to use
credit cards to make payments to vendors, refer to “Credit
Cards,” in Chapter 5 to set up credit-card information before
you reconcile accounts.

Finish entering history
for Accounts module

Before you can set up an account for reconciliation, you must
finish entering history for your company. For more information
about entering history, see Chapter 6, “Entering Account
History.”

After you set up After you have set up the accounts and credit cards you need,
refer to Chapter 14 of the User Guide to find out how to reconcile
your bank and credit-card statements each month.

What is Account Reconciliation?
Simply Accounting stores a record of the current status of the
cheques and other payments issued by your company, of the
bank deposits you make, of the credit-card payments you
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process, and of any miscellaneous transactions that affect the
accounts you have set up for reconciliation.

Reconciliation allows you to find errors or unexpected
differences between your accounting records and the records
(statements) the bank or credit-card company sends you. (The
statement may list interest, fees, and service charges you had to
pay, as well as interest you earned from the bank. These
amounts will not appear in your Simply Accounting records
unless you add them.)

When you receive a statement from a financial institution, you
can use the Account Reconciliation window to compare
transactions on the statement with your Simply Accounting
transactions. This process of comparing a statement to your
own records and accounting for any differences is called
reconciliation.

If you use the Import Online Statements feature to help you to
reconcile Bank or Credit Card accounts, Simply Accounting
automatically matches transactions from downloaded
statements to your Simply Accounting transactions.

Accounting control It is good bookkeeping practice to have someone who does not
make deposits, or sign cheques, reconcile the bank statements.

Checking Credit-Card Statements
Track credit-card
transactions
separately

To keep track of credit-card transactions, create a separate asset
account for each credit card you use or accept, and then set up
the Credit Card accounts for reconciliation, as described in this
chapter.

Reconcile Credit
Card accounts first

You will not find deposits for individual credit-card sales on
your bank statement. The credit-card company normally
transfers the amounts it owes you in lump sums to your bank,
based on each day’s credit-card sales. Therefore, it is a good
idea to reconcile your Credit Card accounts before reconciling
your Bank account.
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Transfer reconciled
credit-card deposits
to your Bank account

On a daily basis, reconcile your credit-card merchant statements
to your credit-card transactions in Simply Accounting. When
you have reconciled the Credit Card accounts to your merchant
statements, record transactions in Simply Accounting
transferring the amounts the credit-card company pays you
from your Credit Card account to your Bank account. Until you
transfer these amounts, your Bank account in Simply
Accounting will not match your balance at the bank, and you
will be unable to reconcile them.

Tip:  To make it easier to reconcile your Bank account, later,
be sure to record a separate transaction for each day’s
deposits, for each credit card.

To transfer the credit card deposits in Simply Accounting:

1. In the Home window, choose Miscellaneous Transactions.

2. Enter transactions to debit the Bank account and credit the
Credit Card account with the amounts that the credit-card
company has transferred to your bank.

Overview: Three Steps to Setting Up
Simply Accounting lets you reconcile up to 1,000 accounts. You
can reconcile any group or subgroup account in the 1000 to 3999
account range, as long as it is not being used as a linked
account. Normally, however, you reconcile accounts, such as
bank or credit-card accounts, that you use to keep track of
transactions with financial institutions.

Set the account to Ready

Add the accounts you need

Enter unreconciled
transactions

For each account you want to reconcile, follow the one-time
setup procedures explained in this chapter. After that, daily or
monthly processing for each account is simple. In general, to set
up an account for reconciliation:

1. Add the related income, expense and adjustment accounts
you need, and then link them to the account you are setting
up for reconciliation.
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2. Reconcile the accounts by hand, and prepare a list of
unreconciled (outstanding) items. Enter this information
and ensure that it reconciles in Simply Accounting, as well.

3. Set the account ready to reconcile.

Adding and Setting Up Accounts for Reconciliation

Set the account to Ready

Add the accounts you need

Enter unreconciled
transactions

As you work though this first of three main sections, you will:

■ Add to Simply Accounting all accounts you need for
reconciling (including, if you haven’t added it already, the
account you want to reconcile).

■ In the account record, select the linked accounts Simply
Accounting will update when you reconcile the account.

Adding the Accounts You Need for Reconciling

1. Add the following accounts in Simply Accounting, if they
do not already exist. (If you are unsure how to add
accounts, see “Adding Accounts,” in Chapter 2 of the User
Guide.)

 You can use the same income, expense, and adjustment
accounts to reconcile more than one Bank or Credit Card
account.

■ Account to be reconciled:  If you have not already
done so, add each account you want to reconcile
(number the accounts in the 1000 to 3999 range). For
example, you may use one account for purchases of
inventory, one for payroll, one for credit-card payments
from your customers, and another for credit cards you
use to pay your vendors.

Linked accounts ■ Income accounts:  Add income accounts for amounts
that your financial institution (not you) decides to
deposit in your account (for example: Bank Interest, or
Bank A Investment Interest). Number them in the
4000 to 4999 range.
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■ Expense accounts:  Add expense accounts for
amounts that your financial institution decides to
charge you or withdraw from your account (for
example: Bank Charges, Merchant Fees, or Bank B Loan
Interest). Number them in the 5000 to 5999 range.

■ Adjustment account:  Add one income account or one
expense account for errors that you find on your
statement and for occasional, small adjustments (for
example: Reconciliation Adjustments) numbered in
the 4000 to 4999 or the 5000 to 5999 ranges.

 Add as many accounts as you need, up to three income
accounts, three expense accounts, and one adjustment
account. If you need more, you may need to make manual
adjustments in the Miscellaneous Transactions window
when reconciling.

Selecting Linked Accounts

Next, you will link the related income, expense, and adjustment
accounts from the previous section to the account you plan to
reconcile. To save you time, the program displays these
accounts in the Account Reconciliation window when you begin
reconciling, and automatically updates them when you finish
reconciling.

1. In the Home window, choose Accounts.

2. Display the record for the account you want to set up for
reconciliation.

3. On the Account Reconciliation tab, select the option Save
Transactions For Account Reconciliation.

4. Choose the Linked Accounts button and fill in the fields
with your preferences.
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Select up to three income
(revenue) accounts and up to
three expense accounts.

Identify one adjustment
account for bank errors.

If you wish, enter more
meaningful names for the
income and expense
headings.

5. Choose OK.

Setting Up an Account for Online Banking

If you wish to reconcile Bank or Credit Card accounts using
statements that you download from your financial institution’s
Web site, you must first set up the account to use the online
banking feature.

To set up an account for online banking:

1. In the Home window, choose Accounts.

2. Display the record for the Bank or Credit Card account you
want to set up for online banking.

3. Fill in the fields.
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You must check this box
to display the other fields in
this tab.

Select Bank Account or Credit
Card Account.

If you select Bank Account, these
fields appear. Enter the bank’s
transit number and select the type
of bank account.

Enter your account number at
the financial institution.

Entering Unreconciled Transactions

Set the account to Ready

Add the accounts you need

Enter unreconciled
transactions

As you work through this second of three main sections, you
will:

■ Manually reconcile your account and, if needed, adjust
some expense and income accounts in the Miscellaneous
Transactions window.

■ Enter any unreconciled amounts from the manual
reconciliation, either by typing them, or by selecting them
from a list of transactions already entered.

Backup Before you continue, back up your company files. (On the File
menu, choose Backup, then fill in the screen.) Later, if you are
unhappy with your attempt to set up account reconciliation, it
will be easier to start over if you have a backup.

Manually Reconciling: Making a List of Unreconciled Amounts

In this section, you will determine which transactions to store
with the account record. These are unreconciled amounts you
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must look for on future statements because they did not appear
on a past bank or credit-card statement.

Print the most current
transactions

1. In the Home window, from the Reports menu, choose
Financials, and then Transactions By Account.

Enter the date of the day after
your last manually reconciled
bank or merchant statement.

After you enter the
date range and
select the account,
click OK.

Enter the
session date.

Select only the Bank or Credit
Card account you want to set
up for reconciliation.

2. In the report that appears, choose Print from the File menu.

3. Gather all your unreconciled statements and match them to
the Transactions By Account report. If there is a form on the
back of your bank or credit-card statement, use it to help
you.

4. Ensure that all cheques you wrote, and all deposits or
credit-card payments you processed, are on the statements.

Income and
expense amounts

 As you reconcile, you may find withdrawals or deposits
that the bank or credit-card company decided to make from
your account. For example, on the statement you find a:

■ Withdrawal of 35¢ for each cheque you wrote.

■ Deposit for interest you earned from the bank.

■ Rental charge for an electronic or ATM terminal.

■ Four percent merchant-fee deduction from credit-card
deposits.

5. If you find such transactions on your bank or credit-card
statement, enter them in the Miscellaneous Transactions
window to finish your manual reconciliation:

■ For all such withdrawals on the statement, credit the
account you are reconciling and debit an expense
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account. (For example, debit one of the Expense
accounts you added earlier in this chapter, in “Adding
the Accounts You Need for Reconciling.”)

■ For all such deposits on the statement, debit your Bank
account, and credit an income account. (For example,
credit one of the Income accounts you added earlier in
this chapter.)

Tip: As you reconcile each statement, you may find
that some of the withdrawals or deposits you made
during a particular month are not on that month’s
statement. These missing or “unreconciled”
amounts will likely appear on the following
month’s statement.

Unreconciled
amounts

6. Make a list of any missing or “unreconciled” amounts. (If
you are manually reconciling more than one statement,
remove any unreconciled amounts from this list if you find
them on later statements.)

Making this list of unreconciled amounts is very important.  
Since you plan to reconcile the next statement using Simply
Accounting, you must store their details in Simply Accounting.

 Continue with the instructions in the next section, “Adding
Unreconciled Amounts to the Account Record.”

Adding Unreconciled Amounts to the Account Record

In your manual reconciliation, you accounted for any
differences between the balance on your bank or credit-card
statement and the corresponding account balance in your
Simply Accounting records.

These differences normally arise because your Simply
Accounting records are more up-to-date than the bank or
credit-card statement. When you reconcile in Simply
Accounting, you must add outstanding transactions to the
Account Reconciliation record, so that the balance forward will
be correct when you reconcile the following month.
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When you add the amounts to the account record, you will
probably need to:

■ Select outstanding transactions from the list of transactions
in Simply Accounting.

■ Type in any transactions that were outstanding as of the
earliest transaction date, or when you last cleared
transactions.

Selecting Existing Transactions

The recommended way to add unreconciled transactions is to
select them from a list of transactions. The program will store
the details of the transactions you select, in the account record.

1. In the Home window, choose Accounts.

2. Display the record for the account you are setting up for
reconciliation.

3. On the Account Reconciliation tab, click Save Transactions
For Account Reconciliation. Choose Setup, and then Yes.

4. Enter a date range.

Check your manual
reconciliation and enter the
earliest date of any
unreconciled amount. (You
cannot choose a date
earlier than the earliest
transaction date.)

Be sure to enter
the session date,
not an earlier
date.

5. In the list that appears, highlight all the amounts from your
manual reconciliation that you want to add (the ones you
found in the section “Manually Reconciling: Making a List
of Unreconciled Amounts”).
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Select all transactions that
appear on the list you made
when you manually
reconciled past statements.
(Transactions from before
the earliest transaction
date, or before you last
cleared entries, can be
added later.)

Select each item
only once!

All previously selected items are marked with a check mark
(9) in the Status (S) column. Since you can save your work
and return to it later, be careful not to select the same
transaction more than once! See “What to Do about an
Unresolved Amount,” later in this chapter, to remove
duplicate or unwanted items from the list of unreconciled
items.

Missing transactions The on-screen list may be incomplete. You will add missing
transactions later by typing them in.

6. Choose OK and continue with the steps that follow, in
“Typing In Unreconciled Transactions.”

Typing In Unreconciled Transactions

A second way to add unreconciled transactions from your
manual reconciliation is to type them in. The program will store
the details of those transactions with the account.

Use this method when the transaction date is either before the
earliest transaction date, or before the date you last removed
(cleared) transaction details.

Typing an unreconciled item in the Set Up Account Reconciliation
dialog box does not add it to the transaction list in any other module.
If the item was never entered in Simply Accounting, leave the Set Up
Account Reconciliation dialog box and enter it as described next.
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To enter an unreconciled transaction from the current
financial year that was never entered:

1. Close the Set Up Account Reconciliation dialog box.

2. In the Home window, choose a transaction window (for
example, Miscellaneous Transactions).

3. Enter the missing transaction.

4. Then, in the Account Reconciliation window, use the steps
in “Selecting Existing Transactions,” earlier in this chapter,
to store the unreconciled amount with your account.

To type an unreconciled transaction:

1. In the Home window, choose Accounts.

2. Display the record for the account you are setting up for
reconciliation.

3. On the Account Reconciliation tab, choose Setup, then No.

 

Add transactions from before
the earliest transaction date:
choose Edit, Insert Line
anywhere in the list, or type in
the bottom (blank) line.

4. Type in any unreconciled transactions that remain. Do not
enter those that you selected in the previous section,
“Selecting Existing Transactions.”

Tip:  When you print the Account Reconciliation Detail
report, the transactions print in the order in which you
entered them, so you may want to order them by date.
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5. Once you have added all the unreconciled transactions, skip
to step 2, in the next section, “Entering the Statement’s
Ending Balance.”

Entering the Statement’s Ending Balance

Look up the ending balance on your most recent reconciled
bank or credit-card merchant statement (from your manual
reconciliation).

1. In the Home window, choose Accounts.

2. Display the record for the account you are reconciling.

3. On the Account Reconciliation tab, choose Setup, and
then No.

 

From the statement, enter the
ending, or “closing,” balance.
Do not skip this step!

The goal is to reduce this
number to zero.

 The program compares the statement ending balance to the
current balance of the account. The difference must be the
same as the total of the unreconciled items you have been
adding.

 If the unresolved amount is zero, follow the steps later in
this chapter, in “Setting the Account to Ready.”

 If the unresolved amount is not zero, check for hints in
“What to Do about an Unresolved Amount.”
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What to Do about an Unresolved Amount

If all else fails, restore your backed up company files, take a
break, and start from the beginning. Before you take this drastic
step:

1. Print an Account Reconciliation Detail report for the
account you are reconciling, so that you can see a record of
the reconciliation in progress. In the Home window, from
the Reports menu, choose Account Reconciliation, and then
Account Reconciliation Status Report. Select the account,
enter dates, and choose OK. Then, for a printed copy,
choose Print from the File menu.

2. Work through the checklist that follows.

 If you find an error, correct it, and then return to the Set Up
Account Reconciliation dialog box to see whether the
unresolved amount is zero.

Checklist: Correcting an Unresolved Amount

❑ Statement
balance

In the Set Up Account Reconciliation dialog box, check that you
entered the ending balance from your last bank statement.

❏ Incomplete list
of transactions

Check your manual reconciliation. Be sure you listed all
unreconciled withdrawals and deposits in the Set Up Account
Reconciliation dialog box.

❏ Charges, fees,
and interest

Be sure you have entered any transactions initiated by the bank
or credit-card company (such as service charges, equipment
rental, merchant fees, or interest earned). Follow the steps in
“Manually Reconciling: Making a List of Unreconciled
Amounts” to add income and expense amounts now, if they do
not already exist.

❏ Duplicate
transactions

Any transaction you select in the Select Outstanding Amounts
dialog box appears in the Set Up Account Reconciliation dialog
box. You may have selected duplicates, or a transaction that
was already reconciled.
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Remove any transaction that does not appear on your list of
unreconciled withdrawals or deposits (from your manual
reconciliation). In the Set Up Account Reconciliation dialog box:

1. Highlight any field in the line you want to remove.

2. On the Edit menu, choose Remove Line.

❏ Errors on the
statement

Check for errors made by your bank or credit-card company.
Carefully compare the amounts on your bank statement to the
amounts on the cancelled cheques, cheque stubs, deposit slips,
and so on. If you discover an error on the statement:

■ Ask your bank or credit-card company to correct the error.

■ Record the error in Simply Accounting:

a) If the Set Up Account Reconciliation dialog box is open,
choose OK to close it.

b) In the Home window, choose Miscellaneous
Transactions, and enter an adjustment.

– If the bank or credit-card company owes you, credit
the Bank or Credit Card account and debit the
adjustment account (for example, debit the
Adjustment account you added earlier in this
chapter).

– If you owe the bank or credit-card company, debit
your Bank or Credit Card account and credit an
adjustment account (for example, credit the
Adjustment account you added earlier in this
chapter).

❏ Missing entries Check for missing entries. Print both the Payment and the
Receipt Transactions reports, and carefully compare them to
your statement.

If you forgot to record a deposit or a withdrawal:

1. If the Set Up Account Reconciliation dialog box is open,
choose OK to close it.

2. Record a receipt or cheque in the Receipts or Payments
window.
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3. In the Home window, choose Accounts and then open the
record for your Bank or Credit Card account.

4. On the Account Reconciliation tab, choose Setup, then Yes,
and then enter a date range. From the list, select the
unreconciled transactions you just added, and choose OK.

Setting the Account to Ready

Set the account to Ready

Add the accounts you need

Enter unreconciled
transactions

In this third of the three main sections, you will set the account
ready to reconcile.

Before you can set the account ready to reconcile, ensure that
the unresolved amount in the Set Up Account Reconciliation
dialog box is zero, as described earlier in this chapter.

To set the account ready to reconcile:

1. In the Set Up Account Reconciliation dialog box, choose
Set Ready. This step cannot be reversed.

 The program enters the last reconciled end balance amount
as the Balance Forward amount for next month’s
reconciliation, advances the Finish Date you entered earlier
(by one month), and saves the list of unreconciled
transactions.

2. Print the Account Reconciliation reports, so you have a
record of the setup transactions. (For instructions, see
Chapter 16, “Reports and Graphs,” in the User Guide.)

Adjusting an
unresolved amount

It is possible (but not recommended) to set the account ready to
reconcile while the unresolved amount is not zero. To do so,
choose Set Ready, and then OK to record the amount in the
adjustment account.
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Where To Now?
After completing the instructions in this chapter, the account is
ready for reconciliation.

To set up another account for reconciliation, repeat the steps in
this chapter.

For instructions on reconciling your monthly bank or
credit-card merchant statements, see Chapter 14, “Reconciling
Accounts,” in the User Guide.
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Chapter 8
Setting Up Printers

This chapter tells you how to test your printer to see if it prints
Simply Accounting reports and forms properly, and describes
additional steps you can take if you have problems.

Before You Print
Before you print any type of report or form, you must:

■ Install at least one printer to work with Microsoft Windows.
Choose Settings on the Start menu, then Printers, then Add
Printer.

■ Select a printer and specify printer settings for each type of
form in Simply Accounting.

Make sure your printer is correctly connected to your computer,
and has paper and a power supply.

Using Different Printers for Specific Forms
You can specify in advance which printer and settings the
program should use for: payment cheques, invoices, T4 slips,
statements, paycheques, labels, purchase orders, sales order
confirmations, sales quotes, receipts, and reports and graphs.

Whatever you print, the program remembers both the printer
and the settings you selected, every time it prints that type of
form. For more information, see “Printer Settings,” in Chapter 5.
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Testing Your Printer
You should test all types of forms to see if your printer prints
them properly. If a report does not print properly, see
“Troubleshooting,” later in this chapter.

Before you begin, install a printer in Microsoft Windows (refer
to your Windows manual or the online help in Windows), and
enter printer settings in Simply Accounting (see “Printer
Settings,” in Chapter 5).

Testing Reports

As a test, print a two-page report such as the chart of accounts.

If you wish, you can open the sample company included with
the program, and print its chart of accounts. (If you have not
installed the sample company, see Chapter 3, “Installing and
Starting Simply Accounting.”)

To print the chart of accounts:

1. Start Simply Accounting and open a company.

2. In the Home window, on the Reports menu, choose Lists,
then Financials, then Chart Of Accounts.

3. On the File menu, choose Print.

4. Check the printed report.

You can select the
sample company…

…or you can open your
own company.
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Testing Other Forms

After you print a report, as described in the previous section,
test each type of form you plan to print.

You can print payroll cheques, payment cheques, invoices,
purchase orders, sales order confirmations, quotes, receipts,
and customer statements on 8½ by 11-inch or 8½ by 7-inch
forms, or on custom forms (explained in Chapter 21,
“Customizing Forms and Reports,” in the User Guide).

T4 and Relevé 1 slips print on 8½ by 5½-inch preprinted forms
or, with some laser printers, on 8½ by 11-inch preprinted sheets
(explained in Chapter 16, “Reports and Graphs,” in the User
Guide).

If the form does not print properly, use the steps that follow to
adjust your printer settings. Follow the same steps for all forms.

These steps use customer statements as an example. You can
test them using blank 8½ by 11-inch paper or preprinted 8½ by
11-inch or 8½ by 7-inch customer statement forms.

To print a customer statement:

1.     Start Simply Accounting and open a company.

2. In the Home window, on the Setup menu, choose Reports
And Forms, then select the Statements tab and confirm that
the form-size setting matches the size of your statement
forms.

You can select the
sample company…

…or you can open
your own company.
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3. In the Home window, on the Reports menu, choose
Customers And Sales, and then Customer Statements.

4. Select at least two customers from the list and choose OK.

 You must print at least two statements, to see where the
second statement starts printing, and whether your printer
knows how long a statement should be.

5. Check the printed statements. They are printed properly if:

■ The print lines up properly on the page.

■ The second statement starts in the correct place. This
depends on the page size of your forms:

 8½ by 11 inches:  The second statement starts printing
at the top of the next 8½ by 11-inch page.

 8½ by 7 inches:  The second statement starts printing
seven inches below the start of the first (except when
printing on laser printers).

 If you selected a form size of 8½ by 7 inches, and the
statements did not print in the proper position, your printer
driver does not let Simply Accounting set page sizes
automatically.

 If you are using a dot-matrix printer, you can still print this
form, either by setting the page size manually, or by using
the Epson FX 80 or the Generic/Text Only printer driver.
First, test to see whether you can set the page size manually,
following the steps below.

Testing Manual Page-Size Setting

If you have determined that your dot-matrix printer driver does
not allow Simply Accounting to set page sizes automatically, by
following the instructions in the previous section, “Testing
Other Forms,” you should now determine whether you can set
page sizes manually.
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To test whether you can set page sizes manually:

1. In the Home window, choose Reports And Forms from the
Setup menu.

2. In the Report And Form Options dialog box, select the tab
for the type of form you want to test, then choose the form
size you want.

3. Choose Setup.

 On the screen that appears next, look for a range or list of
paper sizes to select. The appearance and selection in the list
depends on your printer (and on your version of Windows).

■ If the paper size you need is available, or the printer has
a Custom or User Defined Size option (to let you define
the page size manually), continue with the steps in the
next section, “Setting Up Non-Standard Forms.”

■ If the paper size you need is not available and there is
no Custom or User Defined Size option (which would
let you define the page size manually), you can use
8½ by 11-inch forms, or try “Using a Simpler
Printer Driver for Non-standard Forms,” later in this
chapter.

Setting Up Non-Standard Forms
Use these steps to set up non-standard forms if you have
determined that your printer driver:

■ Does not let Simply Accounting automatically set the page
size (as determined in “Testing Other Forms”), and

■ Does let you set the page size manually (as determined in
“Testing Manual Page-Size Setting”).
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Reset page size to
print a different size
of form

The program will use the same setting for every type of form.
Each time you want to print a different size form, you must
choose a different page size.

If you use more than one printer, you must choose a page size
each time you want to print a different size form on a
particular printer.

To set the form size:

1. In the Home window, choose Reports And Forms from the
Setup menu.

2. In the Report And Form Options dialog box, select the tab
for the type of form you want to print.

3. Select the printer, form (paper size), and the font name and
size you want to use.

4.  Choose Setup, then select the paper size you want from the
available paper sizes. Or, if the size you want is not listed,
select Custom or User Defined Size, then enter the size of
your paper.

 You can print cheques, invoices, purchase orders, sales
orders, quotes, and statements on 8½ by 7-inch or
8½ by 11-inch forms, or on custom forms (explained in
Chapter 21, “Customizing Forms and Reports,” in the User
Guide).

 In this example, the paper size is 8½ by 7 inches:

 

The dialog box may look
different, depending on
your version of Windows.

Multiply the desired width and
length of your form by 100 if you
use inches, or by 10 if you use
millimetres (850 = 8½ inches).

5. Choose OK until you return to the Home window.

You are now ready to print. Simply Accounting will use this
page size for everything you print, until you change the settings.
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Other programs in Microsoft Windows that use this printer will
also use this page size.

Using a Simpler Printer Driver for Non-standard Forms

If your printer accepts neither automatic nor manual settings for
page sizes, and you want to use a non-standard form, then you
must install another printer driver.

A printer driver is a file that contains information about your
printer. Some printer drivers are more complex than others. The
Epson FX 80 and Generic/Text Only printer drivers are simpler,
and will work with most printers to print on non-standard
forms. Try installing the Epson FX 80 printer driver first. If it
does not work, install the Generic/Text Only printer driver.

Installing a Simpler Printer Driver in Windows

1. On the Start menu, choose Settings, Printers, Add Printer.

2. Follow the instructions on the screen to install either the
Epson FX 80 or the Generic/Text Only printer driver.

3. Return to Simply Accounting and continue with the steps in
the next section, “Selecting a Simpler Printer Driver in
Simply Accounting.”

Selecting a Simpler Printer Driver in Simply Accounting

After you install a printer driver in Windows, you must select
the printer driver in Simply Accounting for each type of form
you want to print. You only need to do this once. The program
remembers the settings and uses them each time you print.

Select a printer driver 1. In Simply Accounting, choose Reports And Forms from the
Setup menu.
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Select a printer from the
list.

If necessary,
change the
margins until
the form prints
correctly.
Many
dot-matrix
printers work
well with a
small negative
left or right
margin (as
explained later
in this
chapter).

Select the tab for the
form you want to
print.

Choose a font. (Not all
fonts come in all sizes.
Size 12 or 14 is easy to
read. Size 8 lets you print
reports with many columns
per page.)

2. Choose the Setup button. For Paper Size, select Custom from
the end of the list, or choose User Defined Size. Select a unit
(0.01 inch or 0.1 millimeters), then enter the size of your
paper. For example, enter 850 by 700 for an 8½ by 7-inch
form.

Tip: For T4 slips, enter 550 for the length.

3. Choose OK to return to the previous screen.

4. In the Paper Source field, select Continuous No Page Break
with the Generic printer driver, or Tractor with the Epson
printer driver.

 This ensures that your printer prints the next cheque,
invoice, or other form directly below the previous one. If
you do not select No Page Break, each item prints at the top
of an 8½ by 11-inch page.

5. Repeat steps 1 to 4 for each type of form you want to use.

Test your forms again 6.  You are now ready to print on non-standard forms. Test
your new settings. Use the steps in “Testing Other Forms,”
earlier in this chapter.
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Helpful Hints

Troubleshooting

If this happens: Do this:

Report is too wide
to fit on the page

Choose a smaller type size or different font. On the Setup
menu, choose Reports And Forms, select the form, then select
another font size or font.

If you are using a dot-matrix printer, try a compressed font
(such as Roman 17 cpi or Courier 17 cpi).

Printing does not
line up properly
(tractor-feed
printer)

Shift the paper left, right, up, or down. Refer to the printer’s
manual.

Reset your margins. On the Setup menu, choose Reports And
Forms, select a form type, then change the margin settings.
Also, see the next section, “Setting Negative Margins.”

Last two lines of
the page do not
print

Reduce the top margin. On the Setup menu, choose Reports
And Forms, select a form type, then enter a smaller top
margin. Also, see the next section, “Setting Negative
Margins.”

If you are using an HP LaserJet printer, you may have
selected a PostScript printer driver. This causes the program
to print too many lines per page. Select another printer
driver, using the steps earlier in this chapter, in “Installing a
Simpler Printer Driver in Windows” or “Selecting a Simpler
Printer Driver in Simply Accounting.”

Nothing prints Check that your printer is connected and switched on.

Try reinstalling the printer driver, using the steps in
“Installing a Simpler Printer Driver in Windows.”

Setting Negative Margins
If the printing does not line up properly on a form, you can
reset the margins. You can even set negative margins to shift the
printing slightly to the left, or up:
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1. From the Setup menu, choose Reports And Forms. Select
the tab for the form you want to change.

2. Experiment with different margin settings until you get the
result you want.

Moves print down
0.05 inch.

Moves print left
0.1 inch.

 The maximum negative margin setting depends on the
printer and form, but you cannot exceed –1.00.

 If the program displays a message telling you the printer
offsets (that is, the negative numbers) are too big, use a
smaller number. Or, continue with the printing to see how
well the form is aligned, then adjust the margin.
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Chapter 9
Setting Up Cash-Basis Accounting

Simply Accounting lets you choose one of two common ways to
keep accounting records: accrual-basis or cash-basis accounting.

This chapter:

■ Explains cash-basis accounting, and describes how to switch
the cash-basis accounting option on or off.

■ Lists the setup procedures that differ for cash-basis
accounting.

■ Directs you to other chapters for setup procedures that are
the same for both methods.

For instructions on day-to-day use of Simply Accounting, see
Chapter 17, “Using Cash-Basis Accounting,” in the User Guide.

What is Cash-Basis Accounting?
Cash-basis accounting is one of the two most common ways of
keeping track of a company’s revenues and expenses. The other
method is accrual-basis accounting.

The difference
is in the timing

In cash-basis accounting, revenues are counted when cash is
received from customers, and expenses are counted when cash
is paid out. You record purchases at the time of purchase, and
record sales at the time of sale, but the transactions do not affect
your account balances until payment changes hands.

In accrual-basis accounting, revenues are counted when a sale is
made, and expenses when a purchase is made, even if the
payment is not received, or made, until later. Most companies
use accrual-basis accounting. In Canada, cash-basis accounting
is more often used by people whose business is farming or
fishing, and by non-profit organizations, such as charities.
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Advantage The advantage to using cash-basis accounting is that it is easier
to track and control your cash flow.

Disadvantage However, it may give a less-accurate picture of your business,
since you may have made large sales or purchases that have not
appeared in your accounts because money has not been
received or paid out.

Check with your
accountant before
choosing an
accounting method

The decision to use cash-basis accounting requires careful
consideration. Check with your accountant to determine which
accounting method to use. You can switch to the cash-basis or
to the accrual-basis at any time, though this decision should also
be considered very carefully.

Note:  The term “cash-basis accounting” does not refer to the
method of payment. Regardless of which accounting method
you use, both you and your customers can pay by cheque, cash,
credit card—it’s your choice.

How Do I Start?
In this table, read all four cases and decide which one applies.

If this describes your case: Follow these steps:

■ You are setting up a new
Simply Accounting system for
a new company.

■ You want to use cash-basis
accounting.

■ Check with your accountant before you choose
cash-basis accounting.

■ Work through all the steps in the next section,
“Setting Up a New Cash-Basis Accounting
System.”

■ You are setting up a new
Simply Accounting system for
an existing company.

■ You want to continue to use
cash-basis accounting.

■ Work through all the steps in the next section,
“Setting Up a New Cash-Basis Accounting
System.”
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■ You are setting up a new
Simply Accounting system for
an existing company.

■ You want to use cash-basis
accounting, but until now you
were using accrual-basis
accounting.

■ Check with your accountant before you choose
cash-basis accounting.

■ Enter your historical invoice and payment
details using the accrual-basis method, as
described in “Entering Vendor Records and
Historical Purchases” and “Entering Customer
Records and Historical Sales,” in Chapter 6.

■ Finish entering historical details as described in
“Finish Entering History,” in Chapter 6.

■ Follow the steps in “Changing Accounting
Methods in Existing Simply Accounting Files,”
later in this chapter, to choose cash-basis
accounting.

■ Your Simply Accounting
system is already set up and
in use.

■ You want to switch cash-basis
accounting on or off, to change
your accounting method.

■ Check with your accountant before you change
accounting methods.

■ Follow the steps in “Changing Accounting
Methods in Existing Simply Accounting Files,”
later in this chapter.

Setting Up a New Cash-Basis Accounting System
This section tells you how to:

■ Set up Simply Accounting files for a new company.

■ Switch to cash-basis accounting.

■ Add records for vendors, customers, inventory, and so on.

■ Link the accounts you need to connect your modules.

■ Enter historical details, if any.

■ Finish entering historical details, if required.

; Keep track This section refers you to other chapters, so be sure to stay
organized by marking each step as you complete it.
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Set Up New Company Files
� 1.  Install Simply Accounting, as described in Chapter 3. Be

sure to install the sample company and company templates,
too.

� 2.  Read “What is Cash-Basis Accounting?,” earlier in this
chapter, to learn about the effects of using the cash-basis
accounting method in Simply Accounting.

� 3.  Practice using the program with the cash-basis sample
company:

a) Start Simply Accounting.

b) Select Open The Sample Company To Help You Learn
Simply Accounting, and choose OK.

c) Select Cash-Basis, and choose OK.

d) With this company, work through the tutorial in
Chapter 4. (Do not use Universl.asc, as that sample
company does not use cash-basis accounting.)

� 4.  Create your own company, as described in “Creating a
Company,” in Chapter 5.

Now switch your new company files to cash-basis accounting,
as described next.

Switch to Cash-Basis Accounting
� 1.  In the Home window, on the Setup menu, choose Settings,

then:
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Enter the date
on which you
want cash-basis
accounting to
begin.

Turn the option on.

Choose the System tab.

After you select the
option and enter
the Cash Accounting
Date, choose OK.

Now add records to track your customers, suppliers, and
inventory, as described next.

Add Records
� 1.  Add vendor records, as described in “Adding Vendors

(Suppliers),” in Chapter 2, “Maintaining Records,” in the
User Guide.

� 2.  Add customer records, as described in “Adding
Customers,” in Chapter 2, “Maintaining Records,” in the
User Guide.

� 3.  Add employee records if you plan to use the payroll
module, as described in “Adding Employees,” in
Chapter 2, “Maintaining Records,” in the User Guide.

4.  Add inventory records if you plan to track inventory
activity for:

� ■ Goods (such as items for resale, and supplies for your
business), as described in “Adding Inventory Items
and Services,” in Chapter 2, “Maintaining Records,” in
the User Guide.

� ■ Services, as described in Chapter 2, “Adding
Inventory Items and Services,” in the User Guide.

� 5.  Add project records, if you plan to allocate expenses and
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revenues to particular projects (or branches, departments,
and so on), as described in “Adding Projects,” in
Chapter 2, “Maintaining Records,” in the User Guide.

Now link the modules to each other, as described next.

Link the Modules
� 1.  If you are using the inventory and payroll modules, set up

their linked accounts, as described in “Linked Accounts,” in
Chapter 5, in this manual.

� 2.  Review the list of accounts below to determine which ones
you will need, then link them as described in “Linked
Accounts,” in Chapter 5.

For descriptions of the different accounts, see “Linked Accounts in
the Vendors and Purchases Module” and “Linked Accounts in the
Customers and Sales Module,” in Chapter 6.

■ Principal and Alternate Bank Accounts.  Required
when you make a purchase or sale.

■ Accounts Payable and Accounts Receivable.  
Required only if you plan to enter transactions with
dates earlier than the Cash Accounting date, in addition
to your regular cash-basis accounting transactions.

Cash-basis
difference

In accrual-basis accounting the Accounts Payable and Accounts
Receivable accounts must be linked. This is one of the
differences between cash-basis and accrual-basis accounting.

■ Freight Expense and Freight Revenue.  Required only if
you pay for freight, or charge customers for freight.

■ GST/HST Paid On Purchases and GST/HST Charged On
Sales (Rate 1) or (Rate 2).  Required only if you pay and
collect GST or HST. If you collect both GST and HST, link
two accounts for purchases and two for sales—one for each
tax rate.

■ PST Payable or QST Payable.  Required only if you collect
PST or QST on sales.
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To choose PST or QST (To switch between PST and QST, on the Setup menu, choose
Settings, then Sales Taxes, then select or clear the Use Quebec
Sales Tax option.)

■ Refundable QST Paid.  Required only if you pay QST that
qualifies for an input tax refund.

■ QST Charged On Sales (Rate 1) and (Rate 2).  Required
if you entered a QST Rate 1 (on the Settings menu, choose
Settings, then Sales Taxes, then Use Quebec Sales Tax) and
if you charge QST on sales of corporeal movable property
and services. If you entered a QST Rate 2, you must also
link a second account.

New or existing
company?

If your company is new, you can now use the Finish Entering
History command, as described in Chapter 6. If your company
was already in business, enter the historical business
information, as described next.

Enter Historical Business Information
� 1.  For each vendor and each customer, gather or make a list of

all unpaid invoices. If you want fully paid invoices to
appear on the Vendor Aged report, list them, too.

� 2.  Using the list from step 1, follow the steps in “Enter
Purchase Invoices” and “Enter Sales Invoices,” in Chapter 6.
Note this difference:

Cash-basis
difference

■ The dialog boxes you use to enter historical invoices in
cash-basis accounting differ from the Historical Invoices
dialog box shown in Chapter 6. Be sure to fill in all the
historical details, as shown in these two examples:
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Accept or change the
payment terms.

From the invoice, copy the
item number. Double-click in
the Item column to display a
list of inventory items, or to
add an item “on the fly.”

From the invoice, copy the
freight charge and the taxes.

Copy the invoice
number and date.

From the invoice, copy the
description, amount, and
account. You can add an
account for a service expense
“on the fly.”

You can add a
project “on the
fly” when you
allocate
expenses.

After entering
all the
information,
choose Record.

 
 

 

From the customer invoice, copy
the item number, description,
amount you charged the
customer for the item, account,
and amount you paid when you
bought the item.

You can add items, accounts,
and projects “on the fly” if they
do not already exist in your
records.

If the item is an inventory item, enter the amount you paid
your vendor (supplier) under Cost of Goods Sold (C.O.G.S.).

From the invoice, copy the
freight and sales taxes.

3.  If you included fully paid invoices on your list in step 1,
follow the steps in “Enter Payments” and “Enter Receipts,”
in Chapter 6.

You are now ready to use the Finish Entering History
command, as described in Chapter 6.
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Finish Entering History
� 1.  After you have entered the historical information for the

modules you need, complete the Finish Entering History
command, as described in Chapter 6.

Changing Accounting Methods in Existing Simply
Accounting Files

You can switch to cash-basis accounting or accrual-basis
accounting at any time, although this is a decision you should
consider carefully. Check with your accountant before taking
this step.

Be sure you do not mix cash-basis and accrual-basis
transactions in the same time period as a result of changing
from one method to another.

To change to cash-basis accounting:

Backup 1.  Back up your company files. (On the File menu, choose
Backup, then fill in the fields on the screen.)

2. On the Setup menu, choose Settings, then the System tab.

Enter the date on which you
want cash-basis accounting to
begin. To avoid unexpected
entries, do not change this
date once cash-basis
accounting has started.

Turn the option on.

3. Choose OK.
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 If you change to cash-basis accounting, then find that you
must enter an accrual-basis transaction, ensure that the
transaction has a date earlier than the Cash Accounting
date. Such transactions are treated as accrual-basis
accounting transactions, and the revenue or expense is
immediately counted.

 If you have entered accrual-basis invoices, you can only
unlink the linked accounts after you pay off the invoices
and remove their details (using the Clear Paid Invoices
command on the Maintenance menu).

To change to accrual-basis accounting:

1. Determine which case applies to you:

To print
accrual-basis
reports

■ If you intend to continue using cash-basis accounting,
but you need to print accrual-basis statements (for
example, to show your bank, or to pay taxes to the
government), do not switch off the Use Cash-Basis
Accounting option. Instead, follow the steps in
“Printing Accrual-Basis Reports in Cash-Basis
Accounting,” in Chapter 17 of the User Guide.

To add earlier,
accrual-basis
transactions

■ If you intend to continue using cash-basis accounting,
but must enter a few accrual-basis entries from an
earlier period, do not switch off the Use Cash-Basis
Accounting option just to enter an accrual-basis
transaction. Instead, enter a transaction with a date
earlier than the Cash Accounting date.

■ If you intend to switch to accrual-basis accounting
permanently, continue with the following steps.

2. On the Setup menu, choose Linked Accounts, then
Vendors And Purchases.

3. If the Accounts Payable field is blank, select the account in
which you will track the amounts you owe to vendors.

 For more information on linking accounts, see “Setting Up a
Linked Account,” in Chapter 5.

4. Choose OK. (Or, if the linked Accounts Payable account
was already selected, choose Cancel.)
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5. Similarly, on the Setup menu, choose Linked Accounts, then
Customers And Sales. Select the account in which you will
track the amounts your customers owe you, then
choose OK.

Backup
6.  Back up your company files. (On the File menu, choose

Backup, then fill in the screen.)

7. On the Setup menu, choose Settings, then the System tab.

8. Clear (uncheck) the Use Cash-Basis Accounting box, then
choose OK.

9. Choose Yes when Simply Accounting asks whether you are
sure you want to do this.

 Simply Accounting immediately processes any uncounted
cash-basis accounting transactions as of the session date.

If you change
your mind

If you change your mind about switching to accrual-basis
accounting, you cannot “unprocess” these transactions.
Instead, you must restore the backup you made in step 6
and re-enter any details you added later. (For details, see
“Restoring a Backup,” in Chapter 1 of the User Guide.)

Where To Now?
This chapter has guided you through the process of setting up
the program for cash-basis accounting. For information about
how to enter day-to-day transactions using cash-basis
accounting, refer to Chapter 17 in the User Guide.
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Index

A

Account balances, 5-33, 6-5
Account numbering, 5-33
Account numbers

assigning, 6-3
hiding, 5-29

Account reconciliation
accounts, 7-4 to 7-6
adjustment accounts, 7-4 to 7-6
credit cards, 7-2
dates, 5-5
defined, 7-1
ending balance on bank statement, 7-12,

7-13, 7-14
expense accounts, 7-8
income accounts, 7-8
linked accounts, 7-4 to 7-6
manual reconciliation, 7-8
number of accounts, 7-3
setting up, 7-1 to 7-16
setting up an account for online banking,

7-6
unreconciled transactions (listing), 7-7 to

7-12
unresolved amount, 7-13 to 7-15
using

See:  User Guide
Account records

adding, 6-4
Account types

defined, 5-30
to format financial statements, 5-32

Accounting method
accrual-basis, defined, 9-1
cash-basis, defined, 9-1
changing, 9-9
when not to change, 9-10

Accounting terminology
in Simply Accounting manuals, 3-8
turning on or off, 3-8

Accounts
account reconciliation, 7-1 to 7-16
adding, 6-4
modifying, using wizard, 5-34
negative balances, 5-33
See also:  Company templates; Linked

accounts
Accounts Payable

See:  Vendors and Purchases module
Accounts Payable linked account, 6-11

in cash-basis accounting, 9-6
Accounts Receivable

See:  Customers and Sales module
Accounts Receivable linked accounts, 6-17

in cash-basis accounting, 9-6
Accrual-basis accounting

additional linked account needed, 9-6
defined, 9-1
processing in cash-basis accounting, 9-10

Add History symbol, 6-1, 6-35
Address

See:  Company information
Address, Web site

shippers, 5-26
Adjustment accounts

See:  Account reconciliation
Adjustment Write-off linked account, 6-32
Advances paid, 6-22
Advances Receivable linked account, 6-24
Advice

See:  Automatic advice
Aging periods

customer, 5-16
vendor, 5-15
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Allocating revenues and expenses
options, 5-19
See also:  User Guide

Allow Inventory Levels To Go Below Zero
option, 5-18
variance accounts, 6-29

Alternate Bank account
payments, 6-11
receipts, 6-17

Appearance
Home window, 5-29

Asset linked accounts (inventory), 6-28
Assigning account numbers, 5-33
Automatic advice

turning off, 5-27

B

Backdating transactions, 5-4
Backing up

account reconciliation, 7-7
before conversion, 2-5
data, instructions for

See:  User Guide
Simply Accounting disks, 3-3

Balance forward
projects, at year end, 6-33

Balance sheet
format, 5-30

Bank Account Payments Are Made From
linked account
See:  Alternate Bank account; Principal

Bank account
Bank Account Receipts Are Deposited To

linked account
See:  Alternate Bank account; Principal

Bank account
Bank accounts, linked, 6-11, 6-17, 6-24

in cash-basis accounting, 9-6
Bank reconciliation

See:  Account reconciliation
Basics, 1-2
Bedford Integrated Accounting

converting from, 2-1, 2-3, 2-22

Benefits
taxable, 6-22
taxable in Quebec, 6-22

Bonuses, employee, 5-11
Budgeting

projects, 5-19
See also:  User Guide

Business Assistant
See:  User Guide

C

CA-RET forms
reinstalling, 3-5

Cash Accounting date
entering, 9-9
transactions earlier than, 9-10

Cash-basis accounting
advantage of, 9-2
cash sales and purchases, 9-2
defined, 9-1
disadvantage of, 9-2
entering history, 9-7
processing accrual transactions, 9-10

additional linked account needed, 9-6
using

See:  User Guide
Changing accounting methods, 9-9
Changing the screen display, 5-27
Chart of accounts, 5-30

predefined, 3-4
sample, 5-35

Checklists
when to display, 5-28
using

See:  User Guide
Cheques

company address on, 5-20
confirm printing, 5-20
numbering, 5-20

Choosing
names, 5-10
options, 5-9 to 5-27

using the Settings wizard, 5-9
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Colour of window backgrounds, 5-29
Comments

on e-mail forms, 5-23
printing on invoices, sales order

confirmations, and quotes, 5-21
Commission, 6-22
Company

creating by copying company templates,
5-7

creating by using Setup wizard, 5-7
Company information, 5-9

addresses on invoices, cheques, and
statements, 5-20

Company templates, 5-7
definition, 3-4
installing, 3-4
linked accounts in, 5-34
sample chart of accounts in, 5-34, 5-35

Components of Simply Accounting
installing, 3-2

Confirm Printing option, 5-20
Conversion

actions to take before, 2-4
Conversion utility

installing, 3-5
Converting

from Bedford Integrated Accounting, 2-1,
2-3, 2-22

from Simply Accounting for DOS, 2-1,
2-3, 2-22

Correcting entries
See:  User Guide

Cost allocation or distribution options, 5-19
Cost, weighted moving average (inventory),

5-18
CPP contributions, 6-23
CPP Expense linked account, 6-26
CPP Payable linked account, 6-24
Creating a company, 5-7
Credit cards

account reconciliation, 7-1 to 7-16
checking statements, 7-2
setting up, 5-25

Crystal Reports print engine
installing, 3-4

Current Earnings account
balance, 6-6
defined, 5-32, 6-6

Customer records
adding sales and payments history, 6-14

Customer statements
sending by e-mail, 5-21

Customers
sending e-mail to, 5-21

Customers and Sales module
adding sales and payments history, 6-14
entering historical balances, invoices, and

payments, 6-14
entering rates and taxes, 5-16
finish entering history, 6-34
linked accounts, 6-17
options, 5-16
preparing for operation, 6-12 to 6-18
using

See:  User Guide
Customizing

forms and reports
See:  User Guide

names, 5-10

D

Data
using with older versions of Simply

Accounting, 2-2
Data, company

See:  Company
Dates, 5-1

account reconciliation, 5-5
defined, 5-2
earliest transaction, 5-2
fiscal end, 5-2
fiscal start, 5-2
formats, 5-2
future, 5-4
latest transaction, 5-3
on reports, 5-24
payroll cheques, 5-4
preset, 5-6
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Dates (continued)
restrictions, 5-6
session, 5-3
transaction, 5-4

Deduction A through J
Deduction Payable linked accounts, 6-25
payroll fields, 6-23
renaming fields, 5-11

Default dates
See:  Preset dates

Default invoice comment, 5-20
Demos

installing, 3-6
Dental

payroll deductions, 6-23
Discounts for early payment of invoices, 5-16
Display font, 5-12
Display options, 5-12, 5-28
Distributing

See:  Allocating
Domino

See:  Lotus Domino

E

Earlier version of Simply Accounting
updating from, 2-1

Earliest transaction date, 5-2
EHT Expense linked account, 6-26
EHT Payable linked account, 6-25
EI Expense linked account, 6-26
EI insurable earnings, 6-22
EI Payable linked account, 6-24
EI premiums, 6-23
E-mail

program requirements, 5-22
sending orders, invoices, receipts, and

statements by, 5-21
Employee history, 6-21
Entering printer settings, 5-23 to 5-25
Entering rates, settings, and formats, 5-11 to

5-23
Epson FX 80 simpler printer driver, 8-6, 8-7

Expense accounts
See:  Account reconciliation

Expense linked accounts
inventory, 6-28
negative inventory levels, 6-29

Expenses
choosing a method of allocation, 5-19

Exporting data
See:  User Guide

F

Financial statements
format, 5-30

Finish Entering History command
defined, 6-1
restrictions, 6-1

Fiscal end date, 5-2
Fiscal start date, 5-2
Font

display, 5-12
Formats

choosing, 5-11 to 5-23
Forms

choosing options, 5-20
comments on printed sales quotes, orders,

and invoices, 5-21
installing, 3-5
printing (testing), 8-3
setting up, 8-5

Freight Expense linked account, 6-12
in cash-basis accounting, 9-6

Freight Revenue linked account, 6-18
in cash-basis accounting, 9-6

G

General Ledger
See:  Accounts; General Module

General module
entering historical information, 6-4
finish entering history, 6-34
linked accounts, 6-5
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General module (continued)
preparing for operation, 6-2
using

See:  User Guide
General options (for accounts), 5-14
Generic/Text Only simpler printer driver, 8-6,

8-7
Getting help, 1-2
GIFI codes

assigning to accounts, 6-3
Group accounts, to format financial

statements, 5-32
Group heading, to format financial statements,

5-32
Group total, to format financial statements,

5-32
GST

See:  Sales tax options
GST Charged On Sales linked account, 6-17

in cash-basis accounting, 9-6
GST On Benefits field, 6-23
GST Paid On Purchases linked account, 6-11

in cash-basis accounting, 9-6

H

Hardware and software requirements, 3-2
Health

See:  Medical
Height

label option, 5-24
Help, 1-2, 1-3
Hiding parts of the screen display, 5-27
Historical information

Customers and Sales module, 6-14
defined, 6-1
General module, 6-4
in cash-basis accounting, 9-7
Inventory and Services module, 6-29
Payroll module, 6-21
Project module, 6-33
Vendors and Purchases module, 6-8

Home window, 3-7
bringing to front, 1-3

Home window (continued)
changing colour, 5-29

Hours
allocating expenses by, 5-20

HST
See:  GST; Sales tax options

HST Charged On Sales linked account
in cash-basis accounting, 9-6

HST Paid On Purchases linked account
in cash-basis accounting, 9-6

I

Icon windows
hiding, 5-29

Importing data
See:  User Guide

Include Interest Paid In Last [ ] Days On
Statements option, 5-16

Income A, B, C, D, E
payroll fields, 6-22
renaming, 5-11

Income accounts
See:  Account reconciliation

Income statement
format, 5-30

Income tax
Quebec income tax, 6-23
Tax Payable linked account, 6-24
Tax (Quebec) Payable linked account,

6-25
Information about your company

See:  Company information
Installing

company templates, 3-4
conversion utility, 3-5
Crystal Reports print engine, 3-4
demos, 3-6
forms and reports, 3-5
manuals, PDF format, 3-5
Microsoft Office documents, 3-5
New Business Guide, 3-5
program files, 3-4
sample data, 3-4
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Simply Accounting, 3-3
Installing over an earlier version of Simply

Accounting, 2-1
Integrated Accounting

converting from, 2-1, 2-3, 2-22
Integration accounts

See:  Linked accounts
Interest charges (sales invoices), 5-16
Internet

e-mail, 5-21
Inventory

cost calculation, 5-18
negative inventory, 5-18, 6-29
options, 5-18
profit evaluation method, 5-18

Inventory and Services module
Asset linked accounts (inventory), 6-28
entering historical stock levels, pricing,

and sales volume, 6-29
finish entering history, 6-34
Inventory Asset linked accounts, 6-28
Inventory Expense linked accounts, 6-28
Inventory Revenue linked accounts, 6-28
Inventory Variance linked accounts, 6-28
negative inventory levels, 6-29
options, 5-17
preparing for operation, 6-27 to 6-32
using

See:  User Guide
Invoices

comment on, 5-20
company address on, 5-20
confirm printing, 5-20
entering

See:  User Guide
numbering, 5-20
sending by e-mail, 5-21
subtotals on, 5-24
tracking shipments, 5-26
See also:  User Guide

Invoices, historical
adding to Customers and Sales module,

6-14
adding to Vendors and Purchases

module, 6-8
Item Assembly Costs linked account, 6-32

L

Labels
height, 5-24
printer settings, 5-24
width, 5-24

Latest transaction date, 5-3
Learning Simply Accounting, 4-1

installing sample data for, 3-8
Lessons, 4-1

sample data for, 3-8
Linked accounts

Accounts Payable, 6-11
Accounts Receivable, 6-17
Adjustment Write-off, 6-32
Advances Receivable, 6-24
Alternate Bank

payments, 6-11
receipts, 6-17

assets, inventory, 6-28
changing, 5-39
CPP Expense, 6-26
CPP Payable, 6-24
Customers and Sales module, 6-17
defined, 5-34
EHT Expense, 6-26
EHT Payable, 6-25
EI Expense, 6-26
EI Payable, 6-24
Freight Expense, 6-12
Freight Revenue, 6-18
General module, 6-5
GST Charged On Sales, 6-17
GST Paid On Purchases, 6-11
in company template, 5-34
Inventory and Services module, 6-31
Item Assembly Costs, 6-32
Medical Payable, 6-25
Payroll Bank, 6-24
Payroll module, 6-24
Pension Payable, 6-25
Principal Bank

payments, 6-11
receipts, 6-17

PST Payable, 6-17
Purchase Discount, 6-12
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Linked accounts (continued)
QHSF Expense, 6-26
QHSF Payable, 6-25
QPP Expense, 6-26
QPP Payable, 6-25
QST Charged On Sales, 6-18
Refundable QST Paid, 6-12
removing, 5-40
Sales Discount, 6-18
sample, 5-35
setting up, 5-39
Tax Payable, 6-24
Tax (Quebec) Payable, 6-25
Union Payable, 6-25
using a wizard to set up, 5-38
Vacation Payable, 6-24
Vendors and Purchases module, 6-11
Wage Expense, 6-26
WCB Expense, 6-26
WCB Payable, 6-25
See also:  Account reconciliation

Looking up invoices
See:  User Guide

Lotus Domino
sending invoices, orders, receipts, and

statements with, 5-22

M

Mail, electronic
See:  E-mail

Mailing labels
See:  Labels

Manuals, Simply Accounting, 1-3
installing, in PDF format 3-5

MAPI
defined, 5-22

Margin (profit evaluation method for
inventory)
calculating, 5-18

Margins
lining up, 8-9
negative (printer settings), 8-9 to 8-10

Markup
calculating, 5-18

Medical payroll deductions
entering deductions, 6-23
Medical Payable linked account, 6-25

Microsoft Mail
sending invoices, orders, receipts, and

statements with, 5-22
Microsoft Office documents

installing, 3-5
using

See:  User Guide
Misc A, B fields

renaming, 5-11
Modules

hiding, 5-29
Moving average (inventory cost), 5-18
MS Mail

See:  Microsoft Mail

N

Names
customizing, 5-10

Negative account balances, 5-33
Negative inventory levels, 5-18, 6-29
Negative margins (printer settings), 8-9 to 8-10
Net (amount paid to employee), 6-22
New Business Guide, 1-2

installing, 3-5
New features in Simply Accounting, 2-6
Next invoice or cheque number, 5-20
Non-accounting terminology, 3-8
Non-standard forms

setting up, 8-5
using simpler printer drivers, 8-6

O

Online banking
setting up an account for, 7-1, 7-2, 7-6
using

See:  User Guide
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Online Help, 1-3
On-screen displays, 1-3
Options

credit cards, 5-25
customers and sales, 5-16
display, 5-12
display font, 5-12
for forms, 5-20
for printers, 5-23 to 5-25, 5-24
general (for accounts), 5-14
inventory, 5-18
names, 5-10
payroll, 5-17
project (cost allocation or budgeting), 5-19
shippers, 5-26
system, 5-12
vendors and purchases, 5-15
See also:  Settings

Order confirmation, sales
comments on, 5-21
sending by e-mail, 5-21

Outstanding amounts
in account reconciliation

See:  Account reconciliation
Outstanding transactions

See:  Account reconciliation
Overtime, 6-22

P

Page size
setting, 8-4, 8-5
testing, 8-4

Payables Ledger
See:  Vendors and Purchases module

Payment cheques
numbering, 5-20

Payment terms
for customers, 5-16
for vendors, 5-15

Payroll
deductions, automatic, 5-17
entering rates and options, 5-17
renaming income and deductions, 5-11

Payroll Bank linked account, 6-24
Payroll cheques

date, 5-4
numbering, 5-20

Payroll deduction options
setting up provincial payroll deductions,

5-11
Payroll module

entering employee pay and deduction
history, 6-21

finish entering history, 6-34
linked accounts, 6-24
preparing for operation, 6-18 to 6-26
using

See:  User Guide
PDF manuals

installing, 3-5
Pension payroll deductions

entering deductions, 6-23
Pension Payable linked account, 6-25

Postdating transactions, 5-4
Premiums, EI, 6-23
Preparing for operation

Customers and Sales module, 6-12 to 6-18
General module, 6-2 to 6-6
Inventory and Services module, 6-27 to

6-32
Payroll module, 6-18 to 6-26
Project module, 6-32 to 6-34
Vendors and Purchases module, 6-6 to

6-12, 6-11
Preset dates, 5-6
Previous year’s records

earliest transaction date, 5-3
processing date, 5-4

Principal Bank account
payments, 6-11
receipts, 6-17

Printer settings, 5-23
entering, 5-23 to 5-25

Printers
drivers, 8-6, 8-7
Epson FX 80 simpler printer driver, 8-6,

8-7
fitting print on page, 8-8, 8-9 to 8-10
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Printers (continued)
Generic/Text Only simpler printer driver,

8-6, 8-7
installing in Simply Accounting, 8-7 to 8-8
installing in Windows, 8-7

See also:  Windows online Help
lining up margins, 8-9
negative margins, 8-9 to 8-10
page size (testing), 8-4
problems, 8-8
testing, 8-2 to 8-5

Printing
Confirm Printing option, 5-20

Processing date
See:  Transaction date

Profit evaluation method, 5-18
Program files

installing, 3-4
Project balances

carrying forward at year end, 6-33
Project module

adding historical balances, 6-33
options, 5-19
preparing for operation, 6-32 to 6-34
renaming, 5-11
using

See:  User Guide
Projects

budgeting, 5-19
Provincial tax (payroll)

renaming, 5-11
PST

See:  Sales tax options
PST Payable linked account, 6-17

in cash-basis accounting, 9-6
Purchase Discount linked account, 6-12
Purchase orders

sending by e-mail, 5-21
Purchases and payments history

adding to Vendors and Purchases
module, 6-8

Purchases, orders, and quotes
entering

See:  User Guide

Q

QHSF Expense linked account, 6-26
QHSF Payable linked account, 6-25
QPP contributions, 6-23
QPP Expense linked account, 6-26
QPP Payable linked account, 6-25
QST

See:  Sales tax options
QST Charged On Sales linked account, 6-18

in cash-basis accounting, 9-7
QST On Benefits field, 6-23
QST Payable linked account

in cash-basis accounting, 9-6
Quebec income tax, 6-23
Quotes, sales

comments on, 5-21
sending by e-mail, 5-21

R

Rates, settings, and formats
entering in Simply Accounting, 5-11 to

5-23
Receivables Ledger

See:  Customers and Sales module
Reconciling

See:  Account reconciliation
Records, maintaining

See:  User Guide
Refundable QST Paid linked account, 6-12

in cash-basis accounting, 9-7
Regular wages, 6-22
Reinstalling

CA-RET forms, 3-5
sample data, 3-8

Reports
print date, 5-24
printing (testing), 8-2
See also:  User Guide

Reports, management
installing, 3-5

Requirements
hardware and software, 3-2
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Restrictions
dates, 5-6

Retained Earnings account, 6-6
Revenue

choosing a method of allocation, 5-19
Revenue linked accounts (inventory), 6-28

S

Salary
entering, 6-22

Sales
credit card settings, 5-25

Sales, orders, and quotes
entering

See:  User Guide
Sales and payments history

adding to Customers and Sales module,
6-14

Sales Discount linked account, 6-18
Sales order confirmations

sending by e-mail, 5-21
Sales quotes, orders, and invoices

adding comments to forms, 5-21
sending by e-mail, 5-21

Sales Tax account
in cash-basis accounting, 9-6

Sales tax options
changing tax names, 5-11
GST rate, 5-14
HST rate, 5-14
preparing to use HST, 5-11
PST on freight, 5-14
PST on GST, 5-14
PST rate, 5-14
QST rate, 5-14

Sample data
installing, 3-4
reinstalling, 3-8

Sample linked accounts, 5-35
Screen display

hiding parts of, 5-27
options, 5-12, 5-28

Section heading, to format financial
statements, 5-32

Section total, to format financial statements,
5-33

Selecting
components to install, 3-2

Serial number, Simply Accounting, 3-2
Session date, 5-3

changing, 5-4
entering, 3-7

Settings
adding comments to forms, 5-21
choosing, 5-11 to 5-23
entering for forms, 5-20
negative printer margins, 8-9
page size (testing), 8-4
printer, entering, 5-23 to 5-25
printing forms, 8-1
wizard, 5-9
See also:  Options; Sales tax options

Settings wizard
choosing options using, 5-9

Setup wizard
using to create a new company, 5-7

Shipments, tracking
See:  User Guide

Shippers
adding Web site addresses, 5-26

Simpler printer drivers, 8-6 to 8-8
Simply Accounting

disks, backing up, 3-3
installing, 3-3
manuals, 1-3

installing in PDF format, 3-5
non-accounting terminology in, 3-8

new features, 2-6
serial number, 3-2
uninstalling, 3-9
using with data from previous versions,

2-2
Simply Accounting for DOS

converting from, 2-1, 2-3, 2-22
Software and hardware requirements, 3-2
Starting Simply Accounting, 3-6
Statements, customer

company address on, 5-20



Getting Started    Index–11

SWC7GSIN.DOC, printed on 03/08/99, at 10:47 AM. Last saved on 02/26/99 12:04 PM.

CA Confidential

Statements, customer (continued)
sending by e-mail, 5-21

Statements, bank or credit-card
reconciling

See:  Account reconciliation
Status bar, 1-3

displaying, 5-27
Subgroup accounts, to format financal

statements, 5-32
Subgroup total accounts, to format financial

statements, 5-32
Subtotals

on invoices, 5-24
Symbols

add history, 6-1, 6-35
System options, 5-12
System requirements, 3-2

T

Tax
See:  Income tax; Sales tax options

Taxable benefits, 6-22
Templates

See:  Company templates
Terms, early-payment

customers, 5-16
vendors, 5-15

Testing
forms printing, 8-3
page size setting, 8-4
pagination in printing, 8-4
report printing, 8-2

Tips (employee income), 5-17
To-Do Lists

displaying automatically, 5-28
using

See:  User Guide
Transaction date, 5-4

backdating, 5-4
earliest, 5-2
latest, 5-3

Transaction fee, credit card, 5-25

Transactions, entering
See:  User Guide

Troubleshooting
printers, 8-8

Tutorial
See:  Learning Simply Accounting

U

UI (Unemployment Insurance)
See:  EI

Unemployment Insurance
See:  EI

Uninstalling
Simply Accounting, 3-9

Union dues, 6-23
Union Payable linked account, 6-25
Unreconciled transactions

See:  Account reconciliation
Unresolved amount

See:  Account reconciliation
Updating from an earlier version of Simply

Accounting, 2-1
updating data, 2-2, 3-10

Upgrading, from Simply Accounting for DOS
updating your data, 3-10

V

Vacation pay
owed, 6-22
paid, 6-22

Vacation Payable linked account, 6-24
Variance linked accounts (inventory), 6-28

negative inventory levels, 6-29
Vendor records

adding purchases and payments history,
6-8

Vendors
sending e-mail to, 5-21

Vendors and Purchases module
Accounts Payable linked account, 6-11
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Vendors and Purchases module (continued)
entering historical balances, invoices, and

payments, 6-8
finish entering history, 6-34
linked accounts, 6-11
options, 5-15
preparing for operation, 6-6 to 6-12
using

See:  User Guide
View menu, 5-27

account numbers, 5-29
appearance, 5-29
automatic advice, 5-27
checklists, 5-28
hiding icon windows, 5-29
hiding modules, 5-29
options, 5-27
status bars, 5-27
To-Do Lists, 5-28

W

Wage Expense linked account, 6-26
Wages

overtime, 6-22
regular, 6-22

Warn If Distribution Is Not Complete option,
5-20

WCB Expense linked account, 6-26
WCB Payable linked account, 6-25
Web site addresses

for shipping, 5-26
Weighted moving average, in inventory cost,

5-18
Width

label option, 5-24
Window background colour, 5-28
Wizard

creating a company using, 5-7
linked accounts, 5-38
modify accounts, 5-34
settings, 5-9
setup, 5-9 to 5-27
using to choose settings and options, 5-8

Workbook
installing practice data for, 3-4

Z

Zero-balance accounts, 6-3
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